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Clear-Com

End User Software License

IMPORTANT:  CAREFULLY READ THE FOLLOWING BEFORE 
USING THIS SOFTWARE.  USING THE SOFTWARE INDICATES 
YOUR ACKNOWLEDGMENT THAT YOU HAVE READ THE 
FOLLOWING AND AGREE TO ITS TERMS.  

IF YOU DO NOT AGREE, RETURN THE SOFTWARE COMPLETE 
TO CLEAR-COM OR YOUR CLEAR-COM REPRESENTATIVE AND 
CANCEL THE INSTALLATION.

THIS IS YOUR PROOF THAT YOU HAVE A VALID LICENSE.  
PLEASE TREAT IT AS VALUABLE PROPERTY.

HME CLEAR-COM LIMITED OR CLEAR-COM LLC., as the case 
may be (hereinafter referred to as “CLEAR-COM”), offers you this 
storage media containing a computer program and files (the 
“SOFTWARE”) and offers to grant to you a non-exclusive  and 
non-transferable License to use the Software on the following 
terms.  Any new revision or update of the Software provided by 
CLEAR-COM to Customer under this License shall be governed 
by the terms and conditions of this License.

1. APPLICATION
a. These terms supersede all prior agreements representations 

and understandings between you the Customer and Clear-Com 
and their authorised representatives relating to the subject 
matter hereof (i.e., the Software) but shall otherwise be subject 
to Clear-Com Terms and Conditions, as amended from time to 
time.  For the avoidance of doubt, in the event of conflict, these 
terms shall prevail. 

b. No variation to these terms, nor any other terms or conditions 
proposed by you, shall be of any effect unless recorded in a 
written document signed by Clear-Com. You confirm that any 
statement made to the contrary by you or on your behalf shall 
not apply to this License.

c. You confirm that you are not relying on any statement made by 
or on behalf of Clear-Com, other than statements recorded in a 
written document signed by Clear-Com.

d. Clear-Com and its licensors reserve all rights not expressly 
granted to you.  Clear-Com's licensors are intended third party 
beneficiaries of this Agreement and have the express right to 
rely upon and directly enforce the terms set forth herein.

e. You agree that the Software belongs to Clear-Com and its 
licensors.  You agree that you neither own nor hereby acquire 
any claim or right of ownership to the Software or to any related 
patents, copyrights, trademarks or other intellectual property.  
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Clear-Com and its licensors retain all right, title and interest in 
and to the Software and all copies thereof at all times, 
regardless of the form or media in or on which the original or 
other copies may subsequently exist.  This license is not a sale 
of the original or any subsequent copy.

2. COPYRIGHT
a. The copyright and all other rights in the Software produced by 

Clear-Com shall remain with Clear-Com or its suppliers.  You 
must reproduce any copyright or other notice marked on the 
Software on any copies that you make. 

3. YOU MAY: 
a. Use the Software only at a single site location.  If you wish to use 

the Software at more than one site you must contact Clear-Com 
and if required purchase further Licenses;

b. Make one copy of the Software for archival or back-up purposes, 
and;

c. Transfer the Software to an end user of a Clear-Com product, 
only if you have made it clear to Clear-Com that you are not the 
end user and you assign all of your rights under this License 
and make no use of the Software yourself. 

4. YOU MAY NOT:
a. Use the Software or make copies of it except as permitted in this 

License;
b. Publish or distribute the computer images, sound files or fonts 

included with the Software as computer images, sound files or 
fonts;

c. Translate, reverse engineer, decompile or disassemble the 
Software, except to the extent the foregoing restriction is 
expressly prohibited by applicable law;

d. Rent, lease, assign or transfer the Software except as set out 
above; or

e. Modify the Software or merge all or any part of the Software in 
another program.

5. TERM:
a. This License shall continue for as long as you use the Software.  

However, it will terminate if you fail to comply with any of its 
terms or conditions.  You agree, upon termination, to destroy all 
copies of the Software.  The Limitations of Warranties and 
Liability set out below shall continue in force even after any 
termination.

6. LIMITED WARRANTY:
a. Clear-Com warrants that the storage media in this Software will 

be free from defects in materials and workmanship for 90 days 
from the date you acquire it.  If such a defect occurs, return it to 
i
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us at the address below and we will replace it free.  This remedy 
is your exclusive remedy for breach of this warranty.

b. After the initial 90 days, THE SOFTWARE IS PROVIDED "AS 
IS" WITHOUT WARRANTY OF ANY KIND EITHER EXPRESS, 
IMPLIED OR STATUTORY, INCLUDING BUT NOT LIMITED 
TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, PERFORMANCE, 
ACCURACY, RELIABILITY, OR NON-INFRINGEMENT OF 
THIRD-PARTY INTELLECTUAL PROPERTY RIGHTS.  This 
constitutes an essential part of this License.

7. LIMITATION OF LIABILITY:
a. For the avoidance of doubt, all conditions imposed by law 

covering matters such as fitness for purpose, compliance to 
description, negligence and quality are expressly excluded from 
this agreement and you agree to accept the foregoing warranty 
in lieu of all such items. 

b. IN NO EVENT SHALL CLEAR-COM BE LIABLE FOR ANY 
LOSS OF PROFITS, LOSS OF BUSINESS, LOSS OF DATA 
OR USE OF DATA, INTERRUPTION OF BUSINESS, OR FOR 
INDIRECT, SPECIAL, INCIDENTAL, EXEMPLARY, MULTIPLE, 
PUNITIVE OR CONSEQUENTIAL DAMAGES OF ANY KIND, 
WHETHER BASED ON CONTRACT, TORT (INCLUDING 
WITHOUT LIMITATION, NEGLIGENCE), WARRANTY, 
GUARANTEE OR ANY OTHER LEGAL OR EQUITABLE 
GROUNDS, EVEN IF CLEAR-COM HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES.  

c. The warranty is personal to you (or end user if you have made it 
clear that you are not the end user) and may not be transferred 
(except as permitted expressly above). 

d. Clear-Com shall not be a liable for failure to perform any 
obligation to you where such failure is due to circumstances 
beyond Clear-Com’s reasonable control.

e. Clear-Com offers extended warranties and, if you are not 
satisfied with the above, you should consider such 
warranties or consider separate insurance. 

8. RESTRICTED RIGHTS:
If this Software is acquired by or for the U.S. Government then it is pro-
vided with Restricted Rights.  Use, duplication, or disclosure by the U.S.
Government is subject to restrictions as set forth in subparagraph
(c)(1)(ii) of The Rights in Technical Data and Computer Software clause
at DFARS 252.227-7013, or subparagraphs (c)(1) and (2) of the Com-
mercial Computer Software - Restricted Rights at 48 CFR 52.227-19, or
clause 18-52.227-86(d) of the NASA Supplement to the FAR, as appli-
cable.  Contractor/manufacturer: HME Clear-Com Limited, 7400 Beach
Drive, Cambridge, England CB25 9TP or Clear-Com LLC.,1301 Marina
Village Parkway, Suite 105, Alameda, CA 94501.
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9. OTHER ISSUES:
a. Any failure by Clear-Com to insist on its strict rights under this 

Agreement shall not be deemed to be a waiver of those (or any 
other rights) and only a duly executed written release shall 
constitute such a waiver.

b. If any of these conditions is deemed invalid or unenforceable the 
remainder shall be unaffected. 

c. Clear-Com's dealings with you shall be governed by English law 
if you are resident in the EMEA region and California law if you 
are resident elsewhere.  The federal and state courts of 
California for Non-EMEA Customers and English Courts for 
EMEA Customers shall have exclusive jurisdiction to adjudicate 
any dispute arising out of this Agreement.

d. If any document is written in more than one language the 
English text shall prevail.  

e. Capitalized terms not defined herein shall have the meanings 
set forth in Clear-Com Terms and Conditions, as amended from 
time to time.
i
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INTRODUCTION TO 
EHX 

This guide describes the features of EHX, the configuration software 
for Eclipse HX v7.1. 

EHX is used to create and manage communication pathways between 
your Eclipse HX devices, including matrices, interface cards, interface 
modules and user panels.

Use EHX to: 

• Create individual, point-to-point talk and listen paths between   
members of a matrix intercom system. 

• Create groups and one-to-many calls (fixed groups). 

• Create many-to-many partylines.

• Store complete system setups (configurations) on the EHX PC.

• Download and instantly implement a configuration on the matrix.   

• Store four complete configuration maps in the matrix’s on-board 
memory, any of which can be activated immediately from the front 
of the matrix with the push of a button.  

• Communicate with CellCom® and FreeSpeak®  beltpacks allowing 
direct communication between panels and roaming users.

• Communicate with remote panels over IP.

• Interface with the Clear-Com Concert ™ multi-user conferencing 
system over IP.

• Interface with HelixNet Partyline™, the Clear-Com digital partyline 
system.

• Interface with telephones, two-way radios, camera intercoms, and 
more. 

• Bring an outside audio source, such as program source, into the 
system’s audio stream and interrupt the program audio for 
announcements (IFBs). 

• Use the GPIO facility to activate an applause light in a studio, a lock 
on a door, or other control functions each time an external device 
such as a switch is triggered.

• Control, monitor, or run diagnostics on a matrix system remotely from 
anywhere in the world, if the matrix  is set up on a LAN network. 

1
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• Link matrices across cities, nations, and continents. 

• And perform many other functions.

FURTHER INFORMATION
For more information about the Eclipse HX matrix system, including 
matrices, interface cards, interface modules and user panels, see the 
complete Eclipse HX documentation set.

Eclipse HX documentation is available from both the Clear-Com 
website (www.clearcom.com) and the Eclipse HX v7.1 software and 
documentation DVDs. 

TERMINOLOGY
Remote devices (including interface cards, interface modules, 
interface frames and user panels) connected to the matrix may be 
referred to as panels in this guide. Occasional references may be 
made to stations (a legacy Clear-Com term).
1
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SYSTEM COMPONENTS 
A complete Eclipse HX system comprises the Eclipse HX configuration 
software (EHX), a central hardware matrix, user panels and other 
remote devices - interfaces, four-wire equipment—connected to the 
matrix. The following sections give a brief overview of the matrix 
system. 

CENTRAL MATRIX    
The matrix hardware assembly comprises the following components:

• The metal housing (sometimes called the frame).

• The central processing unit (CPU).

• The internal circuitry which controls the attached devices.

• Power supplies. 

• The rear panel interfaces which link the matrix to user panels and 
remote devices such as interface modules. 

• The rear panel interfaces which link the matrix to CellCom/FreeSpeak 
antennae.

• The rear panel interfaces, which provide fiber-optic links between 
matrices.

Figure 1-1: Eclipse HX-Omega Matrix

Chassis   
The matrix chassis (frame) is a metal rectangular box which houses 
the matrix’s internal circuitry and power supplies.
C
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The Eclipse HX-Omega is designed to host removable CPU and 
interface cards.

The Eclipse HX-Median and Eclipse HX-Delta are designed to host 
removable CPU cards, interface cards, and interface modules.

The Eclipse HX-PiCo contains fixed internal circuitry.

The larger matrices (Eclipse HX-Omega, Eclipse HX-Median and 
Eclipse HX-Delta) have removable power supplies, which can be 
exchanged when necessary. 

The following are the main elements of the Eclipse HX central matrix: 

Central Processing Unit (CPU) 
The central processing unit (CPU) provides the serial data and 
Ethernet connection to the PC hosting the EHX software.

The CPU also coordinates the data flow for other features of the 
system, such as general-purpose outputs and inputs. The CPU stores 
four complete system configurations in its memory, which can be 
retrieved and activated directly from the matrix’s front-panel controls, 
even when the matrix is not connected to a computer. 

Each matrix system contains at least one central processing unit, 
located either on its own removable CPU card, or in internal circuitry. 

The Eclipse HX-Omega, Eclipse HX-Median and Eclipse HX-Delta are 
supplied with two CPU cards (in a master and slave relationship), 
ensuring fail-safe operation. 

Internal Circuitry   
The matrix’s internal circuitry controls the operation of the panels and 
interfaces connected to it. Panels and interfaces connect to the  
internal circuitry through an RJ-45 connector, or “port”, on the rear 
panel of the matrix. The internal circuitry sends balanced duplex audio 
and RS-422 data signals to and from connected audio equipment 
through 4-pair shielded category-5 (CAT5) cable (STP). 

Each audio device connected to the matrix can communicate with all 
other audio devices in the system. For intelligent linking, shielded 
category-5 cable is run from a port on one Eclipse matrix to a port on a 
second Eclipse matrix to form a trunkline connection.

The Eclipse HX-Omega, Eclipse HX-Median and Eclipse HX-Delta 
matrix internal circuitry can also control fiber optic interfaces to provide 
high-speed links between matrices and E1 interfaces to allow 
communication with wireless system antennae.
1
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Power Supplies 
Each Eclipse HX-Median, Eclipse HX-Omega or Eclipse HX-Delta 
matrix can hold two independent power supplies.  These may be 
connected to a main and backup power source for redundancy. If one 
of these power supplies fails, the second supply automatically takes 
over. 

In the event of a complete power failure, a matrix can automatically 
restore itself to complete functioning by retrieving configuration 
information from its non-volatile operational memory.

The Eclipse HX-PiCo matrix has a dual AC input power supply unit.

Rear-Panel Connectors 
A matrix connects to remote devices such as user panels, interfaces, 
general purpose inputs and outputs, local area networks (LANs), the 
computer that hosts the EHX configuration software, and other 
matrices through its rear-panel connectors.  

The rear-panel RJ-45 sockets, or ports, connect the matrix to intercom 
panels, beltpack antennas, Concert servers, other matrices and 
interfaces with shielded category 5 (CAT5) cable.

ECLIPSE HX CONFIGURATION SOFTWARE (EHX) 
The Eclipse HX configuration software (EHX) controls the operation of 
the system’s connected audio devices, using a configuration 
(sometimes called a configuration map) that has been downloaded to 
the matrix. 

The system is designed in a “star” configuration, in which each 
member of the system connects directly to the matrix rather than to 
each other. Audio signals are routed through the central matrix and out 
to the connected audio devices in accordance with the configuration 
created in EHX.

EHX can also be used to monitor the matrix for faults and to log errors 
for analysis.  

SETTING UP AN ECLIPSE HX MATRIX SYSTEM
The following procedure shows the basic steps for setting up an 
Eclipse HX matrix system. For detailed installation information, see the 
Eclipse HX Installation Guide.

To set up an Eclipse HX matrix system (basic steps):

1. Ensure that there is a working connection between the EHX PC and 
the matrix (see chapter 3 for information on selecting the connection 
type and setting ethernet addresses).

2. Open EHX. Go to System and right click the systems pane to open 
the Add Matrix Frame option.
C
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3. To add a new matrix, click Add Matrix Frame.  Open the matrix type 
menu by clicking Please choose a matrix type and select the 
required matrix type.

4. Click New Matrix Frame on the new, onscreen matrix icon and 
enter the name of the new matrix.

5. Enter the IP address of the new matrix in the Matrix IP Address 
window of the new matrix icon.

6. Go to Hardware > Cards and Ports.
7. Eclipse HX-Omega, Eclipse HX-Median and Eclipse HX-Delta only: 

Select each of the MVX-A16 cards to corespond to the cards fitted 
to the matrix. This displays the list of ports for that card. Add the 
required panels and interfaces to the ports.

8. Eclipse HX-Omega, Eclipse HX-Median and Eclipse HX-Delta only: 
Select each E-QUE card fitted and configure the ports (according to 
the type of card configured in Card Properties).

9. Eclipse HX-Omega, Eclipse HX-Median and Eclipse HX-Delta only: 
Select each IVC-32 card fitted and configure the card for IP 
communication, using Card Properties.

10. Eclipse HX-Omega, Eclipse HX-Median and Eclipse HX-Delta only: 
Select each LMC-64 card fitted and configure the card for IP 
communication, using Card Properties.

11. Eclipse HX-Omega, Eclipse HX-Median and Eclipse HX-Delta only: 
Select each E-MADI64 card fitted, and configure the card for MADI 
communication using Card Properties.

12. Go to Configuration > Panels. Configure the keys on any 
connected V-Series and I-Series user panels, using the list of 
sources and destinations.

13. When you have finished your configuration, download the 
configuration map to the matrix by clicking Apply Changes To 
System (located in System) or press CTRL-D.

Note:
You can also apply changes from the Tools menu, or by right-clicking 
a matrix in the Layout screen, and selecting Apply Changes.

EHX OVERVIEW
The following sections describe some of the main elements of the 
Eclipse HX Configuration Software. For more detailed information, see 
the rest of his guide. 

Setting Up Matrix Port Functions  
Each physical port on the matrix needs to know what type of remote 
device connects to it. This could be one of the many different types of 
Clear-Com intercom panels, control panels, or interfaces that connect 
the matrix to telephones, 2-way radios, and so on. 

In addition each port needs a label to identify it on intercom panels and 
other connected equipment.
1
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Labels can be up to ten characters in length, or can be split into two 
parts, each part limited to five characters.

Assigning Names to Individual Panels    
At individual panels and interfaces, port “labels” are assigned to 
specific keys or buttons. If an operator communicates frequently with a 
source or destination in the matrix system a key or button may be 
assigned on a panel for either talking or listening directly to that source 
or destination. 

These individual buttons or keys are similar to “speed dials” on a 
traditional telephone.  Each key can be set up so that when it is 
pressed, it makes an audio route. For example a key on a panel 
attached to port 1 may be programmed to send audio to port 28. When 
that key is pressed, an audio route is activated from the originating 
panel to the device connected to port 28. When the key is released, 
the route is de-activated (these audio routes are also called 
“crosspoints”).

Figure 1-2: Key Assignment

PROJECTS AND CONFIGURATIONS
A configuration determines the operating parameters of the Eclipse 
HX system, including port functions, talk-and-listen audio routes, 
controls and other functions. 

Configurations are created and managed in EHX, for download to the 
matrix frame(s). Up to four configurations can be stored in the 
operational memory of the matrix. Pushing a button on the front panel 
of the matrix applies the configuration to the entire matrix system. 

Port 1 Port 28

Source Destination
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You can create:

• A configuration for just one matrix frame and/or multiple, 
intelligently linked matrix frames.

• Multiple, alternate configurations for that matrix, and/or system of 
linked matrices, to address different intercom requirements. For 
example, you may want to create separate configurations for a 
live sports broadcast and the main evening news broadcast.

A project is a container that manages and organises your Eclipse HX 
frames and their configurations. 

The project can be used to define every aspect of a complex intercom 
system, including the connectivity between multiple, intelligently linked 
matrices and/or the configurations for individual matrix frames.

An unlimited number of projects may be stored on the EHX PC or on a 
server.

Tip: The following sections describe some of the types of 
communications routes that can be created with EHX. Subsequent 
chapters in this manual describe these topics in detail.

Groups: Partyline and Fixed 
Group communication may be configured in several ways. In a “fixed 
group” configuration an operator speaks to all members of the group at 
once. However, if a group member responds by calling the operator 
back with their answer-back key the audio path goes to operator panel 
only. 

Alternatively, all members of a group can speak with all other members 
of the group at the same time. This is commonly called a “conference” 
or “partyline”.   It is similar to a telephone conference call with its 
two-way, full-duplex communication. Members of a partyline can join 
and leave in real time, making the membership dynamic in the sense 
that it is always changing. 

Controls: DTMF Sequences, Relays, Routes 
An intercom panel can be used to perform a variety of other functions 
besides sending audio. It can activate a Dual Tone Multi Frequency 
(DTMF) sequence to call out on a telephone line, activate an electronic 
relay to turn on a light or lock a door, or activate audio from an external 
router like a mixer desk. These types of function are called controls. 

Call Signals
A call signal is an audible or visual signal or Tally sent on an intercom 
channel, with or without accompanying audio. These signals have a 
variety of purposes from alerting an operator who has taken off their 
headset, to activating control sequences.  
1
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Interruptible Foldback (IFB) 
An audio source such as “on-the-air” or “program” audio can be routed 
through the matrix to a presenters ear pieces.  In a typical broadcast 
application, program audio is routed to the “talent”– a collective term 
for any person in front of the camera broadcasting directly to an 
audience. A director or other audio person can then interrupt or dim the 
program audio to the “talent” for announcements (commands) or cuing 
by using the “interruptible foldback” or IFB feature. 

Figure 1-3: IFB Operation
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GETTING STARTED: 
INSTALLING, 
STARTING, AND 
EXITING EHX 

SYSTEM REQUIREMENTS
EHX runs on the following versions of Windows:

• Microsoft Windows Server 2003 SP2 (32-bit and 64-bit).

• Microsoft Windows Server 2003 R2 (32-bit and 64-bit).

• Microsoft Windows Server 2008 SP2 (32-bit and 64-bit).

• Microsoft Windows Server 2008 R2 (64-bit).

Note:
Windows Server 2008 R2 is only available in a 64 bit version (no 
32 bit version is available).

• Microsoft Windows XP SP3 (32-bit and 64-bit).

• Microsoft Windows Vista SP2 (32-bit and 64-bit).

• Microsoft Windows 7 (32-bit and 64-bit).

• Microsoft Windows 8 (32-bit and 64-bit)

Tip: When running EHX on Windows OS,  you can run the client 
and server on separate machines, connected over the network.

This manual provides a 

comprehensive guide to the 

Eclipse HX Configuration 

Software. 
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The minimum requirements for the PC hosting EHX are as follows:

The recommended requirements for the PC hosting EHX are:

Specification Value / Description

Processor 1 GHz

Memory 1 GB RAM

Hard Disk 1 GB

Input Devices CD/DVD-ROM drive

Display Resolution SVGA

User Entry Keyboard, Mouse

Network IEEE 802.3 Ethernet card

TABLE 2.1: MINIMUM PC REQUIREMENTS

Specification Value / Description

Processor

2 GHz for a client.

As many cores as possible 

for a server

Memory 

2 GB for a 32-bit client

4 GB for a 64-bit client

3 GB for a 32-bit server

4 GB+ for a 64-bit server

Free Space 1 GB

Display Resolution 1600 x 1200 

Ports 1 Serial Port

TABLE 2.2: RECOMMENDED PC REQUIREMENTS
2
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INSTALLING EHX

BACKING UP YOUR EXISTING 5.1/5.2 PROJECTS 
AND CONFIGURATIONS
If you are upgrading EHX from an earlier version of EHX or ECS, 
Clear-Com recommends backing up your projects and configurations 
before you install EHX, and exporting them to a hard disk location. 

To back up and export your exiting projects and configurations:

1. Open the project you want to export.

2. Select File > Export Project.

3. Save the project to a location on your hard drive. The project will be 
saved as a *.ccn format file, which you can import later into 
EHXv7.1

Note:
EHX can open *.ccn format files as well as its own *.hxn format 
files.

Repeat the above procedure for all the projects you want to save.

BACKING UP YOUR EHX PROJECTS AND 
CONFIGURATIONS
If you are required to uninstall and re-install your EHX installation for 
any reason, ensure that you save your projects first for re-importing 
into EHX (see Importing your projects into EHX below). You can 
uninstall EHX from your Windows All Programs menu.

If you are running EHX in Client-Server mode, export your projects 
to a secure location on your hard drive in the same way as your ECS 
v5.2.4 projects (see above).

If you are running EHX in Client-Only mode, where the user works 
directly with *.hxn project files, your projects should already be saved 
prior to uninstall.
C
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INSTALLING EHX
The Eclipse HX v7.1 software DVD contains a number of executables 
for installing EHX:

Note:
Before Installing EHX Server, please see “Installing and Configuring 
IIS on the Server” on page 11-2.

Installation *.exe Description

EHXSetup.exe

Installer for the 32-bit  and 64-bit 

versions of the client. Use the EHX 

client version to connect directly to 

the matrix in Client-only mode or to 

an EHX server in Client-Server 

mode.

EHXServerSetup.exe

Installer for the 32-bit server and 

64-bit server versions of EHX. The 

EHX server enables multiple EHX 

clients to work together when 

configuring an Eclipse HX v7.1 

system.

TABLE 2.3: EHX INSTALLATION EXECUTABLES
2
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IMPORTING YOUR PROJECTS AND 
CONFIGURATIONS INTO EHX

To import a saved project from EHX v7.0, ECS v5.2.4 or a previous 
version of EHX into EHX in Client-Server mode:

1. Open EHX. Select File > Import Project.

2. Navigate to the project file (*.hxn or *.ccn format) saved to your 
hard drive. To import the file, click Open.

Note:
Remember to save your project, after opening  it.

Repeat the above procedure for all the projects you want to import.

To import a saved project from EHX v7.0, ECS v5.2.4 or a previous 
version of EHX into EHX in Client-only mode:

1. Open EHX. Select File > Open.

2. Navigate to the project file (*.hxn or *.ccn format) saved to your 
hard drive. Click Open.

Note:
If you import a CCN file, remember to save your imported project as 
an *.hxn format file.
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RUNNING EHX

LOGGING INTO EHX
To log into EHX in Client-only mode (EHX is run on a single machine, 
without connecting to a server):

1. From the Windows Start menu, select Programs / All Programs > 
Clear-Com > Eclipse HX Configuration Software.

2. The EHX user login screen is displayed (see below). If you are 
logging in for the first time, the default username (Administrator) is 
already entered for you.

No password is required on initial login. 

Click OK.

Figure 2-1: EHX Login Screen

Once logged in to EHX, the User Management facility can be used to 
change the password for the default user and add further users (see 
Chapter 3 of this guide). The default user has EHX administrator 
privileges.

Note:
If you are running EHX in Client-Server mode, you must first enter the 
address of the remote server to log into (see “Client-Server Login” 
below).
2
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Client-Server Login
If you are running EHX in Client-Server mode, you must enter the 
address of the remote server before logging in.

To log into EHX in Client-Server mode:

1. From the Windows Start menu, select Programs / All Programs > 
Clear-Com > Eclipse HX Configuration Software.

2. The EHX user login screen is displayed (see below). In the dialog, 
click Options. 
 

3. Enter the address of the remote server to log into (for example, 
http://RemoteHost:80/EclipseServer). 

Figure 2-2: EHX Log in Server Option

4. The EHX user login screen is displayed (see below). If you are 
logging in for the first time, the default username (Administrator) is 
already entered for you.

No password is required on initial login. 

Click OK.

The same versions of EHX must be installed to both the client and the 
server.
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First Screen after Log in
After successfully logging in (either locally or to a server) the EHX 
initial screen is displayed.

Figure 2-3: EHX Initial Screen

IDENTIFYING THE EHX VERSION WITH HELP > 
ABOUT
The version of EHX can be displayed by opening Help on the Windows 
toolbar and selecting About.

Figure 2-4: EHX About Screen

Tip: The operational mode of EHX (Client-Only or Client-Server 
mode) is displayed, as well as the version of EHX.
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EHX: SETTING UP A 
SYSTEM

INTRODUCTION
Complete the following procedure to set up a new Eclipse HX-Omega, 
Eclipse HX-Median or Eclipse HX-Delta matrix. 

Tip: For the latest, detailed guidance, see the relevant User Guide.
For information on setting the default IP address on Eclipse HX-Pico 
matrices, see the Eclipse HX-PiCo User Guide.

To set up a new Eclipse HX-Omega, Eclipse HX-Median or Eclipse 
HX-Delta matrix: reset the matrix to the factory default IP address 
(169.254.0.100): 

1. Reset the matrix to the factory default IP address 
(169.254.0.100):

Note:
The default IP address is a link local IP address. This means that  
the PC is connected directly to the matrix using an ethernet cable, 
and communicates with the rack in DHCP mode. When the rack's 
IP configuration is defaulted back to the above link local address it 
also defaults to DHCP enabled.

a. The matrix is fitted with two CPU cards, in a master and slave 
relationship. Remove the slave CPU card.

b. Press and hold the ENG and FULL RESET front panel buttons 
simultaneously (bottom of card) then press the RESET button (top 
of card, see illustration) on the master CPU card.

c. Replace the slave CPU card.

d. Remove the master CPU card.

e. Press and hold the ENG and FULL RESET front panel buttons 
simultaneously (bottom of card) then press the RESET button (top 
of card, see illustration) on the slave CPU card.

f. Replace the master CPU card.

2. Ensure that the matrix and the EHX PC are connected using an 
ethernet connection, either directly or over a network.

3
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3. Configure the ethernet connection on the EHX PC, then create a 
configuration with the factory default IP address.

4. Download the complete configuration map to the matrix, using the 
factory default IP address.

MATRIX ETHERNET OPERATION
The Eclipse HX-Omega, Eclipse HX-Median and Eclipse HX-Delta 
CPU card ethernet ports are normally connected to a LAN and used to 
communicate with clients such as EHX and Production Maestro.  The 
ethernet port functionality depends on the IP address setup.

If an IP address of 0.0.0.0 is configured on the second ethernet 
port, it will not be used for Tx or Rx.  This is the default setup if the 
default IP address is set as described above.

All matrix to matrix traffic is sent out on both ethernet ports. This 
applies to both directed and broadcast packets.  All matrix to matrix 
traffic is also received on both ethernet ports. If the traffic is transaction 
related, the second (duplicate) message received is not consumed, but 
simply dropped. 

The matrices listen for client connections on both ethernet ports. Once 
the connection is made it is added to the list of connections to service. 
Broadcast type Tx data is duplicated out on each connection (for 
example, an HCI connection to the matrix from 3rd party applications). 

EHX makes a connection on either the main or backup ethernet port of 
each system in the linked set. If both are up, this will default to the 
primary port. In the event that connection is lost to the currently active 
port on a matrix, EHX will swap over to using the other ethernet port.  If 
this connection is lost only on one matrix in a linked set, the others will 
not be affected. 

Configuration Restrictions
The network ID on the first ethernet port must be different to that of the 
second port.  The network ID is defined by the IP address and the 
network mask for the port. 

For example:

A network address of 172.16.2.1 and a mask of 255.255.0.0 
gives a network ID of 172.16.  Therefore in this scheme the second 
port could not have an IP address starting with 172.16. 

If the network mask is extended to 255.255.255.0 the network ID 
becomes 172.16.2. This means that the second port could have an 
address of 172.16.3.1  and a mask of 255.255.255.0, giving a 
network ID of 172.16.3 for the second port. 
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Note:
If both Ethernet ports are set up with the same network ID this 
condition results in data loss on one or both of the ethernet ports. 

Ethernet redundancy and the use of a default gateway is not 
recommended.  An IP address and gateway combination on an 
ethernet port means that all Tx traffic to any address is possible on the 
port.  Traffic that actually matches the other ethernet port can therefore 
be sent out on the wrong port. 

SELECTING ETHERNET OR SERIAL
CONNECTION 
EHX can communicate with a matrix using one of the following two 
methods:  

• Ethernet connection.

• Serial connection if the EHX PC is connected directly to the matrix via 
an RS-232 cable.  

Ethernet is the recommended connection type for all applications. 
Serial connections are limited to a single frame, have a limited range of 
functionality and should only be used for backup purposes.

Note:
The factory ships an Eclipse HX matrix without an assigned IP 
address. To use an Ethernet connection, the IP address must be reset 
to the default.  The system can then be configured for an Ethernet 
connection. It is not possible to change the IP address through a map 
download. Use EHX > System or EHX > Matrix Event Log (see the 
chapter on Diagnostic Tools for details on the Matrix Event Log).

ETHERNET CONNECTION 
Ethernet connection allows single or multiple EHX PCs  to control, 
configure, monitor and diagnose issues with single or multiple matrices 
anywhere on the WAN / LAN.

The PC is usually connected to the matrix frame using:

• The LAN1 connector (a standard RJ45 connector) on the rear of 
the Eclipse HX-Median, Eclipse HX-Omega or Eclipse HX-Delta 
matrix.

Note:
LAN1 is the default connector on the matrix. LAN2 (also a 
standard RJ45 connector) is not configured when it leaves the 
factory, and must be enabled in EHX. 

• The LAN connector (a standard RJ45 connector) on the rear of 
the Eclipse HX-PiCo.
 

Ethernet mode to complete 

the configuration.

PC Matrix
Crossover

cable

Lan1

PC Matrix

10/100
SwitchStraight

CAT5
Straight
CAT5
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A ferrite core must be added to the socket end of each Ethernet cable 
to comply with European EMC standards. A suitable ferrite core is 
Wurth Electronik part: 74271132. Shielded CAT5 cable is 
recommended for Electro Magnetic Compliance in EU countries.

A crossover cable should be used (though a straight-through CAT5 
cable can be used with a switch):

To establish communication between the PC and the Eclipse HX 
frame, the PC and the frame must be set to the same subnet.  
Windows provides many different methods of reconfiguring network 
settings.

The following workflow is true for Windows XP only: 

1. From the Windows Start menu, select My Network Places.
 

2. From the Network task pane, click View Network Connections.  
The Network Connections dialog is displayed. 

PIN FUNCTION

Pin 1 Transmit data +

Pin 2 Transmit data -

Pin 3 Receive data +

Pin 4 N/C

Pin 5 N/C

Pin 6 Receive data -

Pin 7 N/C

Pin 8 N/C

TABLE 3-1: PIN ASSIGNMENTS FOR LAN CONNECTORS
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Figure 3-1: The Network Connections Dialog Box

3. Click the Local Area Connection icon once, then right-click the 
icon for a shortcut menu.
    

4. From the shortcut menu, select Properties. The Local Area 
Connection Properties dialog is displayed.
   

Figure 3-2: Local Area Connection Properties Dialog
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5. Click the Internet Protocol (TCP/IP) icon to highlight it, then click 
Properties. The Internet Protocol (TCP/IP) Properties dialog is 
displayed.
 

Figure 3-3: Internet Protocol Properties Dialog

6.  Select Use the following IP Address, then enter an IP address of 
169.254.0.10. 

The subnet mask should be 255.255.0.0.

Ensure that all other settings are blank. Click OK, then OK again.  

The IP address of the computer is now set to the same subnet as the 
Eclipse HX matrix.

SERIAL CONNECTION 
To establish a serial connection between the EHX PC and the matrix 
the hardware must be connected first and then the software 
configured. 

To establish the hardware connection, connect a serial (RS-232) cable 
between the computer's serial port and the connector labelled RS-232 
on the rear of the Eclipse HX frame.

To set up a serial connection between EHX and the Eclipse HX frame: 

1. From the EHX command line, open the Tools menu and select 
Matrix Connection. The Connection Settings dialog is displayed. 
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2. Because Ethernet connection is the default, it is already selected. 
Select the Serial connection radio button instead.

3. From the drop-down menu select the COM port on the PC the serial 
cable is connected to. 

Tip: Click Only Show Available Ports to display the available COM 
ports on the computer.  

Figure 3-4: Selecting a Serial or Ethernet Connection 

When using a serial connection, the left-hand menu pane is highlighted 
in purple.

Checking Connections with the Windows
Ping Utility 
If there is a problem connecting to the Eclipse HX matrix, you can use  
the Windows Ping utility on ethernet to verify that the cabling and IP 
settings are correct.

To check the connection to the matrix with Ping:

1. From the Windows Start menu, select Run. 
The Run dialog is displayed. 

2. To open the command window, type cmd in the Open field and click 
OK. 
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3. Type ping xxx.xxx.xx.xxx, where the xes represent  the IP 
address of the Eclipse HX matrix.

4. Press Enter. 

If the ping was successful, a reply will be received. If the ping was not 
successful check the cabling and IP settings.

Note:
When checking the connection, ensure that Network Bridging and any 
firewalls are disabled.

CREATING A PROJECT FILE 
A project (stored and exported as an *.hxn file) provides a container 
for your configurations, and may comprise one or many configurations 
for one or many matrix frames. 

A project can be used to define every aspect of a complex intercom 
system, including the connectivity between multiple, intelligently linked 
matrices and/or the configurations for individual matrix frames.

An unlimited number of projects may be stored on the EHX PC or on a 
server.

A configuration determines the operating parameters of the Eclipse 
HX v7.1 system.

When you first create a configuration, the file does not have any 
content. EHX is used to populate the configuration with details of the 
system, including:

• The user panels, interface cards, interface modules and control 
devices associated with the matrix / matrices.

• The labels (alphanumeric names) assigned to each device.

To create a project file:

1. Select File > New Project (CTRL-N).

Note:
The Alt-F, N and Ctrl-N commands can be used when in any EHX 
mode to start a new configuration map.

2. If you are running EHX in Client-Server mode, enter a name for the 
project in the dialog. Click Save.

The project name is displayed on the title bar at the top of the screen. 
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SETTING UP A NEW MATRIX
Once a new project has been created, matrices can be added to the 
project. To edit the default address displayed on the matrix icon:

1. Right click the layout pane and click Add Matrix Frame.

2. When the matrix icon is displayed, click Matrix Frame IP Address 
on the icon. 

To open the project configuration setup, click Configuration Manager.

Note:
Frames that are added to a project are allocated the next available 
system number at the time that they are added to the project.

ADDING A DISCOVERED MATRIX
A matrix can only be discovered if:

• The ethernet address of the matrix is accessible to the EHX PC.

• The EHX PC can receive broadcast packets from the matrix.

 For more information, see “Ethernet Connection” on page 3-3.

To add a discovered matrix to the project:

1. Open System > Layout. If there are active matrices on the network, 
EHX will list the discovered matrices left of center on the screen.

Figure 3-5: Layout Screen

The first step in setting up a 

system is to create a project 

file. A project file is a 

container for one or more 

configurations. 
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2. To add a matrix to the new project, either:

• Drag a discovered matrix into the right hand pane 
(recommended). The matrix is added to the project and the 
Hardware, Configuration and Diagnostic menu links are 
displayed in the left hand menu pane.
3
 Clear-Com®
EHX User Guide

- 1 0



• Click Add Matrix to System on the matrix icon. A dialog is 
displayed with the following options:

Option Description

Empty Configuration

If this option is selected the frame is 
added and the Hardware, 
Configuration and Diagnostic menu 
links are displayed in the menu pane.  
The Hardware link will flash amber if 
no cards or panels have been 
configured.

The matrix IP address and system 
preferences are set up as 
described below, after which the 
hardware should be configured 
manually.

Discover Hardware

Select this option to fully and 
automatically populate the project 
with available cards and panels.

A progress bar is displayed while the 
hardware is being discovered (see 
below). The matrix is added to the 
project and the Hardware, 
Configuration and Diagnostic menu 
links are displayed in the left hand 
menu pane.

Upload Configuration 
from Matrix Frame

This option is backup facility that 
enables you to retrieve the last 
downloaded configuration from the 
matrix frame (provided one has been 
loaded). It is not a general way to 
configure the frame.

Once the configuration has been 
loaded the Hardware, Configuration 
and Diagnostics menu links will be 
displayed and the configuration 
(which already contains the system 
and panel setups) can be edited.

TABLE 3-2: ADD MATRIX FRAME TO PROJECT DIALOG
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Figure 3-6: Add matrix frame to project dialog

Figure 3-7: Discover Hardware progress bar

Adding an Offline Matrix
Note:
Matrix frames that are added to a project are allocated the next 
available system number at the time that they are added to the project.

If the matrix frame you want to configure is unavailable (for example, 
the matrix has yet to be installed), you can still add that matrix frame to 
EHX. 

To add an offline matrix:

1. Right click the right hand layout pane. 

2. Click Add Matrix Frame. A matrix, with generic information, is 
added to the layout pane. 

Note:
An offline matrix is always displayed gray on the layout pane.
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Figure 3-8: Adding an offline matrix (shell)

3. You can now configure the offline matrix with the relevant, specific 
configuration information (if known).

Configuring an Offline Matrix
The offline matrix, which is a shell at this stage, requires basic 
configuration, before you can start adding cards and panels.

Figure 3-9: New Matrix Icon

To configure the matrix:

1. To enter a name for the matrix (optional), click New Matrix Frame at 
the top of the matrix frame.
 

2. Set the matrix type by clicking Please choose a matrix type on the 
matrix frame.

From the drop-down menu, select the appropriate matrix type 
(Eclipse HX-Omega, Eclipse HX-Median, Eclipse HX-Delta or 
Eclipse HX-PiCo). 
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Figure 3-10: Select Matrix Type

3. The Hardware and Configuration menus for the matrix are now 
available from the sidebar menu for the matrix on the left of the 
scren. Click to open / view all menu options.

Note:
The Hardware > Cards and Ports menu flashes amber, because 
there is no connection with physical hardware.

4. The default IP address (169.254.0.100) is shown on the matrix 
frame on the layout pane. Type the IP address of the offline matrix 
into the text field, if known.

MATRIX FRAME PREFERENCES MENU
To configure the global system settings of the matrix, select 
Configuration > Preferences from the side-bar menu for the matrix 
on the left of the screen.

The settings are organised under a series of tabs.
3
 Clear-Com®
EHX User Guide

- 1 4



Figure 3-11: Preferences tabs (open at Intelligent Linking)

Preferences > Intelligent Linking
The Preferences > Intelligent Linking tab enable you to:

• Specify the format of Alias Labels. Aliases mean that labels can be 
displayed differently on a connected, remote system from the way 
they are displayed on the local system. 

• Define which ports are used for Comfort Tones (warning tones). 
Comfort tone ports are used to  indicate a trunking failure to panel 
users.

Alias Labels

The Alias Labels section of intelligent linking controls how labels for 
panel functions are presented in linked systems. The Alias Labels 
options are as follows:
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Note:
Because partylines and Fixed Groups are now viewed as a global item 
across all systems (they work inter-system), partyline and Fixed Group 
alias names are not displayed in remote systems. All partylines and 
Fixed Groups should be given a unique name.

Comfort Tones

Comfort tones are external tone sources which can be used to indicate 
the status of the trunk lines between matrices. 

The port that the source is connected to is specified in the Redirect 
Port field. You can also specify the label that will be displayed on the 
matrix. 

The system states that can trigger a comfort tone are:

• No Trunk (a requested trunk line is unavailable).

• System Down (requested destination system is unavailable).

• Trunk Clear (requested trunk line is available).

Option Description

Same as the local label

Labels appear the same on local and 
remote systems.  If this option is 
selected the label will be the same 
regardless of whether it is on a local 
system or on a remote system.

Local label prefixed with the 

system number

Local labels are prefixed with the 
system number.  This will 
automatically indicate whether a 
label on a panel operates on the 
local system or on a remote system 
and the identity of the remote 
system.

Freely editable

The labels may be set up with any 
system of identification the user 
requires.

TABLE 3-4: ALIAS LABELS OPTIONS
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Whenever one of these conditions occurs, the appropriate tone will be 
routed from the specified port to the panel that issued the request.

The label displayed on the Reply key will change to the specified 
comfort tone label.

Preferences > ISO and IFB
The Preferences > ISO and IFB tab enables you to define how ISO 
and IFB operations are implemented on the Eclipse HX v7.1 system.

Figure 3-12: ISO and IFB tab

If none of the checkboxes are selected, then the default ISO behaviour 
is that when a path between the source panel and an ISO destination 
becomes active, then any other listen paths at the ISO destination also 
remain active. This enables the ISO destination to hear both the caller 
and the other listens during the ISO conversation. 

This default behaviour is shown in the example in Figure 3-13  , where 
the Source panel is calling CAM-3. 

Tip: For information about the default IFB behaviour when none of the 
checkboxes are selected, see  IFB Interrupts other talks from 
Source Station below.
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Figure 3-13: ISO Default Operation

ISO Interrupts all other incoming audio at the ISO

If you select this checkbox, then the ISO destination can only talk and 
listen to the calling source.

 The previous listen paths are interrupted (turned off) for the duration of 
the ISO conversation.

The calling panel will continue to hear the other listens, but talk paths 
are turned off for the duration of the ISO conversation.  This is shown 
in Figure 3-14  where the source panel is calling CAM-3.

Figure 3-14: ISO Interrupts at ISO (modified operation)

ISO interrupts all other incoming audio at the caller

If you select this checkbox, then the ISO source can only talk and 
listen to the ISO destination.

The previous listen paths are interrupted (turned off) for the duration of 
the ISO conversation.  All listen paths to the ISO source are also 
turned off, so that the ISO source can only talk and listen to the ISO 
destination.

This is shown in Figure 3-15  where the source panel is calling CAM-3.
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Figure 3-15: ISO Interrupts at Caller (modified operation)

IFB Interrupts other talks from Source Station

If none of the checkboxes are selected, then the default IFB behaviour 
is that when an IFB path is active between a panel (the IFB source) 
and a destination port, then none of the other talk paths are 
deactivated from that panel.

The communication path to the IFB destination will also be carried by 
the other active talk paths.

If the IFB Interrupts other talks from Source Station checkbox is 
selected however, all the other talk paths from the panel are 
interrupted (turned off) for the duration of the IFB talk.

This enables you to make a private call to a remote dialled-in IFB 
destination.

Assign multiple sources to IFB from AP panel

When this checkbox is selected,  an AP panel can assign multiple 
sources to an IFB destination. The IFB will hear all the talk from the 
selected sources.

Preferences > System Access Codes
Aspects of system functionality can be protected with access codes. 
Use this tab to enter codes to unlock features.
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Figure 3-16: System Access Codes tab

DTMF Passcodes

Use the DTMF Passcodes section to set the global access codes 
within the Eclipse HX v7.1 System. Eight DTMF codes are available for 
accessing the Eclipse HX System from a remote location (using DTMF 
Inward Access).

When you assign a value to any of the eight available DTMF codes, 
that code becomes recognizable to any MVX-A16 port in the Eclipse 
HX System.

Note:
For Eclipse HX-PiCo, only ports 17 to 32 can be configured for DTMF 
access codes.

You can configure a TEL-14 module that is connected to a MVX-A16 
port with a setting that tells the port to recognize any, all, or none of 
the configured DTMF access codes.

If any MVX-A16 port has been configured to recognize one or more of 
the DTMF access codes, then that port will allow any caller to access 
the system who correctly enters a recognized access code.

Note:
Access codes are formed of numeric characters and must be four 
digits long.  EHX will not allow a password field containing fewer than 
four characters, and will only accept numerals.

When a user manual dials, the DTMF tones go out on the last selected 
talk to an interface. An interface is either a TEL-14, CCI-22, FOR-22 or 
a Direct.
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Figure 3-17: Example DTMF Passcodes

Panel Menu Access Code

The menus on V-Series main panels can be PIN-code protected. Enter 
the PIN code here. When users attempt to access PIN-protected 
menus they will have to enter this code.  

The PIN protected menus on V-Series panels are:

• Sys Config Access

• Local Pref Menu access

• Diagnostic Menu Access

Features Passcode

You can enter a 16 digit passcode to enable Production Maestro to 
operate with the frame.

This passcode is purchased / obtained from Clear-Com. For more 
information, see your Clear-Com representative.

Note:
If the passcode is changed an apply and red reset is required to 
implement the change.

Preferences > Wireless Beltpacks
The Preferences > Wireless Beltpacks tab enables you to configure 
the system identifier and DECT parameters for CellCom / FreeSpeak 
wireless beltpacks. 

A password is required to access the DECT configuration facility. For 
more information, contact your Clear-Com representative. 
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Figure 3-18: Wireless Beltpacks Tab

To configure the DECT frequency, click Configure.  Enter the DECT 
configuration password to display the DECT configuration screen 
(Select Frequency Region).

Figure 3-19: Select Frequency Region

The frequency range used by the wireless beltpacks can be set:

• Directly by entering the required value into the field. 

• By selecting the appropriate region, using the radio buttons.

• The country where the wireless system will be used from the 
drop-down menu. 

If you use either of the last two options, the correct frequency range 
value is automatically inserted.

To confirm the frequency range, click OK.

Preferences > Key Operation
The Preferences > Panel & Key Operation tab controls the incoming 
audio signalization (tally) key color of keys and rotary encoders on 
panels connected to Eclipse HX matrices.
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Figure 3-20: Key Operation Tab

Tally Settings

Use this section to change the incoming Tally light color (the default is 
red). The options are:

• Red. Tally light color is red.

• Green. Tally light color is green (I-Series only).

Panels generate In-Use Tallies on talk out AND receive

Select this option to generate an In-Use tally signal on the called panel. 
The tally will be displayed on all other panels which have a label to the 
called panel.

The default for the option is unchecked.

Panels continue to receive incoming calling tally AFTER reply

If you select this option, the receiving panel will continue to receive and 
display the incoming call tally after the incoming call has been 
answered using the Reply key. 

Note:
The key signalizations are displayed by both I-Series and V-Series 
panels.

If Tally Settings is set to Red, then panels flash dim red at 4 Hz after 
reply and then at the release of the talk key. 

If Tally Settings is set to Green, then I-Series panels flash dim green 
at 4 Hz after reply and then at the release of the talk key. 

V-Series panels show bright green solid after reply and then at the 
release of the talk key.

The default is for the option to be unchecked.
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Feedback Settings 

If this option is selected, the label of any Forced Listen port will appear 
in the Reply / Answerback stack of the listening panel. 

The option is unchecked by default. 

Reply Key

Use this section to determine the order in which incoming calls to a 
panel are stacked on the Reply Key.  

• If the First caller option is selected then the calls are ordered on 
the basis of “first in first out” so the reply key answers the calls in 
the order they are received.  I

• If the Last caller option is selected, then the calls are ordered on 
the basis of “last in first out”. This means that the Reply Key 
answers stacked calls by starting with the most recent call.

The default is that the first call is answered first.

Preferences > IP Panels
The Preferences > IP Panels tab determines the default Codec and 
IP port to be used by the IVC-32 card when communicating with panels 
over IP.

Figure 3-21: IP Panels tab

The Codec option specifies the algorithm used to compress the audio 
in digital form for transmission over IP.  Currently the default is G.722 
which is enabled by default.  It cannot be disabled.

The remaining IVC-32 card parameters such as IP address and port 
are set up when the card is configured in Cards and Ports (see 
chapter 5 for further information).

Preferences > Production Maestro Pro
The Production Maestro Pro tab allows the user to select the type of 
audio level metering to be used by the system.
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Figure 3-22: Production Maestro Pro OptionsMetering Scale and Ballistics

Metering scale and ballistics

The metering scale and ballistics options specify how the audio levels 
are scaled and displayed.

Nordic N9

The Nordic N9 option displays the audio level as a peak programme 
meter (PPM) and gives a better level reading. The scale is of the type 
used in Scandinavia.

VU

The VU option displays the audio level as a Volume Unit (VU) meter 
and uses Root Mean Square voltage to display the audio level.  This is 
a commonly used type of audio metering but does not always give the 
most accurate reading.

The VU meter scale has zero point at +4dBu with a decibel scale 
ranging non-linearly from 20dB below this point to 3dB above.

Preferences > Configuration Download

Figure 3-23: Configuration Download tab

The Configuration Download options are applicable to Apply 
Changes downloads without a reset, and to red resets (the matrix and 
its crosspoints are reset after download).
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You can select (or deselect) one or more of the following options:

• Delete all locally made key assignments (Key assignments that 
were made locally from either panel menus or in Online mode). 

• Delete all locally made IFBs or Forced Listen assignments 
(IFBs or Forced Listen assignments that were made locally from 
either panel menus or in Online mode).

• Delete all locally made I/O level changes (Input and Output 
levels that were modified by the panel. Crosspoint I/O levels are 
unaffected).

• Delete all locally made Fixed Group member changes (Fixed 
Group members that were modified from the panel).

• Delete all locally made Partyline member changes (Partyline 
members that were added locally from the panel).

MATRIX ICON MENU: CONFIGURATION OPTIONS
Right click the matrix icon on the System pane to display the matrix 
icon menu. To go to the configuration options, click Configuration.   

Configuration Manager
The Configuration Manager (which you can access directly from the 
matrix on the layout pane) enables configurations to be saved, loaded, 
imported and exported. You can also protect configurations through 
password protection.

Figure 3-24: Configuration Manager Screen

Enter the name of the new matrix and click Update Details. You may 
also want to enter an optional description and configuration password.  
3
 Clear-Com®
EHX User Guide

- 2 6



The template checkbox indicates that this project is to be fixed as 
read-only.  It can be used as a basis for creating new projects, by 
opening the configuration and saving it as a new project.

Click Update Details to update the project without closing the 
Configuration Manager screen.

The Profile column is color-coded:

• Green indicates the configuration can be downloaded without a 
reset.

• Red indicates a black reset is required (clearing the matrix frame 
memory after download). Such a reset may break trunk tables, 
and is undesirable in a multi-user multi frame system.

The profile of a frame describes how it interacts with other matrix 
frames in a linked system. This column indicates whether the selected 
configuration matches the existing frame profile or whether it will affect 
other frames in the linked system.

Configuration > Create New Configuration
It is possible to create a new configuration which may be empty or 
which contains only the hardware discovered from the matrix.

To create a new configuration:

1. In the right hand layout pane, right-click the display for the target 
matrix in the main section of the display. A context menu is 
displayed. 

2. Select Configuration > Create New Configuration and then either 
Discover Hardware or Empty.

Figure 3-25: Creating a New Configuration 
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If Discover Hardware is selected, a warning message will be 
displayed before the current hardware configuration is replaced (see 
below).

To continue, click Yes.  EHX interrogates the matrix to obtain the 
current hardware configuration.

If Empty is selected, the configuration is created with no hardware or 
configured devices.

Figure 3-26: Discover Hardware Confirmation

Configuration > Upload Configuration from Matrix Frame

It is possible to upload the last downloaded configuration, including 
labels, from the matrix.

To upload the last downloaded configuration from the matrix:

1. In the right hand layout pane, right click the display for the target 
matrix in the main section of the display. A context menu is 
displayed. 

2. Select Configuration > Upload Configuration from Matrix 
Frame. The configuration uploads to EHX from the matrix.

Figure 3-27: Uploading a Configuration 
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Configuration > Back up Key Status
The Configuration > Back up Key Status option enables the EHX 
user to upload and store a record of all the talk and listen keys active at 
the time on the EHX server.

This function also saves the states of the panel microphones, panel 
headsets and panel loudspeakers. For example, you could use this 
facility to record the state of talk and listen keys prior to a Black reset of 
the matrix.

This function is used in conjunction with the Restore Key Status 
function (see below).

Configuration > Restore Key Status
The Configuration > Restore Key Status option allows the EHX user 
to download  a previously saved record of the state of talk and listen 
keys to the matrix to restore the talk and listen keys to their previous 
states. 

This function also restores the states of the panel microphones, panel 
headsets and panel loudspeakers. This could be done for example 
after a Black reset of the matrix.

This function is used in conjunction with the Back up Key Status 
function (see above).

MATRIX CONTEXT MENU: FIRMWARE OPTIONS
Right click the matrix icon on the layout pane to display the context 
menu. For the firmware options, select Firmware.

The Firmware options enable you to:

• Update firmware.

• Request the details of all the firmware versions on the matrix cards 
and attached panels which support the function.

Note:
Updating the firmware is covered in the chapter on software installation 
(together with upgrading CPU firmware).
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Figure 3-28: Firmware options

The firmware versions are listed in a text window and can be exported 
to a *.csv file. This file type is usually opened by spreadsheet 
programs, such as Excel.  An example of a firmware report is shown in 
Figure 3-29 .

Note:
It is also possible to update the firmware from the Tools menu, by 
selecting Apply Firmware To System.

Figure 3-29: Firmware Report Display
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The report provides a summary of the firmware versions, followed by a 
detailed list for all devices that provide this information.

Device Firmware information listed

CPU card

CPU cards list the boot PROM 
version, the application version, the 
versions of the CPLDs and the 
current settings of the DIP 
switches.

MVX-A16 card
MVX-A16 cards will list the application 
version and HDLC version.

Fiber card
Fiber cards will list the FPGA version.

E-QUE card
E-Que cards will list the boot code 
version, the FPGA version and the 
application version.

IVC-32 card

IVC-32 cards will list the boot code 
version, the FPGA version and the 
application version.

LMC-64 card

LMC-64 cards will list the boot code 
version, the FPGA version and the 
application version.

V-Series panel

V-Series main panels will list the boot 
code version, the application version, 
panel kernel version and the filesystem 
version.  V-Series expansion panels 
will only list boot and application 
versions.

I-Series panel
I-Series panels will report the 
application version.

TABLE 3-5: FIRMWARE REPORT INFORMATION
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MATRIX CONTEXT MENU: SORT INTELLIGENT LINKS
Right click the matrix on the layout pane to display the context menu. 

To sort any links that exist between matrices in a linked set, select Sort 
Intelligent Links.

No dialog is displayed.

MATRIX CONTEXT MENU: DELETE MATRIX FRAME 
FROM PROJECT
Right click the matrix icon on the layout pane to display the context 
menu. 

To remove the matrix and all configuration information from the current 
project, select Delete Matrix Frame From Project.  

Figure 3-30: Matrix Delete Confirmation

To continue, click OK. 

When the operation is complete the matrix icon will be deleted from the 
System pane.

MATRIX CONTEXT MENU: APPLY CHANGES
Right click the matrix icon on the layout pane to display the context 
menu. To apply the changes you have made to the configuration to the 
matrix, select Apply Changes.
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Figure 3-31: Download Dialog

Merge
To merge the current EHX configuration with the rack configuration 
before download, click Merge.  

Use Merge if the rack configuration has been changed as a result of 
making changes in EHX Online mode or from assignment panels.  In 
both cases these changes would not be captured by the current EHX 
configuration and would be lost if a download was performed without 
first merging the configurations. 

Note:
Merge has the same effect as performing a merge in Online mode and 
will display the same informatory messages.

To continue with the download to the frame, click OK. 

Options
Options displays a further dialog, which enables you to customize the 
implementation of the download.
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Figure 3-32: New Configuration Download Options

Apply Changes Settings

You can select any or all of the following actions in Apply Changes 
Settings:

• Delete all locally made key assignments

• Delete all locally made IFB or Forced Listen assignments

• Delete all locally made I/O level changes

• Delete all locally made Fixed Group member changes

• Delete all locally made Partyline member changes

Reset Frame

You can select one of the following reset options in Reset Frame:

• Apply changes with reset (to initialize new hardware or add 
trunks).  

• Apply changes with reset and clear all memory (overwrite frame 
with EHX configuration). 

To continue with the download, click OK. A new configuration will be 
built and downloaded to the frame.
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Preserving Locally Assigned Keys
When a download (Apply Changes) is performed all the locally 
assigned keys (keys assigned from a panel rather than EHX) will be 
lost unless a merge operation is performed before the download. 

If the user wishes to retain these keys in the new configuration map the 
user should go into Online mode and merge the locally assigned keys 
with the new configuration before downloading and then save the 
modified project.

The configuration can then be downloaded, preserving the locally 
assigned keys.
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MANAGING 
CONFIGURATIONS 
AND USERS

FILE MENU: INTRODUCTION
Projects may be created, opened, saved and deleted using the File 
menu.

In client-server mode, projects may also be exported as *.hxn files and 
imported back into EHX at a later time.

Figure 4-1: File Menu

4
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FILE MENU: CREATING A NEW PROJECT
To create a new project:

1. Select File (Alt-F) > New Project (CTRL-N).

2. In Client-Only mode, the project is created. 

Note:
When you save the project in Client-Only mode, a standard 
Windows Save As dialog is displayed. Enter a project name and 
click Save.

In Client-Server mode, a dialog is displayed. Enter a name for the 
project. To create the new project, click Save.

FILE MENU: OPENING A PROJECT
To open a project:

1. Select File (ALT-F) > Open (CTRL-O).

2. In Client-Only mode, a standard Windows Open dialog is displayed. 
Navigate to the project file and click Open.

Note:
A list of Recently opened files is also available from the File menu.

In Client-Server mode, a dialog is displayed with a list of available 
projects. Select the project and click Open.

Figure 4-2: Client-Server mode: Project list dialog
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Note:
If a project is already open, EHX will ask if the current project should 
be saved before opening the new project.

Password protection override
EHX users with administrator rights can open any configuration within 
a project, even if a configuration password has been set in the 
Configuration Manager. Users with administrator rights can also 
reset the password if required.

If an EHX user without administrator rights tries to open a password 
protected configuration within a project, they must enter the correct 
password.

FILE MENU: CLOSING A PROJECT
To close a project, select File > Close.  EHX will prompt you to save 
the project before closing.

Figure 4-3: Save prompt when closing a project

FILE MENU: IMPORTING AND EXPORTING 
A PROJECT
Note:
Client-Server mode only. In Client-Only mode, files are opened directly 
from the PC.

You can import a project / configuration (*.ccn or *.hxn file format) into 
EHX by selecting File > Import Project.

Navigate to the project file you want to import. Select the file and click 
Open.

The project is then displayed in the normal project selection screen 
and the required project can be selected and loaded, as described 
previously (see above).
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Note:
After a project file is imported from a previous version of EHX, it is 
advisable to ensure that the matrix type is set correctly. 

If the imported configuration is currently active on the matrix, and has 
not been renamed, Clear-Com recommends applying the imported 
configuration to the matrix before entering Online mode. 

You can export a project (*.hxn file format only) from EHX by selecting 
File > Export Project.

Navigate to the desired folder location. Name the file and click Save.

FILE MENU: SAVING A PROJECT
To save the project, select File > Save Project (Ctrl-S).

Save Project As
To change the name or details of a configuration you want to save:
Select File > Save Project As.

3. In Client-Only mode, a standard Windows Save As dialog is 
displayed. Enter a project name and click Save.

In Client-Server mode, the Save Project dialog is displayed. Change 
the name and/ or description of the project and then click Save. 

Tip: Client-Server mode only: Save saves changes to the EHX 
database but does not download the configuration to the Eclipse HX 
matrix. To apply a configuration to the matrix, do any of the 
following:

• Select Tools > Apply changes to frame

• From the left hand screen matrix menu, click Apply Changes

• Right click the matrix icon on the system frame and select Apply 
Changes from the matrix icon menu.

FILE MENU: DELETING A PROJECT
Note:
Client-Server mode only. In Client-Only mode, you can delete project 
files directly from the PC.

To delete a project:

4. Select File > Delete Project.

5. The delete project screen is displayed.  Select the project to be 
deleted and click Delete.

6. A confirmation dialog is displayed. To continue with the deletion, 
click Yes.
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FILE MENU: IMPORT/EXPORT CONFIGURATION 
KEYSETS
You can use the Import/Export Configuration Keysets wizard (File > 
Import/Export Configuration Keysets) to:

• Export all the keysets in the current configuration to an external file.

• Import all the keysets from an external file and apply those keysets to 
the current configuration. Saved configuration keysets can be 
imported into other configurations avoiding the need to manually 
recreate panel setups.

Importing Configuration Keysets
To import configuration keysets:

1. Select File > Import/Export Configuration Keysets.

2. The welcome screen of the wizard is displayed. Select Import 
keysets.

Figure 4-4: Import and Export Configuration Keysets Dialog

3. Click Next.

4. Click Browse... to navigate to the keyset file you want to import. To 
load the file into the dialog, select the file and click Open.

Note:
The default file extension for the keyset files is *.KEYSET.
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Figure 4-5: Import Keyset File Dialog

5. To import the keysets into the current configuration, click Finish. 

Exporting Configuration Keysets
To export configuration keysets:

1. Select File > Import/Export Configuration Keysets.

2. The welcome screen of the wizard is displayed. Select Export 
keysets (see Figure 4-4).

3. Click Browse... to select a folder to save the file to. Enter the 
required filename.
Note:
The default file extension for the keyset files is *.KEYSET.

Figure 4-6: Exporting Configuration Keysets

4. To export the keyset configurations, click Finish.
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FILE MENU: USER MANAGEMENT
To access the user management facility, select File > User 
Management.

Note:
Only EHX users with network administrator rights (Network Admin) 
can access the user management facility.

The user management facility provides the tools necessary to 
administer EHX users and control the level of system access.  It is 
possible to:

• Add or delete users.

• Change passwords.

• Assign access levels or roles. 

Currently EHX has four access levels:

• Network Admin

• Local Admin

• User

• Guest

Tip: EHX remembers the last used login. If you are not required to 
save the login, deselect the Save option in the dialog.  EHX will display 
the name and role of the current user on the title bar of the EHX 
window.

Network Admin access level
The network administrator role provides unrestricted access to all of 
the configuration settings on all the systems in a linked set.  Network 
administrator rights include: 

• Configuration Management

• Configuration Allocation

• All configuration editing

• Digital Wireless setup

• IP Addressing

• Trunk Allocation

• User Management

• Online configuration

• Monitoring

• Live status under System

• Firmware update
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Local-Admin access level
The local administrator level provides unrestricted access to all of the 
configuration settings on all the local system the user is logged in to.  

The local administrator has no access to user management and 
cannot change the configuration settings on other systems in a linked 
set using the layout pane, but can view a linked set configuration.  The 
local administrator can also view the live status of system components 
using the layout pane.

Local administrator rights include: 

• Configuration Management

• Configuration Allocation

• All configuration editing

• Digital Wireless setup

• IP Addressing

• Online configuration

• Monitoring

• Live status under System

• Firmware update

User access level
The user level provides access to all configuration editing and 
downloading capability, including:

• Configuration Management

• Configuration Allocation

• All configuration editing

• Digital Wireless setup

• IP Addressing

• Online configuration

The user level has no access to user management or the layout pane 
and its associated functions.

Guest access level
The guest level provides a minimum level login and is the default role if 
the user is removed from all other groups.

The guest role only allows access to panel programming on the current 
system configuration. 
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The guest user can open more than one system configuration in a 
linked set but cannot modify any system parameters.  The guest role 
does not allow access to user management.

Managing user access levels
To access the user management facility, select File > User 
Management.

Note:
Only EHX users with network administrator rights (Network Admin) 
can access the user management facility.

When EHX is initially installed a single network administrator account 
is preconfigured with the username Administrator. This account can 
then be used to set up other accounts as required.

When user management mode is entered a complete list is shown of 
all the registered users. Users can be added, deleted and edited from 
this screen

Note:
If the user is removed from all other groups the user becomes a Guest 
user by default.

.

Figure 4-7: User Management screen

Creating a New EHX User
To create a new EHX user:

1. Select File > User Management.

Note:
Only EHX users with network administrator rights (Network Admin) 
can access the user management facility.
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2. The User Management screen is displayed. To add a new User ID, 
click New.

A new user is added. The default access level is Network Admin 
(see above).

Figure 4-8: Creating a New User 

3. Edit the Username,  Description, and Password fields. Double 
click to highlight the entry. 

To delete the default entry for these fields, click Delete and type in 
the new entry. 

4. To change the access level of the new user:

a. Go to the Available Groups pane.g

b. Select either Local Admin or User and use the right arrow (>>) to 
transfer that role into Group user is in. 

The previous access level is replaced by the new access level in the 
Group user is in pane.

5. When you have completed your changes, click Close.
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Editing an Existing EHX User
To edit a user:

1. Select File > User Management. The User Management screen is 
displayed.

Note:
Only EHX users with network administrator rights (Network Admin) 
can access the user management facility.

2. Select the user you want to edit from the list. To modify the 
Username, Password, Description or access level groups the 
user belongs to, follow Steps 3 - 5 in Creating a New EHX User 
above.

3. When you have completed your changes, click Close.

Deleting a User
To delete a user:

1. Select File > User Management. The User Management screen is 
displayed.

Note:
Only EHX users with network administrator rights (Network Admin) 
can access the user management facility.

Ensure that a network administrator is logged into EHX to access 
user management.

2. Select the user you want to delete  and click Delete. 

A comfirmation prompt is displayed. To continue with the removal fo 
the user, click Yes. 

3. To exit the User Management screen, click Close.

Important note:
One valid network administrator account must always be available to 
allow login to EHX and to access User Management. You cannot 
delete either the default network administrator account or the currently 
logged in user account.
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THE EHX SCREEN AFTER A PROJECT HAS BEEN 
LOADED
When a project has been loaded for editing:

• The EHX menus are displayed on the left hand side of the screen.

• The Tools > Apply changes to frame link is enabled.

The Diagnostics menu is only displayed if a valid system 
configuration is present. 

Figure 4-9: Menu Display with Projects Loaded

Tip: The Go Online button enables EHX to enter Online mode. This 
enables some matrix configuration items (highlighted in green) to be 
modified interactively without needing to download a new 
configuration.
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CONFIGURING THE 
ECLIPSE HX SYSTEM

USING THE LEFT PANE EHX MENUS
The EHX menus in the left hand pane are used to configure and 
manage your Eclipse HX system devices, including:

• Matrices (Eclipse HX-Omega, Eclipse HX-Median, Eclipse HX-Delta 
and Eclipse HX-PiCo)

• Matrix hardware ports and interface cards (including MVX-A16 
analog port cards, E-QUE E1/T1 cards, IVC-32 IP cards, LMC-64 
metering cards, E-FIB fiber cards, and E-MADI64 cards).

• Interface frames (such as the IMF-3) and modules (such as the 
TEL-14, FOR-22, CCI-22, RLY-6, and GPI-6 modules).

• User panels (V-Series and I-Series).

• Two-wire and four-wire intercom systems.

• Wireless intercom systems (such as CellCom / FreeSpeak).

You can use the EHX menus to set up and manage partylines, Sort 
Groups, Key Groups, routes, speed dials, wireless beltpacks and 
beltpack roles, and configure GPIs and GPOs, as well as many other 
tasks.

Figure 5-1: Eclipse HX Main Menu
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Various menu items may be highlighted amber to indicate possible 
configuration issues:

MATRIX HARDWARE
The Hardware menu is utilized to build up the configuration of the 
Eclipse HX system.

The Eclipse HX system combines hardware items with port functions.  
Hardware items may include configuration cards, interface cards, ports 
(panels or Interfaces) and RLY-6/GPI-6 modules.  Port functions also 
use this link and provides access to the advanced settings for ports 
and also where local preferences are configured.

Menu HIghlighted when...

System

There is an open project, but 
not an open configuration.

There is an open configuration 
but the matrix type is not set.

There are multiple frames in the 
system but the fiber ring is 
judged to be incorrect.

Cards and Ports
There are no ports configured 
for a particular frame.

IP Devices
There are IP cards which do 
not have any available ports

Beltpacks
There are antennas but no 
beltpacks

Panels

There are key groups which do 
not have members

There are configured panels 
but no configured keys

Controls
There are speed dials but no 
controls.

TABLE 5-1: HIGHLIGHTED CONFIGURATION ISSUES
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Note: To build a configuration, at least one MVX-A16 or IVC-32 
card must be configured in an Eclipse HX-Omega, Eclipse 
HX-Median or Eclipse HX-Delta matrix.  If no cards are fitted 
the first available slot should be configured in EHX as if an 
MVX-A16 card was present in order for the map to build.

FONTS
A number of fonts are supported by Eclipse HX systems allowing 
suitable panels to display labels in Latin and certain non-Latin scripts.  
The fonts supported by Eclipse HX systems are described below with 
the panel support.

Eclipse HX v7.1 has additional font support for the V-Series panels:

• Basic Latin. The backslash is a Yen character. This is a 
size-maximized font (no descenders, lower-case characters are not 
relative in size to upper-case characters). This covers Unicode 32 to 
127 (decimal), 0x20 to 0x7F (hex).  The V-Series panel display will 
support ten characters.

• Cyrillic. This is a normal, relatively-sized font. The V-Series panel 
display will support ten characters. Covers Unicode 1024 to 1279 
(decimal), 0x400 to 0x4FF (hex) with some missing characters.

• Hiragana. The V-Series panel display will support five characters. 
This covers the codepoint range 12352 to 12447 (decimal), 0x3040 
to 0x309F (hex).

• Full-width Katakana. The V-Series panel display will support five 
characters as this is a normal wide font. This covers the codepoint 
range 12448 to 12543 (decimal), 0x30A0 to 0x30FF (hex) with some  
missing characters.

• Kanji. There are about 17,000 out of the 21,000 characters. The 
V-Series panel display will support five characters. This covers the 
codepoint range 19968 to 40895 (decimal), 0x4E00 to 0x9FBF 
(hex).

• Hangul. The V-Series panel display will support five characters, 
codepoint range is 44032 to 55215 (decimal), 0xAC00 to 0xD7AF 
(hex).

• Half-width katakana. The V-Series panel will support ten characters. 
The codepoint range is 65376 to 65440 (decimal), 0xFF60 to 
0xFFA0 (hex).

Basic Latin
Basic latin labels can be displayed on all the panels with a display 
capability.  The maximum number of characters displayed will depend 
on the type of panel.
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Cyrillic
Cyrillic labels requires Russian language support to be installed in 
Windows and either an ASCII keyboard with Russian character 
support or a Cyrillic keyboard.  Cyrillic is only supported on V-Series 
panels.

Hangul
Hangul labels require Korean language support to be installed in 
Windows and either an ACSCII keyboard with Korean language 
support or a Korean language keyboard.  Hangul is only supported on 
V-Series panels.

Hiragana, Katakana and Kanji
Hiragana, Katakana and Kanji labels require Japanese language 
support to be installed in Windows and either an ASCII keyboard with 
Japanese character support or a Japanese language keyboard.

Hiragana, Katakana, half-width Katakana and Kanji labels can be 
displayed on V-Series panel only while some other panel types can 
support half-width Katakana.  If an attempt is made to place a 
Hiragana, Katakana or Kanji label onto a panel with a display that is 
not compatible the label will either fail to display correctly (may display 
question marks) or not display at all.

Half-Width Katakana Compatible Panels
The following panels can display half-width Katakana labels:

• V12LD

• V24LD

• V12LDD

• V12PD

• V24PD

• V12PDD

• V12RD

• V24RD

• V12RDD

• V12LDE

• V12PDE

• V12RDE

Katakana and Kanji labels may be entered in exactly the same way as 
normal labels provided the prerequisite software and hardware is 
present.
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Figure 5-2: Panel Configuration

SYSTEM CONFIGURATION LIMITS
The configuration limits for the Eclipse HX v7.1 matrix system are as 
follows:

Configuration item Limit (Max. number)

Fixed Groups 999

Partylines 399

Partyline members 64

IFBs 200

GPSF 3200

Controls 999

Physical ports 496 (36 on Eclipse HX-PiCos)

TABLE 5-2: CONFIGURATION LIMITS
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ONLINE CONFIGURATION
Online configuration allows the EHX user to directly access 
configuration information from the matrix and update the matrix 
configuration used by EHX.  All the Online Configuration facilities 
require an ethernet connection to the matrix.

Tip: Online mode is described in more detail in chapter 9 of this 
manual.

MATRIX HARDWARE SETUP
To begin configuring the matrix hardware, go to Hardware > Cards 
and Ports.

 

Figure 5-3: Initial Matrix Hardware Screen

Beltpack roles 200

Matrix frames 15

Keys 249600

Configuration item Limit (Max. number)

TABLE 5-2: CONFIGURATION LIMITS
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If the matrix is available on the network (the correct firmware has been 
loaded and the IP address has been set up), the hardware can be 
auto-detected by clicking Detect New Hardware at the top of the 
screen.

ADDING AN MVX-A16 CARD
The MVX-A16 is a 16 port matrix card designed to connect 16 intercom 
panels,  interfaces or external 4-wire devices to the Eclipse HX System 
(Eclipse HX-Omega, Eclipse HX-Median and Eclipse HX-Delta only). 
MVX-A16 cards can be added, removed and viewed in the matrix 
hardware screen.

Figure 5-4: Eclipse HX Empty Slots

To add an MVX-A16 card:

1. In Hardware > Cards and Ports, navigate to an available slot 
number (marked Empty). Do either of the following:

• Double click the slot.

• Right click the slot and select Set Card Type.

2. A drop-down menu is displayed, listing the available card types. 
Select MVX-A16.

Repeat this step for the number of required MVX cards.

Note:
MVX-A16 cards must already be fitted into the Eclipse HX frame with 
no empty slots left between the cards.

Tip: You can also change an existing card by right-clicking the slot and 
selecting Set Card Type. (Changing the type of card will delete any 
ports, panels and keys that exist on the card).
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REMOVING AN MVX-A16 CARD
To remove an MVX-A16 card from the configuration:

1. In Hardware > Cards and Ports, navigate to the slot number of the 
MVX-A16 card you want to delete.  Do either of the following:

• Double click the slot.

• Right click the slot and select Set Card Type. 

2. A drop-down menu is displayed, listing the available card types.  
Select Empty. 

3. A warning dialog is displayed. To confirm the deletion, click Yes.

UPGRADING THE MVX-A16 CARDS
You can upgrade the MVX application code (*.fwc) with EHX.

The boot code file (*.mot) is upgraded using the Renesas Flash 
Development Toolkit 3.4 Basic (FDT), not EHX. 

You can also use the FDT to upgrade the MVX boot and application 
code simultaneously, using the combined MVX boot and application 
code file (*.mot).

Tip: For detailed upgrade procedures and information, including 
upgrades that you cannot perform in EHX, see the Eclipse HX 
Upgrade Guide.

To upgrade the MVX application code (for all the MVX-A16 cards) 
using EHX:

1. Ensure that you have the following equipment:

Equipment Description / Notes

PC with an Ethernet or 
serial port

-

EHX software EHX must be installed and configured

Ethernet or serial 
connection

For the matrix to PC connection

TABLE 5-2: UPGRADING THE MVX APPLICATION CODE
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2. Start EHX on the PC.

3. Connect the matrix to the PC using either an Ethernet or serial port.

4. In EHX, open the configuration. Select System > Layout.

5. Right click the matrix and then select Firmware> Update Firmware.

6. The Update Firmware wizard dialog is displayed. Click Next.

In the Select Hardware Type screen, ensure that the Card radio 
button is selected:

Figure 5-5: Select Hardware Type dialog

7. Click Next and then navigate to the MVX application code file 
(*.fwc): 

a. Go to Software DVD > Eclipse HX-Omega-Median-Delta > 
xxxxxZ – MVX Application (where xxxxxxZ represents the part 
number). 

The folder contains the *.fwc file and a Read Me file (*.txt) with 
version information.

b. Select the*.fwc file and click OK / Open. 

MVX application code 
files

The appropriate application code file 
(*.fwc format), which is available from 
the Eclipse HX v7.1 software DVD:

Software DVD > Eclipse 
HX-Omega-Median-Delta > 
xxxxxxZ-MVX Application (where 
xxxxxxZ represents the product 
number). 

Equipment Description / Notes

TABLE 5-2: UPGRADING THE MVX APPLICATION CODE
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8. Click Next and confirm that the details displayed are correct.

9. Click Next and confirm that the download commences.

10. When the download has completed, click Finish to close the 
update firmware wizard.

11. Ensure that the MVX cards reset once the download is complete. 

Reset should take approximately 1 minute.

12. When the download has completed, click Finish to close the 
update firmware wizard.

Note:
You can use the Firmware report tool in EHX to confirm the firmware 
version of the MVX application code. To use the Firmware report 
tool:
a. Open EHX and go to System > Layout .

b. Right click the matrix icon.

c. Select Firmware > Firmware report.

Figure 5-6: Ports on MVX-16 Card

SHOW ALL PORTS
This option is available from the top of the screen.

Click to toggle between Show All Ports, which shows all the ports on 
the MVX-A16 card, or Show Configured Ports, which only shows 
currently configured ports. 
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PORT LIST OPTIONS
Click Port List Options at the top of the screen to hide or show the 
Show All Ports and Detect New Hardware buttons, and the Search 
dialog.

PORT NUMBER
The Port Number field is non-editable. Port numbering is presented in 
the format <Card>.<Position> (<Absolute Position>), where:

<Card> is the number of the interface card.

<Position> is the port number on the interface card.

<Absolute Position> is the port number that is achieved by counting 
through all the ports on the matrix frame (including all the ports on the 
cards that were installed to the frame before this card). 

PORT FUNCTION

Figure 5-7: Port Function > Port Type menu

Each port in a system must be assigned a port function which specifies 
the port’s intended use, including what type of device is connected to 
the port. 

The port’s intended use is important as the system will treat a port 
differently if it is connected to a user panel rather than a telephone 
interface for example. 
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The Port Function column displays each port’s functions according to 
the current configuration.  Each line in this column features a 
drop-down menu listing the available port type options.

To set the port function:

1. Click the row for the port.

2. Click the Port Function field. A drop-down menu is displayed.

3. From the drop-down menu, select the desired device (user panels 
and interfaces that may be connected to the port).

The available device types are listed below:

• AES Mono

• Panel Aux

• CCI-22

• Direct (4 wire external)

• E1 Direct (E-QUE port using E1 protocol)

• FOR-22

• I-Series Panels

• Panel Aux

• Telephone (TEL-14)

• Trunk (matrix to matrix network trunk line)

• V12LD Panel

• V12PD Panel

• V12RD Panel

• V24LD Panel

• V24PD Panel

• V24RD Panel

• V12LDD Panel

• V12PDD Panel

• V12RDD Panel
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Device Details
• AES Mono - The port is configured for an AES-6-RJ interface 

providing a monaural connection to third party equipment.

• CCI-22—The CCI-22 port function is commonly used when a port is 
configured as a 2-Wire Party Line. Call signals are sent to and 
received from an external Clear-Com party line in the same way that 
they are sent between panels within the Eclipse HX System.

• Direct— Commonly used when the port is wired directly to an 
external 4 wire device.

• FOR-22— The FOR-22 has a number of different functions, however 
the Port type is set as a FOR-22 but in the Advanced Settings for 
that port the function allocated to the FOR-22 is set in the 
Application field. The commonly used applications are as follows:

• Two-Way Radio—When the 2-Way Radio port function is 
selected, the port is configured to operate a push-to-talk two-way 
radio system.  The call signal output activates a relay to key the 
radio’s transmitter.

Note:
If the FOR-22 is to be used as a 2-Way Radio from remote 
systems, the FOR-22 relay should be added as a secondary 
action in Advanced Settings. When the FOR-22 is in 2-Way Radio 
mode the rack has control of the relay and will automatically fire it.

• 4-Wire —When the port is wired directly to an external device. 
Normally 4-wire functions are only audio connections and do not 
use call signals.  By default, when a four-wire port is connected to 
an FOR-22 4-Wire Audio Interface, a call signal sent to the port 
from the Eclipse HX System activates the FOR-22 channel’s 
relay.  Alternatively, this relay can be activated by attaching the 
relay name to a control label configured in the Control Manager.

Note:
When the FOR-22 is in four-wire mode the relay will not 
automatically fire. To make the relay fire when a talk path to the 
FOR-22 is created a control must be created and added as a 
secondary action in the Advanced Settings for the FOR-22.
When enabled in Partyline mode the FOR-22 allows panels to 
listen to all commands to/from the interface.

• I-Series Panel - The port is configured to drive an I-Station with 30 
pushbuttons.
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• Panel Aux - The port is configured for an AES-6-CX interface 
providing a binaural connection to a panel supporting split-ear 
operation.  This type of port must be configured as part of a pair of 
ports to provide a binaural connection to the panel.  The first or 
master port of the pair is configured for the attached panel in the 
normal way and the Aux Port is the second port configured under 
Basic Settings.

• Telephone (TEL-14)—When the (telephone) port function is 
selected, the port is configured to operate a TEL-14 Telephone 
Interface.  The call signal output is used as a request from the 
Eclipse HX system for the interface to go off-hook.  A call signal sent 
from the TEL-14 interface to the Eclipse HX indicates that the line is 
ringing or that the line is off-hook.

• Trunk - An MVX-A16 port is configured to function as a trunk line to a 
remote matrix.  The connection must be configured in the ‘System’ 
screen and cannot be configured from the Matrix Hardware setup.  
The ‘Linking Options’ shown under the ‘Advanced Settings’ menu is 
for information only.

• V12LD - The port is configured to drive a V-Series panel with nine 
pages of 12 lever keys allowing up to 108 connections including 
reply.

• V12PD - the port is configured to drive a V-Series panel with nine 
pages of 12 pushbuttons allowing up to 108 connections including 
reply.

• V12RD - the port is configured to drive a V-Series panel with nine 
pages of 12 rotary encoders allowing up to 108 connections 
including reply.

• V24LD - the port is configured to drive a V-Series panel with nine 
pages of 24 lever keys allowing up to 216 connections including 
reply.

• V24PD - The port is configured to drive a V-Series panel with nine 
pages of 24 pushbuttons allowing up to 216 connections including 
reply.

• V24RD - The port is configured to drive a V-Series panel with nine 
pages of 24 rotary encoders allowing up to 216 connections 
including reply.

• V12LDD - the port is configured to drive a V-Series lever key desktop 
panel with nine pages of 12 lever keys allowing up to 108 
connections including reply.

• V12PDD - the port is configured to drive a V-Series pushbutton 
desktop panel with nine pages of 12 pushbutton keys allowing up to 
108 connections including reply.
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• V12RDD - the port is configured to drive a V-Series rotary desktop 
panel with nine pages of 12 rotary encoder keys allowing up to 108 
connections including reply.

Tip: The Eclipse HX matrix may require different code in the MVX-A16 
cards. See the customer release note on the software DVD-ROM.

Summary of Expansion Panels

The following devices are expansion panels and cannot be selected 
from the matrix hardware drop-down menu.  They are only selectable 
from the expansion panel menu under Advanced Options.  The 
panels/devices listed will vary depending on the type of master panel 
they are being configured with.

The expansion panels supported by EHX are:

• V12LDE Panel

• V12PDE Panel

• V12RDE Panel

• E-Station

Tip: Details of which expansion panels are supported by the various 
panels are given in the section on panel options.

Deleting a Port Assignment
After a port has been configured in EHX, the port key assignments and 
advanced settings can be deleted.

To delete port assignments and settings:

1. Select the box next to the Port number. The whole row is 
highlighted.

2. Set the port type to Empty.

LABEL
A label is used to identify a port. 

Labels can contain up to 10 characters, using numbers, capital letters, 
all punctuation marks and blank spaces. A label can be split into two 
parts, each part containing a maximum of five characters.

Note:
The ‘£’ (pound) sign is not a valid character and will result in the 
configuration map being rejected by the Eclipse HX System.

If the appropriate option is selected in Preferences > Intelligent 
Linking tab, the local talk labels may be prefixed with the system 
number.
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DESCRIPTION
The description field is usually used to provide a more detailed 
description of the port function than the Talk/Listen label. 

The description field is limited to 23 characters.

The description field is cleared when a port is newly configured and a 
description must be entered when the port is configured. 

SORTING PORTS
Each of the columns in the Cards and Ports screen have a sort 
capability.  To sort on a column move the mouse cursor over the name 
of the required column. The column is highlighted a light blue color. 
Click to sort the column. 

Each column sorts as follows:

• Port Function – Groups together Ports functions, then toggles 
between first and last on the screen.

• Label – Alphabetically sorts, using the Talk component of the label, 
then the Listen component of the label. Numerical labels come first, 
then lettered labels.  If you click the column again, the sort toggles 
between first and last ports.

• Description – Sorts on numerical fields then letter fields.

COLUMN/ROW RESIZING
Within the System Ports screen rows and columns can be re-sized by 
moving the mouse cursor over a row or column, the cursor should 
change to a double ended arrow, left click and hold the mouse button 
and drag to required size.

PORT PROPERTIES
Port Properties enables the EHX operator to tailor the behavior of a 
selected port. 

To view the port properties for a particular port:

1. Select the required interface card.

2. Select the relevant port and the Port Properties for that Port will be 
displayed. 
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Note:
By default the Port Properties tabs will initially not be displayed in 
expanded form. To expand a class of advanced settings click on the ‘>’ 
beside the heading. The Port Properties that are available to you 
depend on the type of device the port is configured for.

The Port Properties options for panels and Interfaces are described 
below.

ASSIGNMENT PANEL (AP) PANEL OPTIONS
The Port Properties options for an AP panel (Assignment Panel) are as 
follows:

Fixed Group Assignment
Set to True or False (default False).  Allows the panel operator to 
select ports to be assigned to a fixed group.

IFB Assignment
Set to True or False (default False).  Allows the panel operator to 
select ports as sources to be assigned to an IFB.

Partyline Assignment
Set to True or False (default False).  Allows the panel operator to 
select ports as fixed members of a party line.

Applies to:
V-Series and I-Series Panels only.

AUXILIARY RELAY OPTIONS

The Port Properties options for an Auxiliary Relay are as follows:

Has Associated Relay
The port device controls a relay (similar to secondary action).  

For example if an external device is connected to an MVX-A16 and 
that external device can control a relay the relay can be controlled 
through this setting.

Applies to:
Direct connections.
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BASIC OPTIONS
The following Basic options are available:

Port Number
The port number the device is configured on.

Note: Not available on Concert panels.

Alias (Remote Matrix)
Specifies the remote system the trunk device is connected to.  This is 
configured in ‘System’ and is displayed in Advanced Settings for 
information only; it cannot be set using Advanced Settings.

Note: Only used on Trunk devices.

Comments
A scratchpad for engineers to record any relevant information about 
the port or device.

Description
The Description field in the port settings table.

Dial Code
Allows the panel to dial out on a phone line using a preset key.

Note: Only on I-Series Panels.

Label
The Listen Label specified in the port settings table (a combined 
Talk/Listen label is shown unless the option for 10 character labels is 
turned off).

Reserve Port
Setting the port as shared reserves the port for trunked 
applications.Reserve port has no function when systems are not fiber 
linked.

Note: Not available for AES Mono and Panel Aux.
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Split Label
If Split Label is set the first five characters and the last five characters 
of a label are displayed separately. If this option is not set all ten 
characters are shown (on panels that support ten characters).

Applies to:

The Description, Comments, Label and Port Number fields are 
available for all port devices unless noted otherwise.

PANEL OPTIONS
The following Panel options are available:

Reply Tally Auto Clear Time
The time interval for automatic answerback in seconds.  To adjust the 
time, select answerback time to display the slider and set the time as 
required.  The time can be set from 0 to 60 seconds. The default is 10 
seconds.

Display brightness
Sets the display brightness on panels that have a suitable display.  To 
adjust the display brightness select the brightness box to display the 
adjustment slider and use the mouse to drag the slider to the required 
setting.  The brightness is adjustable from 0 to 10.  The default setting 
is 0.

Note: Not available on Concert panel.

Display Dim Timer
Sets the time interval in minutes before the display on an inactive 
panel is dimmed to prevent damage to the display.  To adjust the time 
setting select the timer box to display the adjustment slider and use the 
mouse to drag the slider to the required setting.  The timer is 
adjustable from 0 minutes to 60 minutes.  If the timer is set to 0 
minutes the display is set to dim permanently.

If the dim timer is set to a value other than “Always Dim” the screen 
saver timer will only start after the screen has dimmed.  For example if 
the dim timer is set to 1 minute and the screen saver timer is set to 1 
minute the screen saver will start after 2 minutes.  If the dim timer is set 
to “Always Dim” the screen saver inactivity timer will start immediately 
as the dim timer will effectively be zero.

Note: Only available V-Series panels.
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Eavesdropping (Privacy)
This box is unchecked by default so other panels cannot eavesdrop on 
a panel’s microphone input, unless that panel has an active talk key 
pressed to another port in the Eclipse HX System.  If this box is 
checked, other panels can monitor a panel’s microphone input, even 
without any activated talk keys.  By default a panel’s microphone 
output is off until a talk key is pressed.  The panel’s Mic ON/OFF 
control will always take priority over eavesdropping.  The default 
setting is disabled.

Note: Eavesdropping must be enabled (checked) for a panel to 
act as an ISO destination is set so that the panel 
microphone can be remotely enabled by the ISO if it is not 
enabled at the destination.

Expansion Panels
Some types of panels can support expansion panels.  If this option is 
available selecting the expansion panel number attached box will open 
a menu showing the type of expansion panels that can be fitted to the 
host panel.  The types of expansion panels listed will vary according to 
the main panel type.

• V12LD - V12LDE may be fitted.

• V24LD - V12LDE may be fitted.

• V12PD - V12PDE may be fitted.

• V24PD - V12PDE may be fitted.

• V12RD - V12RDE may be fitted.

• V24RD - V12RDE may be fitted.

• V12LDD - no expansion panels are supported.

• V12PDD - no expansion panels are supported.

• V12RDD - no expansion panels are supported.

• i-Station - E Station, V Station may be fitted.

Headset Mic Type
The Headset Mic Type allows the type of headset microphone to be 
configured.  To set the microphone type highlight the item to allow the 
drop-down menu to be displayed.  The options for headset 
microphones are Dynamic Balanced, Dynamic Unbalanced (default)  
and Electret.  This setting applies to headset 1 and 2.
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Headset PTT Function
The Push to Talk function allows  the action for PTT to be selected.  
The options are No Function, Activate All Talk Keys and Activate 
Two-Way Radio.  The default is No Function.  This function is triggered 
by any of the PTT inputs on a panel.  

In the case of V-Series panels this function only relates to XLR-4 and 
XLR-5 type headsets that have been modified for PTT.  V-Series 
XLR-7 headsets and headsets connected to the auxiliary audio 
connector use the logic 1 and 2 inputs (see Logic Inputs).

The effect of these functions are:

• No Function - PTT has no effect.

• Activate All Talk Keys - PTT will activate audio paths on all latched 
talk keys.  Non-latching talk keys will not be activated.

• Activate Two-Way Radio - PTT will activate audio paths on all latched 
talk keys connected to two-way radios (normally via a FOR-22 unit).

Note: Not available on Concert panels.

Headset LS Cut
When enabled (True) this facility will automatically cut the audio to the 
panel loudspeaker if a headset is detected.  Highlight the option and 
use the drop-down menu to set the option to True or False.  The 
checkbox will indicate whether the option is enabled.

Note: Only available on V-Series panels.

Listen Again Auto Delete
The Listen Again auto delete timeout sets the length of time in minutes 
before a message recorded in the listen again buffer is automatically 
deleted.  If the delay is set to 99 minutes auto delete is disabled.   To 
set the listen again auto delete timeout highlight the option and click on 
the drop-down menu to display the slider.  Use the mouse to set the 
timeout to a value of 0 to 99 minutes.

Note: Only available on V-Series panels.

Mute Relay
If this is set to True the local panel GPO mute relay is fired when a Talk 
only key is pressed.  The default setting is false.
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Nearby Panel Partial
This attribute affects the way that  Nearby Panels configured in Local 
Advanced operate.

The ‘Nearby Panel Partial’ attribute is set to True to enable audio from 
nearby panels to be routed to the headset.  If it is not set audio from 
nearby panels is cut completely to prevent audio feedback. 

Page Override Allowed
The panel main volume audio can be overridden by paging audio from 
another panel.  The default setting is disabled.  For Page Override to 
operate this must be set to True on any destination panel where the 
local main volume setting may need to be overridden by a calling 
panel.  This is used in conjunction with Page Volume.

Note: Only available on Concert, V-Series panels.

Page Gain
Allows the Page Override gain to be set.  Use the gain adjust slider to 
set the required level.  The level range is from 0 to 10dB.  The default 
volume setting is 0dB.

This is used in conjunction with Page Override.

Note: Only available on Concert, V-Series and I-Series Panels.

Gooseneck Mic Type
The Gooseneck Mic Type allows the type of panel microphone to be 
configured.  To set the microphone type highlight the item to allow the 
drop-down menu to be displayed.  The options for microphones are 
Dynamic Balanced, Dynamic Unbalanced and Electret (default).

Panel Text Orientation
Determines the orientation of label text on V-series panels.

Line Release
Allows the panel to release the selected telephone line which may be 
held on by the incoming caller anywhere in the system.  The default is 
disabled.

Note: Not available on Concert.
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Screen Saver Timer
The screen saver timer facility sets the length of time a panel is 
inactive elapse before the screen saver is displayed.  The screen 
saver is used to prevent the display being damaged by being left for 
long periods with the same display.  The time may be set to any value 
between 1 and 60 minutes.  It cannot be disabled.

If the dim timer is set to a value other than “Always Dim” the screen 
saver timer will only start after the screen has dimmed.  For example if 
the dim timer is set to 1 minute and the screen saver timer is set to 1 
minute the screen saver will start after 2 minutes.  If the dim timer is set 
to “Always Dim” the screen saver inactivity timer will start immediately.

Note: Only available on V-Series Panels.

Applies to:

All panel devices.

IP PANEL OPTIONS
Note: IP Panel Options are only available for IVC-32 cards.

The IP Panel options are as follows:

UserID
Panel ID required for the panel to log in to the system via the IVC-32 
card.  The user ID is set in EHX and also entered on the panel for the 
panel to log in.

Note: The password must not contain upper case letters.

Network Connection
Selects the network connection type for an IP panel.  Select from LAN 
(high speed), WAN (intermediate) or Internet (low speed) from a 
drop-down menu.  The default ins LAN.

Audio Codec
Allows the codec (G.722) to be selected for IP connections.  

Password
Panel password required for the panel to log in to the system via the 
IVC-32 card. The password is set in EHX and also entered on the 
panel for the panel to log in.
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Applies to:

Only available on Concert and V-Series IP panels.

ASSIGNMENT PANEL OPTIONS
The Assignment Panel options are as follows.

Fixed Group Assignment
Enables the panel to add or remove members of a fixed group.

IFB Assignment
Enables the panel to add or remove members IFB sources to or from 
IFB destinations.

Partyline Assignment
Enables the panel to add or remove fixed members to or from 
partylines.

MENU OPTIONS

Local Preferences Access
Allow access to the local preferences menu via the local menu option.  
This allows access to audio level control, brightness settings, timeouts 
and crosspoint reset.  Access may be enabled for all users (True), 
denied to all users (False) or controlled by the PIN number. 

Select the option and click on the arrow to open the drop-down menu. 
Select the required access.

Note: Only on V-Series.

Diagnostic Menu Access
Allow access to the panel diagnostic menu via the local menu option.  
This allows some panel information to be displayed and access to 
panel reset and telephone line release functions.  Access may be 
enabled for all users (True), denied to all users (False) or controlled by 
the PIN number.  Select the option and click on the arrow to open the 
drop-down menu.  Select the required access.

Note: Only on V-Series panels.
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System Configuration Menu Access
Allows access to the system configuration menu via the local menu 
option.  This allows access to partyline, fixed group, remote panel, 
local panel, forced listen, input level and output level menus.  Access 
may be enabled for all users (True), denied to all users (False) or 
controlled by the PIN number.  Select the option and click on the arrow 
to open the drop-down menu.  Select the required access.

Note: Only on V-Series Panels.

Supervisor Mode Access
Enables the panel to supervise another panel.

Note: Only on V-Series Panels.

VOICE OPERATED SWITCH
Four settings are available under Port Properties > Voice Operated 
Switch. These settings determine how the audio gate operates.

•   Audio Gating Delay determines how quickly the audio gate closes 
when the operator stops speaking. Adjust this value so that the 
audio gate does not close too early and cut off words at the end of 
sentences or during small gaps. 

• Audio Gating turns the audio gate function on or off. By default, this 
setting is off. This function gates (performs a logical AND) on the 
crosspoint and the Vox detection threshold.  If the crosspoint is 
made from the port and the input Vox level exceeds the detection 
threshold then audio will be passed to the port.

•  Audio Presence Tally (also known as Vox tally) causes a panel’s 
listen key to flash on a panel whenever audio above the set 
threshold level is detected. 

•   Audio Detection Threshold sets the audio level at which the “audio 
gate” opens and closes. Typically the threshold value is set at the 
level of a human voice, so that when a person speaks into the 
microphone, the audio gate switches open to allow audio onto the 
intercom line. When the person stops speaking, the gate closes, 
regardless of the fact that background noise may be present. 
Recommended levels are -3dB for panels and -20dB for interfaces.

If the VOX control option is configured, VOX will activate when the gate 
opens.
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Audio Gating Delay
This option determines the length of delay in seconds before the audio 
gate closes after the audio level falls below the preset threshold.

To set the Audio Gating Delay: 

1. In Port Properties > Voice Operated Switch, click Audio Gating 
Delay. A level adjustment slider is displayed on screen. 

2. Drag the level adjust slider to the desired setting from 0 to 4 
seconds.  The greater the value the longer the delay before the 
audio is cut.  This can be used to ensure that the audio is not cut 
during short pauses.

3. Click outside the Voice Operated Switch section to close the virtual 
slider box.  The new delay value is displayed.

Audio Gating 
An “audio gate” allows EHX to restrict or “gate” background noise at a 
panel microphone or interface’s input so that the background noise 
does not transmit to the intercom line. When the audio gate is activated 
the panel or interface operates as a flexible voice operated switch, 
which only transmits audio when it detects an audio signal 
characteristic level.

To enable Audio Gating

1. In the Audio Detection Threshold section of a port’s Advanced 
Settings, click Audio Gating. 
A drop-down arrow appears on the screen. 

2. Click the drop-down arrow to turn the audio gating feature on or off. 
A check appears on the screen to indicate the feature is on. The 
check disappears to indicate the feature is off. 

Audio Presence Tally

To enable Audio Presence Tally

1.  In the Audio Presence Tally section of a port’s Advanced Settings, 
click Audio Presence Tally.  A drop-down arrow appears on the 
screen. 

2.  Click the drop-down arrow to turn the Audio Presence Tally feature 
on or off. 

The operator can speak into a panel’s microphone and adjust the 
threshold value so that the audio presence light just goes out when the 
operator is not speaking, or input a tone into the interface input and 
adjust the threshold value.
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Audio Detection Threshold

To set the Audio Detection Threshold

1. In the Audio Detection Threshold section of a port’s Advanced 
Settings, click Audio Detection Threshold.  A level adjustment slider 
is displayed to set the threshold to value between 0 and -45dB.

2. Drag the slider to the desired setting. Increasing the value causes 
the only very loud sounds to open the audio gate, while decreasing 
the value causes even very soft sounds to open the gate. The “audio 
presence tally” feature may be used to help set the gate at the level 
of the audio signal.

3. Click outside the Voice Operated Switch section to close the slider 
and update the display to the new setting.

Applies to:

V-Series Panels, I-Series Panels, Concert, Direct, AES Mono, Panel 
Aux, FOR-22 and Telephone devices.

This feature is not available on IP panels.

GLOBAL OPTIONS
The following Global options are available:

Auto Listen
This function enables a port for auto-listen. When a panel activates a 
talk to a destination that is configured for auto-listen, a listen path from 
that destination back to the source panel will also be activated 
automatically for the duration of the call. In this way, the source 
receives audio from the destination without the destination having to 
specifically activate a talk back to the source.  The default setting is 
disabled.
Generally used on interfaces and four-wires.

Note: For Auto Listen to work correctly on external 4-Wire ports 
the MVX-A16 port must have the destination TX/RX looped 
together.

Auto Signal Tone
This function enables a panel or interface port for automatic call 
signalling. If a talk path is activated to a destination that has been 
configured for auto-call signalling, the call signal will be sent to the 
destination for the duration of the talk. Auto-call signals are most 
commonly used with external devices that require a control signal to 
activate them.

If a port set for auto-call signalling joins a partyline, or is preset to a 
partyline, an auto-call will not be sent to the port if the talk is to the 
partyline. The default setting is disabled.
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For panels which support Auto Signal - Call Signal must be enabled.

Panel Connected Tally
This allows the system to set a tally (flashing LED) on a panel 
indicating that the corresponding panel is connected to the system.  
The default is disabled.

This is normally used on remotely connected panels where the panel 
to matrix comms may suffer from an occasional loss of service.

Note: Not available for CCI-22, AES Mono, Panel Aux and Direct 
(no keys).

Global IFB
This function enables configuring a panel or interface as a global IFB 
destination. 

Any panel activating a talk to a global IFB destination creates a 
one-way talk path to that panel or interface.   If more than one panel at 
a time activates a talk to the global IFB destination, both sources can 
be heard by the destination.

When all IFB talks to the destination are deactivated, the destinations’ 
audio paths return to their previous states.  For IFB talks to also 
interrupt talks at the source, select the ‘IFB Interrupts All Other Talks 
From Source panel’ button in  ‘Matrix Frame Preferences’.  The default 
setting is disabled.

When Global IFB is enabled the Attenuation field is also enabled 
allowing the amount of attenuation or ‘Cutting’ for each label’s IFB 
level.   The adjustment range is from Full Cut to No Cut in 3db steps.  
The default setting is No Cut.

If an interface has Global IFB set and a destination position is talking to 
this interface then an incoming call from a local ISO source WILL NOT 
cause the outgoing talk from the destination panel to be cut as this is 
overridden by the Global setting. 

Global ISO
This function enables a panel or interface as a global ISO (Isolate) 
destination. 

Any panel activating a talk to a global ISO destination creates a 
private, two-way talk path between that panel and the destination.

All other communications will be interrupted by any call from any Panel 
or Interface in the Eclipse HX System. When the source terminates the 
call, its audio paths return to their previous state. When all ISO paths to 
the destination are deactivated, the destinations’ audio paths return to 
their previous states. For ISO talks to also interrupt listens at the 
source, select the ISO Interrupts All Other Listens check box in ‘Matrix 
Frame Preferences’. The default is disabled.
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Users should note that ISOs are always local to the matrix so the 
source and destination must be devices on the same matrix.  An ISO 
destination cannot be set to a remote matrix.

Note: If the destination of an ISO is a panel then ‘Eavesdropping’ 
must be enabled in Global Settings (Advanced Settings 
section) in order to activate the panel microphone if it is not 
already activated.  If the destination is not a panel but a 
device such as a 4-Wire port Eavesdropping does not need 
to be enabled for the destination device.

IFB Attentuation
When a port talks to the IFB destination, forced listens are 
automatically dimmed by the IFB Attenuation setting. 

Note: You make a port into an IFB destination by enabling Global 
IFB.

Latch Disable
This function prevents talks to the port from latching.  If a 
latch-disabled port is assigned to a talk key, the key can only talk to the 
port for as long as the operator physically holds down the key.   A 
latch-disabled port can be included in a fixed group or party line 
without automatically latch disabling the entire fixed group or party line.

Prevent Reply Signalization
Prevents key signalization for the calling panel appearing on the 
answerback (reply key).

Applies to:

V-Series Panels, I-Series Panels, Concert, Direct connections, AES 
Mono, Panel Aux, FOR-22 and Telephone devices.
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GAIN OPTIONS
The following Gain options are available: 

Aux Volume Off Limit
Sets the minimum limit for the auxiliary audio output so that the volume 
cannot be turned completely off.

Note: Only available on V-Series panels.

Headset 1 Sidetone Permanently On
Turns the headset 1 sidetone permanently on.

Headset 2 Sidetone Permanently On
Turns the headset 2 sidetone permanently on.

Input Gain
Allows the input gain to be set.  Use the input gain adjust slider to set 
the required gain from +15 dB to -45dB (or type in the value). The 
default is 0dB.

Main Volume Off Limit
Sets the minimum limit for the main audio output so that the volume 
cannot be turned completely off.

Note: Only available on V-Series panels.

Output Gain
Allows the output gain level to be set.  Use the output gain adjust slider 
control to set the required gain from +15 dB to -45dB (or type in the 
value). The default is 0dB.

Sidetone Gain
Sets the sidetone gain in dB for the panel.  The default is 0dB.

Note: Not available for V-Series, CCI-22, Concert, AES Mono, 
Panel Aux, Trunk, Direct and FOR-22 interfaces.

Headset 2 Microphone Gain
Sets the gain in dB for the panel headset 2 microphone.  The default is 
50dB.

Note: Not available for Concert, AES Mono, Panel Aux, Direct and 
FOR-22.
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Headset Microphone Gain
Sets the gain in dB for the panel headset microphone.  The default is 
50dB.

Note: Not available for Concert, AES Mono, Panel Aux, Direct and 
FOR-22.

Gooseneck Microphone Gain
Sets the gain in dB for the gooseneck (panel) microphone in dB.  The 
default is 0dB.

Note: Not available for Concert, AES Mono, Panel Aux, Direct and 
FOR-22.

Speaker Dim
This is to prevent howl-round. When a talk selector is activated on a 
panel, the speaker volume is attenuated by the value set within 
speaker dim. 

To change the setting select the box with the current setting to display 
the slider and use the mouse to drag the slider to the new setting.  The 
speaker dim can be adjusted from -15dB to 0db.  The default is -9 dB.

Applies to:

I-Series Panels.

AUDIBLE ALERT OPTIONS
The various configurable audible alerts on panels are as follows: 

Call Signal Tone
When checked the Call Signal Tone will enable an audible tone when a 
call signal is received by the panel.  The call signal can be used to 
signal an event on another panel.  The default setting is disabled.

Change or Error Tones
When checked the Change or Error Tones will announce whenever the 
configuration for that panel has changed or when there is an error on 
the panel.  When unchecked Change or Error Tones is disabled.  The 
default setting is disabled.

Monitoring Tones
Monitoring tones when checked enables the panel tone when another 
panel activates a listen to the first panel.  If the box is unchecked the 
Monitoring tone is disabled.  The default is disabled.
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Applies to:
V-Series panels, I-Series panels and Concert.

TALLY OPTIONS
The following Tally options are available:

Dimmed Tallies
Enables dimmed Tally lights (the default is enabled). 

Inhibit Amber Tally
When enabled, prevents the tally light for Talk and Listen keys on 
V-Series panels from being lit amber. The tally light will only be lit red.

Note: V-Series panels only

In Use Tally
This allows the system to set a tally (flashing LED) on a panel key 
indicating that the port is currently in conversation with another panel 
or interface. The default is disabled.

FAST KEY ASSIGN OPTIONS
Some V-Series options that control access to panel menus allow a pin 
code option to be selected.  If no pin code has been set under 
Preferences > System Access Codes a warning message will be 
displayed offering the user the option to set a pin code.  If a no pin 
code is set selecting this option will allow all users to access the menu.

Enable Assignment as a Listen
Enables the port to be assigned locally as a listen key by another 
panel.  If it is set to False it will prevent a listen key being assigned to 
the panel.

The default is True.

Note: This functionality only takes effect when making 
assignments on a V-Series panel or Concert Panel.

Enable Assignment as Talk
Allow the port to be assigned locally via Soft Mode as talk key by 
another panel.  If it is set to False it will prevent a Talk key being 
assigned to the panel.

The default is True.

Note: This functionality only takes effect when making 
assignments on a V-Series panel or a Concert panel.
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Default Assign as Talk and Forced Listen
When enabled this forces any key assigned to this panel to be a Talk 
and Forced Listen key.  It is interlocked with the ‘Enable Assignment as 
Listen’ and ‘Enable Assignment as Talk’ settings so that whenever the  
‘Default Assign as Talk and Forced Listen’ setting is True both ‘Enable 
Assignment as Listen’ and ‘Enable Assignment as Talk’ are forced to 
the True state.  If either or both of these settings is then changed to 
False the ‘Default Assign as Talk and Forced Listen’ setting is  
automatically changed to False.

When this setting is False the Enable Assignment as Listen’ and 
‘Enable Assignment as Talk’ settings can be set normally.

The default setting is False.

Note: This functionality only takes effect when making 
assignments on a V-Series panel.

Fast Key Assign
Enables the panel for Fast Key Assign. This facility allows the panel 
operator to locally assign panel keys to local or remote ports by direct 
input of the port number into the dial pad. The panel operator can also 
assign keys directly from sort groups.

The Eclipse HX scalable dialcode scheme for Fast Key Assign is as 
follows:

<matrix number><entity type><entity instance>

For example, Frame 1 > Hardware ports > Port 1 would be dialed into 
the dial pad as 0101001. 

The entity types are:

Entity Number

Hardware port 01

Partyline 02

Fixed Group 03

IFB 04

TABLE 5-2: FAST KEY ASSIGN ENTITY TYPES
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Local Fast Key Assign Shortcut
If you are using Fast Key Assign on the local system, you do not have 
to enter the matrix type and entity type.

To expedite Fast Key Assign on a local system:

1. On the V-Series panel dial pad, select # to enter Fast Key Assign 
mode.

2. Enter the number of the port you want (for example, 001).

3. To validate the entry, select * on the dial pad.

Tip: For more information about Fast Key Assign, see the V-Series 
Panel Guide.

Note:
Fast Key Assign can only be used on V-Series panels with dial pads 
(numeric keypads).

Protect Port from Assignment
Prevents this port from being locally assigned by another panel in soft 
mode.

Sort Groups
Opens a drop down menu so that sort group memberships can be 
edited and applied.

Note: Not on Concert, AES Mono and Panel Aux.

Applies to:
All panels unless otherwise noted.
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LOGIC INPUT OPTIONS
The Logic Inputs are used in relation to the Miscellaneous GPI 
connections on panels that are fitted with local option cards and 
V-Series panels.  

The logic inputs are also associated with PTT function on headset 1 
and headset 2 on V-Series panels where the headset is either an 
XLR-7 type headset connected to the front panel or a headset 
connected to the auxiliary audio connector.  In the case of V-Series 
panels headset 1 PTT 1  or headset 2 PTT 1 active will have the same 
effect as Logic 1 active.  Headset 1 PTT 2 or headset 2 PTT 2 active 
will have the same effect as Logic 2 active.  

The PTT actions for XLR-4 and XLR-5 headsets connected to a 
V-Series panel are determined by the ‘Headset PTT Function’ setting.

The following actions are available for both Logic Input 1 and Logic 
Input 2:  

• No Function

• Mic On/Off

• Mute Mic Output to Frame

• Mic Off (Momentary)

• Answerback Talk Clear

• Studio Announce

• Speaker Off

• PTT Activate all Talk Keys

• Activate Talk Switch 1

• Activate Talk Switch 2

• Activate Listen Labels

• PTT Activate Two Way Radio Talk Keys

• Select Route (and controls)

The default setting is No Function.

Applies to:
V-Series and I-Series Panels.

Logic Inputs 3 and 4 are only available on V-Series panels.  Logic 
inputs 3 is pre-assigned to Reply Key.  Logic input 4 is not 
currently used.
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ATTACHED CONTROL OPTIONS
The Port Properties options for an Attached Control are as follows:

Secondary Action
The Secondary Action allows a Control to be attached to a Port. 
Whenever a talk route key to the Port is pressed, the Control 
attachments such as Relays, Routes or Speed Dials, are activated.

VOX Action
The VOX Action allows a Control to be attached to a port. Whenever 
the audio level at the Port reaches the Audio Detection Threshold 
defined in Voice Operated Switch section of Advanced Settings the 
Control attachments such as Relays, Routes or Speed Dials, are 
activated.

Note:
Not available on Concert panels.

Applies to:
On all port devices except Trunk.

DTMF OPTIONS
The DTMF options are used to configure either the TEL-14 interface 
module or an external telephone hybrid for incoming calls. They are 
also used to control access to the system by the external caller. 

The setups for outgoing calls are configured on the MVX-A16 card 
which controls the outgoing DTMF on TEL-14 interface modules.

Access Prompt
Controls whether the port sends DTMF access prompt tones and may 
be enabled or disabled.  This allows the incoming caller to receive 
access prompts.  The default is enabled.

Assign DTMF Codes
Assigns a DTMF selector code to a specific audio path.  This allows 
the incoming caller to make various preselected links within the matrix 
by entering a specific code.
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Enable DTMF Passcodes
This enables the use of passcodes that are set up using the 
Preferences > DTMF Settings tab.  Up to eight DTMF passcodes can 
be set up for a system and each passcode can be enabled for a port 
using a drop-down menu.

When enabled incoming callers must enter a 4 digit passcode before 
being allowed access.

First Code Only
If this is enabled DTMF tone detection will be disabled after the first 
valid DTMF code has been received.  Default is disabled.

Note: Only on TEL-14.

Accumulate DTMF Codes
This field controls whether only one DTMF selector code can be used 
(disabled) or whether multiple DTMF selector codes can be used.  The 
default setting is disabled.

When enabled this allows the incoming caller to make multiple routes 
by dialling multiple codes.

One Digit Codes
If this is set enabled DTMF selector codes are limited to a single digit 
or the hash (#) and asterisk (*) characters.  The default setting is 
disabled.

Applies to:

Direct, CCI-22, FOR-22 and TEL-14 interfaces.
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GENERAL PURPOSE INPUTS (GPIS)
The Eclipse HX matrix has eight General Purpose Inputs (GPI) on the 
processor card and these Inputs are automatically added to EHX in the 
Matrix Hardware screen as module 0.  Further GPIs can be added to 
the system using GPI-6 modules by incrementing the number of GPI 
modules shown below the list.

Figure 5-8: GPI-6 modules are added/removed from the Matrix Hardware

ADDING AND REMOVING GPI-6 MODULES
To add / remove GPI-6 modules:

1. Open Hardware > GPIs.

2. The counter next to Number of External GPI-6 modules displays 
the current number of GPI-6 modules. To display a drop-down list of 
numbers, click the counter.

3. If you select a higher number than the current number, new GPI-6 
modules are added. Six new GPIs are added per module. 

If you select a lower number than the current number, GPI-6 
modules and their associated GPIs are removed.
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CONFIGURING GPIS
To configure either a matrix frame or GPI-6 input:

1. Identify the input number to be used from the GPIs screen.

2. Click the row to highlight it.

3. From the Available Controls list, select the required Talk label.

4. To transfer the label to the Attached Controls list, do either of the 
following:

• Click the => arrow.

• Double click the label.

5. To detach the Talk label from the GPI, select the required label in the 
Attached Controls list. 

6. To detach the label, do either of the following:

• Click the <= arrow. 

• Double click the label.

Note: When using an IMF-3 frame the GPI-6 cable should be 
connected first to the matrix GPI data connector before 
connecting any GPI-6 cards.

GENERAL PURPOSE OUTPUTS (GPOS)
The Eclipse HX Frame has 8 Frame General Purpose Outputs 
(GPOs), which are automatically added to EHX in Cards and Ports as 
module 0. 

RLY-6 modules are added/removed from the GPOs screen. 

Note:
Panel Relays are also managed from this screen, but are added and 
removed automatically when panels are managed from the cards and 
ports screen.
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Figure 5-9: GPOs Screen

ADDING RLY-6 MODULES
To add / remove RLY-6 modules:

1. Open Hardware > GPOs.

2. The counter next to Number of External RLY-6 modules displays 
the current number of RLY-6 modules. To display a drop-down list of 
numbers, click the counter.

3. If you select a higher number than the current number, new RLY-6 
modules are added. Six new GPOs are added per module. 

If you select a lower number than the current number, RLY-6 
modules and their associated GPOs are removed.

CONFIGURING GPOS
In Hardware > GPOs, use the checkboxes to set whether the relay 
output is activated with talk and or listen.  

The Control Manager is used to create and configure controls that can 
be attached to the relays.
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CONFIGURING THE E-FIB FIBER CARD
The E-FIB fiber card is designed to provide trunking between Eclipse 
HX-Omega, Eclipse HX-Median and Eclipse HX-Delta matrices.  The 
fiber cards can also be configured to provide redundancy in 
communications link between Eclipse HX matrices.  Each card 
provides two fiber rings.

ADDING AN E-FIB CARD
To add an E-FIB card:

4. In Hardware > Cards and Ports, navigate to an available slot 
number (marked Empty). Do either of the following:

• Double click the slot.

• Right click the slot and select Set Card Type.

5. A drop-down menu is displayed, listing the available card types. 
Select either E-FIB (Fiber) or E-FIB (Redundant).

Note:
Only one E-FIB (Fiber) and one E-FIB (Redundant) card can be 
added. Clear-Com recommends that E-FIB cards are fitted to slots 6 
and/or 7 of Eclipse HX-Median matrices, slots 14 and/or 15 of Eclipse 
HX-Omega matrices and slot 4 of Eclipse HX-Delta matrices.

Figure 5-10: E-FIB Fiber Card Selection
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REMOVING AN E-FIB CARD
To remove an E-FIB card:

1. In Hardware > Cards and Ports, navigate to the slot number of the 
E-FIB card you want to delete.  Do either of the following:

• Double click the slot.

• Right click the slot and select Set Card Type. 

2. A drop-down menu is displayed, listing the available card types.  
Select Empty. 

3. A warning dialog is displayed. To confirm the deletion, click Yes.

CONFIGURING AN E-FIB CARD
The E-FIB card provides a single fiber port that can be configured to 
have Talk and Listen labels and a description.  

Note: If E-FIB Fiber (Redundant) is selected, no ports are 
displayed because the card parameters cannot be 
configured.

Figure 5-11: Fiber Card Configuration

The Port Properties menu allows the following parameters to be set.
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Basic Options

Fiber Port Count

The Fiber port count specifies the number of unidirectional fiber 
channels that will be configured for the fiber card.  The port count may 
be set to  a maximum of 192 ports in multiples of 16.  As a general 
guide the port count (fiber channels) can be set to the maximum of 192 
ports in networks with five or fewer matrices as this will not use all the 
timeslots (but see note below).

For networks with more than five matrices the port allocations must 
take account of the maximum number of simultaneous talks and listens 
across the network with a maximum of 1024 timeslots being available.  
The matrix event log can be used to help tailor the port counts for the 
matrices.  Alternatively the user may contact Clear-Com support for 
assistance in configuring the network.

Note: The port count should not be set to an excessive number 
(significantly more that the number of panels available for 
connection via the fiber card) as this may reduce system 
performance.

Port Number

The port number is set to the next available port on the system.  For 
example, if two MXV-A16 cards are installed before the fiber card the 
port number will be set to 33 (16+16+1).

The port number cannot be changed in Port Properties.

Remote Frame

The remote matrix frame that the fiber trunk is connected to.  Selecting 
this option will display a list of remote systems that the fiber trunk may 
be connected to in order to select the target system. For a system to 
be listed it must have been set up in ‘My Systems’ as linked to the 
current matrix so that the hardware can be allocated.

CONFIGURING THE E-QUE CARD
The E-QUE card is designed to allow Eclipse HX matrices to be 
connected to CellCom/FreeSpeak wireless antennas/beltpacks or 
connected together using E1 or T1 protocol (see chapter 3 “Matrix 
Frame Preferences”).
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ADDING AN E-QUE CARD
To add an E-QUE card:

1. In Hardware > Cards and Ports, navigate to an available slot 
number (marked Empty). Do either of the following:

• Double click the slot.

• Right click the slot and select Set Card Type.

2. A drop-down menu is displayed, listing the available card types. 
Select one of the following E-QUE card options:

• E-QUE (E1 Direct)

• E-QUe (T1 Direct

• E-QUE (E1 Trunk)

• E-QUE (T1 Trunk)

• E-QUE (E1 Direct/Trunk)

• E-QUE (T1 Direct/Trunk)

• E-QUE (Antenna)

• E-QUE (Splitter)

Note:
The E-QUE entry selected should be correct for the intended use as 
the cards will be configured differently by EHX.
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Figure 5-12: E-Que Card Selection

Tip: A total of four E-QUE, IVC-32 or LMC-64 interface cards may be 
fitted to an Eclipse HX-Omega. A total of three E-MADI64 cards may 
be fitted to the matrix. 

E1 DIRECT
The E1 Direct is an E-QUE card that has been configured for 60 direct 
ports using E1 protocol.  Each E1 port can be used as an E1 
communication line to another E1 device. The following section 
provides guidance on configuring an E1 Direct in Cards and Ports.

Port Function

This is always set to ‘E1 Direct’.

Label

Label for the port used to assign the port to a path. The label has 10 
characters, or can be split into two parts, each of maximum five 
characters.

Description

Optional port description, up to 255 characters long.
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Card Properties

For an E-QUE card in E1 Direct mode the Clock Recovery mode and 
Codec should be set by clicking on the ‘Card Properties’ link in the 
lower right of the hardware display.  This will display the Clock 
Recovery and Codec setup.

Figure 5-13: E1 Direct Card PropertiesClock Recovery

The data clock may be generated by the E-QUE card (Local 
Generated) or taken from the E1 line.  The clock source will need to be 
determined before configuration.  Select the correct configuration by 
clicking on the appropriate radio button.

Codec

E-QUE cards configured as E1 Direct use two cables plugged into 
ports 1 (top) and 5 (bottom) for the E-QUE card to provide E1 ports.  
The top cable (Top Half) provides the first 30 ports (1-30) and the 
bottom cable (Bottom Half) provides the second 30 ports (31 - 60).  
The top and bottom cables can be configured to use different Codecs.  
The Codecs available are:

• G722 - standard G722 conversion and compression.

• G722 A-Law - uses an A-law algorithm to optimize the G722 
codec. This is often used in European systems. 

• G722 µ-Law - uses a µ-law algorithm to optimize the G722 codec.  
This is often used in North America and Japan.

Click on the appropriate radio button to select the codec for top and 
bottom cables.
5
 Clear-Com®
EHX User Guide

- 4 6



T1 DIRECT
The T1 Direct is an E-QUE card that has been configured for 48 direct 
ports using T1 protocol.  Each T1 port can be used as an E1 
communication line to another T1 device. The following section 
provides guidance on configuring an T1 Direct in Cards and Ports.

Port Function

This is always set to ‘T1 Direct’.

Label

Label for the port used to assign the port to a path. The label has 10 
characters, or can be split into two parts, each of maximum five 
characters.

Description

Optional port description, up to 255 characters long.

Card Properties

For an E-QUE card in T1 Direct mode the Clock Recovery mode and 
Codec should be set by clicking on the ‘Card Properties’ link in the 
lower right of the hardware display.  This will display the Clock 
Recovery and Codec setup.

Figure 5-14: E1 Direct Card PropertiesClock Recovery

The data clock may be generated by the E-QUE card (Local 
Generated) or taken from the T1 line.  The clock source will need to be 
determined before configuration.  Select the correct configuration by 
clicking on the appropriate radio button.

Codec

E-QUE cards configured as T1 Direct use two cables plugged into 
ports 1 (top) and 5 (bottom) for the E-QUE card to provide T1 ports.  
The top cable (Top Half) provides the first 30 ports (1-30) and the 
bottom cable (Bottom Half) provides the second 30 ports (31 - 60).  
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The top and bottom cables can be configured to use different Codecs.  
The Codecs available are:

• G722 - standard G722 conversion and compression.

• G722 A-Law - uses an A-law algorithm to optimize the G722 
codec. This is often used in European systems. 

• G722 µ-Law - uses a µ-law algorithm to optimize the G722 codec.  
This is often used in North America and Japan.

Click on the appropriate radio button to select the codec for top and 
bottom cables.

E1 TRUNK
An E-QUE card set to E1 Trunk is used to connect Eclipse HX matrices 
using E1 trunking protocol.  The System Ports display will show two 
ports numbered 1 and 31.  

Figure 5-15: E1 Trunk Ports

Port 1 represents 30 “virtual” ports 1 - 30 which will be allocated 
automatically for communications.  Port 31 represents a further 30 
“virtual” ports 31 - 60 that are automatically allocated. 

Port Function

This is always set to ‘E1 Trunk’.

Label

Label for the E1 direct port used to assign the port to a path. The label 
has 10 characters, or can be split into two parts, each of maximum five 
characters.

Description

Option port description up to 255 characters long.

Card Properties

For an E-QUE card in E1 Trunk mode the Clock Recovery mode and 
Codec should be set by clicking on the ‘Card Properties’ link in the 
lower right of the hardware display.  This will display the Clock 
Recovery and Codec setup.
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Figure 5-16: E1 Trunk Card Properties

Clock Recovery

The data clock may be generated by the E-QUE card (Local 
Generated) or taken from the E1 line.  Normally the card should be set 
to ‘Line Recovery’ for connection to a third party device or E1 network.  
For other devices the clock source will need to be determined before 
configuration.  Select the correct configuration by clicking on the 
appropriate radio button.

If connecting two Eclipse HX matrices back to back using E1:

• An E1 or T1 crossover cable is required.

• One E-QUE card should be set to ‘Local Generated’ clock and the 
other to ‘Line Recovery’ clock.

Codec

E-QUE cards configured as E1 Trunk use two cables plugged into 
ports 1 (top) and 5 (bottom) for the E-QUE card to provide E1 trunk 
ports.  The top cable (Top Half) provides the first 30 ports (1-30) and 
the bottom cable (Bottom Half) provides the second 30 ports (31 - 60).  
The top and bottom cables can be configured to use different Codecs.  

The available Codecs comprise:

• G722 - standard G722 conversion and compression.

• G722 A-Law - uses an A-law algorithm to optimize the G722 codec. 
This is often used in European systems. 

• G722 µ-Law - uses a µ-law algorithm to optimize the G722 codec.  
This is often used in North America and Japan.

Click the appropriate radio button to select the Codec for top and 
bottom cables.
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E1 TRUNK
An E-QUE card set to E1 Trunk is used to connect Eclipse HX matrices 
using E1 trunking protocol.  The System Ports display will show two 
ports numbered 1 and 25.  

Figure 5-17: T1 Trunk Ports

Port 1 represents 24 “virtual” ports 1 - 24 which will be allocated 
automatically for communications.  Port 25 represents a further 24 
“virtual” ports 25 - 48 that are automatically allocated.  

Port Function

This is always set to ‘T1 Trunk’.

Label

Label for the port used to assign the port to a path. The label has 10 
characters, or can be split into two parts, each of maximum five 
characters.

Description
Option port description up to 255 characters long.

Card Properties

For an E-QUE card in T1 Direct mode the Clock Recovery mode and 
Codec should be set by clicking on the ‘Card Properties’ link in the 
lower right of the hardware display. This will display the Clock 
Recovery and Codec setup.

Figure 5-18: T1 Trunk Card Properties
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Clock Recovery

The data clock may be generated by the E-QUE card (Local 
Generated) or taken from the T1 line.  Normally the card should be set 
to ‘Line Recovery’ for connection to a third party device or a T1 
network.  For other devices the clock source will need to be 
determined before configuration.  Select the correct configuration by 
clicking on the appropriate radio button.

If connecting two Eclipse HX matrices back to back using T1:

• An E1 or T1 crossover cable is required.

• One E-QUE card should be set to ‘Local Generated’ clock and the 
other to ‘Line Recovery’ clock.

Codec

E-QUE cards configured as T1 Trunk use two cables plugged into 
ports 1 (top) and 5 (bottom) for the E-QUE card to provide T1 trunk 
ports. 

The top cable (Top Half) provides the first 24 ports (1-24) and the 
bottom cable (Bottom Half) provides the second 24 ports (25 - 48).  
The top and bottom cables can be configured to use different Codecs.  
The Codecs that are available comprise:

• G722 - standard G722 conversion and compression.

• G722 A-Law - uses an A-law algorithm to optimize the G722 codec. 
This is often used in European systems. 

• G722 µ-Law - uses a µ-law algorithm to optimize the G722 codec.  
This is often used in North America and Japan.

Click the appropriate radio button to select the Codecs for top and 
bottom cables.

T1 TRUNK
An E-QUE card set to T1 Trunk is used to connect Eclipse HX matrices 
using T1 trunking protocol.  The System Ports display will show two 
ports numbered 1 and 25.  

Figure 5-19: T1 Trunk Ports

Port 1 represents 24 “virtual” ports 1 - 24 which will be allocated 
automatically for communications.  Port 25 represents a further 24 
“virtual” ports 25 - 48 that are automatically allocated.  
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Port Function

This is always set to ‘T1 Trunk’.

Label

Label for the port used to assign the port to a path. The label has 10 
characters, or can be split into two parts, each of maximum five 
characters.

Description
Option port description up to 255 characters long.

Card Properties

For an E-QUE card in T1 Direct mode the Clock Recovery mode and 
Codec should be set by clicking on the ‘Card Properties’ link in the 
lower right of the hardware display. This will display the Clock 
Recovery and Codec setup.

Figure 5-20: T1 Trunk Card Properties

Clock Recovery

The data clock may be generated by the E-QUE card (Local 
Generated) or taken from the T1 line.  Normally the card should be set 
to ‘Line Recovery’ for connection to a third party device or a T1 
network.  For other devices the clock source will need to be 
determined before configuration.  Select the correct configuration by 
clicking on the appropriate radio button.

If connecting two Eclipse HX matrices back to back using T1:

• An E1 or T1 crossover cable is required.

• One E-QUE card should be set to ‘Local Generated’ clock and the 
other to ‘Line Recovery’ clock.
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Codec

E-QUE cards configured as T1 Trunk use two cables plugged into 
ports 1 (top) and 5 (bottom) for the E-QUE card to provide T1 trunk 
ports. 

The top cable (Top Half) provides the first 24 ports (1-24) and the 
bottom cable (Bottom Half) provides the second 24 ports (25 - 48).  
The top and bottom cables can be configured to use different Codecs.  
The Codecs that are available comprise:

• G722 - standard G722 conversion and compression.

• G722 A-Law - uses an A-law algorithm to optimize the G722 codec. 
This is often used in European systems. 

• G722 µ-Law - uses a µ-law algorithm to optimize the G722 codec.  
This is often used in North America and Japan.

Click the appropriate radio button to select the Codecs for top and 
bottom cables.

E1 DIRECT/TRUNK
The E1 Direct/Trunk is an E-QUE card that has been configured for 60 
ports using E1 protocol. The first 30 are available to be set as E1 
Directs, the second 30 are used as a single E1 trunk connection (and 
shown only as Port 31 - as on an E1 trunking card). 

Port Function

This is always set to Direct except for the last port which is set to 
Trunk.

Label

Label for the port used to assign the port to a path. The label has 10 
characters, or can be split into two parts, each of maximum five 
characters.

Description
Option port description up to 255 characters long.

Card Properties

For an E-QUE card in E1 Direct/Trunk mode, the Clock Recovery 
mode and Codec should be set by clicking on the ‘Card Properties’ link 
in the lower right of the hardware display. This will display the Clock 
Recovery and Codec setup.
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Figure 5-21: T1 Trunk Card Properties

Clock Recovery

The data clock may be generated by the E-QUE card (Local 
Generated) or taken from the E1 line.  Normally the card should be set 
to ‘Line Recovery’ for connection to a third party device or an E1 
network.  For other devices the clock source will need to be 
determined before configuration.  Select the correct configuration by 
clicking on the appropriate radio button.

If connecting two Eclipse HX matrices back to back using E1:

• An E1 or T1 crossover cable is required.

• One E-QUE card should be set to ‘Local Generated’ clock and the 
other to ‘Line Recovery’ clock.

Codec

E-QUE cards configured as E1 Direct/Trunk use two cables plugged 
into ports 1 (top) and 5 (bottom) for the E-QUE card to provide E1 trunk 
ports. 

The top cable (Top Half) provides the first 16 ports (17-32) and the 
bottom cable (Bottom Half) provides the second 15 ports (33 - 48).  
The top and bottom cables can be configured to use different Codecs.  
The Codecs that are available comprise:

• G722 - standard G722 conversion and compression.

• G722 A-Law - uses an A-law algorithm to optimize the G722 codec. 
This is often used in European systems. 

• G722 µ-Law - uses a µ-law algorithm to optimize the G722 codec.  
This is often used in North America and Japan.

Click the appropriate radio button to select the Codecs for top and 
bottom cables.
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TI DIRECT/TRUNK
The T1 Direct/Trunk is an E-QUE card that has been configured for 48 
ports using T1 protocol. The first 24 are available to be set as T1 
Directs, the second 30 are used as a single T1 trunk connection (and 
shown only as Port 24 - as on a T1 trunking card).

. 

Port Function

This is always set to Direct except for the last port which is set to 
Trunk.

Label

Label for the port used to assign the port to a path. The label has 10 
characters, or can be split into two parts, each of maximum five 
characters.

Description
Option port description up to 255 characters long.

Card Properties

For an E-QUE card in E1 Direct/Trunk mode, the Clock Recovery 
mode and Codec should be set by clicking on the ‘Card Properties’ link 
in the lower right of the hardware display. This will display the Clock 
Recovery and Codec setup.

Figure 5-22: T1 Trunk Card Properties

Clock Recovery

The data clock may be generated by the E-QUE card (Local 
Generated) or taken from the T1 line.  Normally the card should be set 
to ‘Line Recovery’ for connection to a third party device or a T1 
network.  For other devices the clock source will need to be 
determined before configuration.  Select the correct configuration by 
clicking on the appropriate radio button.
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If connecting two Eclipse HX matrices back to back using T1:

• An E1 or T1 crossover cable is required.

• One E-QUE card should be set to ‘Local Generated’ clock and the 
other to ‘Line Recovery’ clock.

Codec

E-QUE cards configured as T1 Direct/Trunk use two cables plugged 
into ports 1 (top) and 5 (bottom) for the E-QUE card to provide T1 trunk 
ports. 

The top cable (Top Half) provides the first 16 ports (17-32) and the 
bottom cable (Bottom Half) provides the second 15 ports (33 - 48).  
The top and bottom cables can be configured to use different Codecs.  
The Codecs that are available comprise:

• G722 - standard G722 conversion and compression.

• G722 A-Law - uses an A-law algorithm to optimize the G722 codec. 
This is often used in European systems. 

• G722 µ-Law - uses a µ-law algorithm to optimize the G722 codec.  
This is often used in North America and Japan.

Click the appropriate radio button to select the Codecs for top and 
bottom cables.

E-QUE ANTENNA
This action automatically adds an E-QUE card with eight antenna ports 
configured.  Each antenna provides six user ports.  The hardware table 
shows the first user port number for each antenna rather than the 
E-Que port number.  Therefore the first antenna is shown as port 1 (the 
first beltpack port) and the second antenna is shown as port 7 
(previous first port number plus six), since beltpack ports 1-6 are on 
the first antenna. This is repeated for successive antennae.

Figure 5-23: Antenna Ports
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Port Function

This is always set to “Antenna”.

Label

Label for the port used to assign the port to a path. The label has 10 
characters, or can be split into two parts, each of maximum five 
characters.

Description
An optional description for the port of up to 255 characters long.

E-QUE SPLITTER
This action automatically adds an E-Que card with two splitter ports 
configured.  Each splitter can support up to five antennae and each 
antenna provides six beltpack ports.  The hardware table shows ten 
antennae with the first beltpack port number for each antenna rather 
than the E-QUE port number.

Therefore the first antenna is shown as port 1 (the first beltpack port) 
and the second antenna is shown as port 7 (previous first port number 
plus six), since beltpack ports 1-6 are on the first antenna.  This is 
repeated for successive antennae.

Figure 5-24: Splitter Ports

Port Function

This is always set to “Antenna”.

Label

Label for the port used to assign the port to a path. The label has 10 
characters, or can be split into two parts, each of maximum five 
characters.
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Description

An optional description for the port of up to 255 characters long.

REMOVING AN E-QUE CARD
To remove an E-QUE card:

1. In Hardware > Cards and Ports, navigate to the slot number of the 
E-QUE card you want to delete.  Do either of the following:

• Double click the slot.

• Right click the slot and select Set Card Type. 

2. A drop-down menu is displayed, listing the available card types.  
Select Empty. 

3. A warning dialog is displayed. To confirm the deletion, click Yes

CONFIGURING AN E-QUE CARD FOR ANTENNA
To configure an E-Que card for Antenna select the card on the 
hardware list to display the configuration screen. 

Each of the eight ports on the card is given a port number reflecting the 
total number of beltpacks that can be supported using the E-QUE card.

Antenna Connections

Figure 5-25: E-Que Antenna Configuration

Select the card port to be configured and open Basic Options under 
Port Properties > Beltpack Antenna to set up the port parameters.

Cable Length
To set the cable length between the card and the antenna select the 
‘Cable Length’ option and open the drop-down slider.  Adjust the cable 
length setting from 0 - 129 meters to 2860 - 2989 meters.

The length set will be displayed next to the option.
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Description
Enter an optional description for the antenna such as position or 
function.

Engineer Comments
A scratchpad for engineers to record any relevant information about 
the port or antenna.

Listen Label
Listen labels for antennas are only used for diagnostics purposes, 
such as antenna/role correlation (a combined Talk/Listen label is 
shown unless the option for 10 character labels is turned off).

Talk Label
Talk labels for antennas are only used for diagnostics purposes such 
as antenna/role correlation (a combined Talk/Listen label is shown 
unless the option for 10 character labels is turned off).

SPLITTER CONNECTIONS

Figure 5-26: E-QUE Splitter Configuration

Select the card port to be configured and go to Port Properties >  
Beltpack Antenna > Basic Options to set up the port parameters.

Cable Length
To set the cable length between the card and the antenna select the 
‘Cable Length’ option and open the drop-down slider.  User the mouse 
to adjust the cable length setting from 0 - 129 meters to 2860 - 2989 
meters. 

The length set will be displayed next to the option.

Description
Enter an optional description for the antenna such as position or 
function.
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Engineer Comments
A scratchpad for engineers to record any relevant information about 
the port or antenna.

Label
Label for the port used to assign the port to a path. The label has 10 
characters, or can be split into two parts, each of maximum five 
characters.

To configure an E-Que card for Splitters select the card on the 
hardware list to display the configuration screen. 

In this case ten antennas will be displayed corresponding to the two 
splitters that can be connected to an E-Que card with each splitter 
supporting up to five antennas.

ANTENNA ROLE MAP
Diagnostics > Antenna Role Map displays the status of the antennae 
and roles currently configured.  

Figure 5-27: Antenna and Role Display

The  mapping of roles onto antennae is indicated by the colored 
squares.  When a role is registered to an antenna, a black dot is placed 
in the antenna row at the role position.
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E-QUE TRUNK BASIC SETTINGS

Port Count
The port count specifies the number of virtual ports that will be 
configured for the cable.  The port count may be set to any number 
between 0 and the maximum number of virtual ports on the cable (30 
for E1, 24 for T1).  As a general guide the port count should be set to 
the maximum number of simultaneous conversations.  The 
recommended setting is 30 for E1 and 24 for T1.

Note: The port count should not be set to an excessive number 
(significantly more that the number of panels available for 
connection using the E-QUE card) as this may reduce 
system performance.

Remote Port Count
The number of ports available for remote systems to use to 
communicate with the matrix.

Remote Frame
The remote matrix frame that the E1 or T1 trunk is connected to.  
Selecting this option will display a list of remote systems that the trunk 
may be connected to in order to select the target system.  For a system 
to be listed it must have been set up in ‘My Systems’ as linked to the 
current matrix so that the hardware can be allocated.

CONFIGURING THE IVC-32 CARD
The IVC-32 card enables you to connect Eclipse HX matrices to 
Concert and IP enabled V-Series panels over a normal LAN or WAN, 
using IP.

ADDING AN IVC-32 CARD
To add an IVC-32 card:

1. In Hardware > Cards and Ports, navigate to an available slot 
number (marked Empty). Do either of the following:

• Double click the slot.

• Right click the slot and select Set Card Type.

2. A drop-down menu is displayed, listing the available card types. 
Select the IVC-32 card.
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Figure 5-28: IVC-32 Card Selection

Tip: A total of four E-QUE, IVC-32 or LMC-64 interface cards may be 
fitted to an Eclipse HX-Omega. A total of three E-MADI64 cards may 
be fitted to the matrix.

This action adds an IVC-32 card to be used for communication over IP.  
Cards and Ports will show thirty two ports that can be configured for 
various IP compatible panels.

Figure 5-29: IP Ports

Port Number

The port number on the IVC-32 card.

Port Function

Selects the device attached to the port from a drop-down menu.  
Devices include IP enabled V-Series panels and Concert panels.
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Label

Label for the E1 direct port used to assign the port to a path. The label 
has 10 characters, or can be split into two parts, each of maximum five 
characters.

Description

An optional description for the port of up to 255 characters long.

Note:
The IVC-32 card must be configured before it can be used.  To set the 
IP parameters click on the ‘Card Properties’ link on the lower right of 
the Matrix Hardware display.  This will display the settable parameters.

Figure 5-30: IVC-32 IP Parameters

General

Default ports used by the Eclipse HX system are 6001 for IP Panel 
communications, 42001 for EHX communications and 1300 for the 
matrix event log.  Ports 42001 and 1300 are used by the UDP protocol. 

Eclipse HX system administrators are advised to check with network 
administrators or IT that these default ports may be used without 
causing a conflict with any other application on the network. 

Each IVC-32 card requires a static IP address.  It is recommended that 
these addresses are issued by IT or the Network Administrator to 
avoid conflicts with any other system on the network and are not part of 
the DHCP dynamically assigned range.

IP Port

Sets the port number to be used by the IVC-32 card when 
communicating over IP.  This parameter should not normally be 
changed from the default value unless all the IP panels or Concert 
server are also updated to use the new port number.  If this is not done 
the IP panels or Concert server will not be able to communicate with 
the IVC-32 card. 
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Eclipse HX system administrators are advised to check with network 
administrators or IT that the default port may be used without causing 
a conflict with any other application on the network.

If the IP port number is changed ports 42001 and 1300 should not be 
used as these ports are already used by EHX.  The Eclipse HX system 
administrator should check with the network administrator or IT to 
obtain a port number to use.

IP Address Assignment

Manually enter the IP address, subnet mask and default gateway for 
the IVC-32 card.

IP Address

Static IP address of the IVC-32 card, assigned by IT or the Network 
Administrator. This will be used by IP panels and Concert clients to 
communicate with the matrix via the IVC-32 card. 

Important note:
It is important to ensure that the IVC-32 card IP address does not clash 
with any other IP address on the network (another device is using the 
same IP address).  If there is an IP address clash  the IVC-32 card 
may repeatedly lose the connection with IP panels or Concert clients.  
If the IVC-32 card IP address clashes it may also cause the IVC-32 
card to crash.

It is recommended that the IVC-32 is given a static IP address. The 
V-Series panels and Concert clients IP addresses should be assigned 
by a DHCP server. 

Subnet Mask

Subnet mask used by the IVC-32 card to define the address range the 
card can access.  Typically this will be assigned by IT or the Network 
Administrator. The default is 255.255.0.0.

Default Gateway

The address of the gateway (router) to be used to communicate with 
external devices such as IP panels and Concert clients over a wider IP 
network.  This address is optional but if used must fall within the 
address range defined by the subnet mask.

External IP Address

If the Matrix is operating behind a firewall then port address forwarding 
can be used to expose a LAN-connected device to the outside world.  
Typically this will be assigned by IT or the Network Administrator.

This IP address must be manually entered on IP panels to 
communicate directly with the IVC-32 card.  This address must be a 
unique address on the internet.  It is not affected by the subnet mask.
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External IP Address IP Port

IP port used when communicating directly with the IVC-32 card using 
the External IP address.  The default port number is 6001 and this 
should not be changed unless the default port number on all external 
devices is also changed to the new port number.

Panel Codecs

The ‘Show ports’ links will display which ports on the IVC-32 cards are 
configured to use the G722 codec.

The codec options are configured in the IP Panel Settings under 
Advanced Settings for each port. 

CONFIGURING THE LMC-64 CARD
The LMC-64 card is designed to allow Eclipse HX matrices to be 
provide audio level metering data to Production Maestro clients over 
an IP network.

ADDING AN LMC-64 CARD
To add an LMC-64 card:

1. In Hardware > Cards and Ports, navigate to an available slot 
number (marked Empty). Do either of the following:

• Double click the slot.

• Right click the slot and select Set Card Type.
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2. A drop-down menu is displayed, listing the available card types. 
Select the LMC-64 card.

Figure 5-31: LMC-64 Card Selection

Tip: A total of four E-QUE, IVC-32 or LMC-64 interface cards may be 
fitted to an Eclipse HX-Omega. A total of three E-MADI64 cards may 
be fitted to the matrix.

This action adds an LMC-64 card to be used for communication over 
IP.  Cards and Ports will show a single port entry that can be 
configured for 16-64 meters.

Figure 5-32: IP Ports

Port Number

The port number on the LMC-64 card.  This does not have a function 
as the card does not provide external ports.

Port Function

This is always fixed as ‘Meter’.
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Label

Label for the E1 direct port used to assign the port to a path. The label 
has 10 characters, or can be split into two parts, each of maximum five 
characters.

Description

An optional description for the port of up to 255 characters long.

The LMC-64 card must be configured before it can be used.  To set the 
IP parameters click on the ‘Card Properties’ link on the lower right of 
the Matrix Hardware display.  This will display the settable parameters.

Figure 5-33: LMC-64 IP Parameters

General

Default ports used by the Eclipse HX system are 6001 for IP Panel 
communications, 42001 for EHX communications and 1300 for the 
matrix event log.  Ports 42001 and 1300 are used by the UDP/ 
protocol.  Eclipse HX system administrators are advised to check with 
network administrators or IT that these default ports may be used 
without causing a conflict with any other application on the network. 

Each LMC-64 card requires a static IP address.  It is recommended 
that these addresses are issued by IT or the Network Administrator to 
avoid conflicts with any other system on the network and are not part of 
the DHCP dynamically assigned range.

IP Port

Sets the port number to be used by the LMC-64 card when 
communicating over IP.  This parameter should not normally be 
changed from the default value.  Eclipse HX system administrators are 
advised to check with network administrators or IT that the default port 
may be used without causing a conflict with any other application on 
the network.
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If the IP port number is changed ports 42001 and 1300 should not be 
used as these ports are already used by EHX.  The Eclipse HX system 
administrator should check with the network administrator or IT to 
obtain a port number to use.

IP Address Assignment

Manually enter the IP address, subnet mask and default gateway for 
the LMC-64 card.

IP Address

Static IP address of the LMC-64 card, assigned by IT or the Network 
Administrator. This will be used by Production Maestro clients to 
communicate with the LMC-64 card. 

Important

It is important to ensure that the LMC-64 card IP address does not 
clash with any other IP address on the network (another device is 
using the same IP address).  If there is an IP address clash  the 
Production Maestro clients may lose audio meter data.  If the LMC-64 
card IP address clashes it may also cause the LMC-64 card to crash.

Subnet Mask

Subnet mask used by the LMC-64 card to define the address range the 
card can access.  Typically this will be assigned by IT or the Network 
Administrator. The default is 255.255.0.0.

Default Gateway

The address of the gateway (router) to be used to communicate with 
Production Maestro clients over a wider IP network.  This address is 
optional but if used must fall within the address range defined by the 
subnet mask.

External IP Address

If the matrix is operating behind a firewall then port address forwarding 
can be used to expose a LAN-connected device to the outside world.  
Typically this will be assigned by IT or the Network Administrator.

This IP address must be used by external Production Maestro clients 
to communicate with the LMC-64 card.  This address must be a unique 
address on the internet.  It is not affected by the subnet mask.

External IP Address IP Port

IP port used when communicating directly with the LMC-64 card using 
the External IP address.  The default port number is 6001 and this 
should not be changed unless the default port number on all external 
devices is also changed to the new port number.
5
 Clear-Com®
EHX User Guide

- 6 8



CONFIGURING THE E-MADI64 CARD
The E-MADI64 is a MADI (Multichannel Audio Digital Interface) card, 
providing up to 64 duplex channels of AES3 digital audio over a coaxial 
cable or fiber pair between compatible devices.

ADDING AN E-MADI64 CARD 
(AUTOMATIC DISCOVERY)
The E-MADI64 card will be automatically discovered when:

• The Discovery Hardware option is selected, after the Matrix Frame 
is placed on the System Layout from the discovery pane.

• The Create New Configuration > Discover Hardware right click 
option is selected in the relevant Matrix Frame on the System 
Layout screen.

ADDING AN E-MADI64 CARD (MANUAL ADDITION)
To add an E-MADI64 card:

1. In Hardware > Cards and Ports, navigate to an available slot 
number (marked Empty). Do either of the following:

• Double click the slot.

• Right click the slot and select Set Card Type.

2. A drop-down menu is displayed, listing the available card types. 
Select the E-MADI64 card.

The configurable ports (16, 32, 56, or 64) for the E-MADI64 card are 
displayed.

Tip: A total of four E-QUE, IVC-32 or LMC-64 interface cards may be 
fitted to an Eclipse HX-Omega. A total of three E-MADI64 cards may 
be fitted to the matrix.

CARD AND PORT SETTINGS
E-MADI64 Port Number

The port number on the E-MADI64 card. Standard EHX settings 
(including VOX and In-use tally) are applicable to all E-MADI64 
channels. 

E-MADI64 Port Function

Assign a function to the port from a drop-down menu.  Limited to Direct 
mode only.
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E-MADI64 Label

The Talk label assigned to the port used to identify the port when 
configuring talk paths.

E-MADI64 Description

An optional description for the port of up to 255 characters long.

E-MADI64 Channel Labeling

The 4-character channel ID for each MADI input channel is taken from 
the provided embedded data bits. The channel ID for each MADI 
output channel can be enabled in EHX.

You can do any of the following:

• Use the 4-character, 3rd party ID, provided from the input channel.

• Use the Production Maestro Pro Alias.

• Disable the ID and use the EHX port name for display on EHX 
Panels.

This means that supported user panels can automatically show:

• The MADI channel ID.

• The Alias as supplied from Production Maestro Pro.

• The Talk / Listen label as defined in EHX.

E-MADI64 Card Properties

Card Properties permits sample rate selection when synching to video 
signals. The E-MADI64 card must be configured before it can be used 
when not using the Word Clock Source Sync.

Card Properties always defaults to the E-MADI64 standard for the 
number of channels. 

To set the sample rate parameters, click Card Properties on the lower 
right of the Matrix Hardware display.

The following dialog is displayed:

Figure 5-34: MADI Channel Sample Rate
5
 Clear-Com®
EHX User Guide

- 7 0



UPGRADING THE E-MADI64 CARD FIRMWARE
You can upgrade the following E-MADI64 code with EHX:

•  H8 application code (*.fwc format file).

•  DSP code (*.fwc format file).

•  FPGA code.

The boot code file (*.mot) is upgraded using the Renesas Flash 
Development Toolkit 3.4 Basic (FDT), not EHX. The FPGA code can 
also be upgraded using Xilinx iMPACT programming software.

Tip: For detailed upgrade procedures and information, including 
upgrades that you cannot perform in EHX, see the Eclipse HX 
Upgrade Guide.

To upgrade E-MADI64 H8, DSP or FPGA code (for all the E-MADI64 
cards) using EHX:

1. Ensure that you have the following equipment:

E-MADI channel mode Sample rate Configurable ports

32 96K 32

56 44.1K or 48K 56

64 44.1K or 48K 64, 32 or 16

TABLE 5-3: E-MADI CHANNEL MODES

Equipment Description / Notes

PC with an Ethernet or 
serial port

-

EHX software EHX must be installed and configured

Ethernet or serial 
connection

For the matrix to PC connection

TABLE 5-4: UPGRADING E-MADI64 CODE
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2. Start EHX on the PC.
3. Connect the matrix to the PC using either an Ethernet or serial port.
4. In EHX, open the configuration. Select System > Layout.
5. Right click the matrix and then select Firmware> Update Firmware.
6. The Update Firmware wizard dialog is displayed. Click Next.

In the Select Hardware Type screen, ensure that the Card radio 
button is selected:

Figure 5-35: Select Hardware Type dialog

7. Click Next and then browse to the E-MADI64 code file (application, 
DSP or FPGA code files (*.fwc)).

The folder contains the *.fwc file and a Read Me file (*.txt) with 
version information. Select the*.fwc file and click OK / Open. 

Tip: See Step 1 for the location of the *.fwc files on the Eclipse HX 
v7.1 DVDs.

H8 application, DSP and 
FPGA code files

The appropriate application code, DSP 
code and FPGA code files (*.fwc format) 
are available from the Eclipse HX v7.1 
DVDs:

Software DVD > Eclipse 
HX-Omega-Median-Delta > E-MADI 
Application

Software DVD > Eclipse 
HX-Omega-Median-Delta > E-MADI 
DSP

Hardware DVD > Eclipse 
HX-Omega-Median-Delta > E-MADI 
FPGA.

Equipment Description / Notes

TABLE 5-4: UPGRADING E-MADI64 CODE
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8. Click Next and confirm that the details displayed are correct.

9. Click Next and confirm that the download commences.

10. When the download has completed, click Finish to close the 
update firmware wizard.

11. Ensure that the E-MADI64 cards reset once the download is 
complete.

When the download has completed, click Finish to close the update 
firmware wizard.
Note:
You can use the Firmware report tool in EHX to confirm the firmware 
version of H8 application and FPGA code. The Firmware report tool 
does not provide firmware version information for DSP code. 

To use the Firmware report tool:

a. Open EHX and go to System > Layout .

b. Right click the matrix icon.

c. Select Firmware > Firmware report.

Code Approximate reset time 

H8 application 1 minute

DSP 3 minutes

FPGA 18 minutes

TABLE 5-5: E-MADI64 CARD RESET TIMES
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FIXED GROUPS
A fixed group is a list of port labels that are represented by a single, 
fixed group label.  The fixed group label can be assigned to selector 
keys on one or more panels, which when activated, simultaneously 
accesses all members of that fixed group.

Note:
Because partylines and Fixed Groups are now viewed as a global item 
across all systems (they work inter-system), partyline and Fixed Group 
alias names are no longer displayed in remote systems. All partylines 
and Fixed Groups should be given a unique name.

Figure 5-1: Eclipse HX Setup Menu

FIXED GROUPS SETUP AND CONFIGURATION
To create a Fixed Group and assign members to that group the 
following steps should be followed:

1. Open Configuration > Fixed Groups.
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Figure 5-2: Fixed Groups List

2. Select the ‘New’ button at the bottom left of the Groups window (top 
left window of the screen).

3. Replace the auto-filled Group Talk label with a meaningful label.
4. Replace the auto-filled Group Listen label with meaningful label.
5. Replace the auto-filled Group description with a more meaningful 

description.
6. In order to add members select the select the required members 

from the ‘Available’ window (bottom left of the screen) and click on 
the ‘>’ in the section between the lower windows to transfer the 
members to the  ‘Attached’ window in the bottom right of the screen.  
Alternatively double-clicking on the required item will transfer it to 
the Attached window.  Also right clicking on a member of the 
Available group will display a menu allowing it to be attached.

7. To remove members from the group select the members to be 
removed in the ‘Attached’ window and click on the ‘<‘ symbol in the 
central section to return them to the ‘Available’ window.  
Alternatively double-clicking on the required member will move it 
back to the Available group.  Also right clicking on a member of the 
Attached group will display a menu allowing it to be detached.

Fixed Groups can be made up of local and remote members (see 
Chapter 10).
5
 Clear-Com®
EHX User Guide

- 7 6



FIXED GROUP ATTACHED CONTROLS
Attachments can be attached to Fixed Groups that will allow a Route, 
Relay or Speed Dial to be activated via a secondary action.
1. Open Configuration > Fixed Groups.
2. Create a Fixed Group or select a Fixed Group that was been 

previously created.
3. Expand the ‘Attached Control’ item in the ‘Properties’ window.
4. Select the ‘Secondary Action’ item in the ‘Attached Control’ list.
5. Select the drop down arrow and select the required control.

Figure 5-3: Fixed Group Attach Control Screen

FIXED GROUP BASIC OPTIONS
Basic Options displays the fixed information about a group and can be 
used to edit the group description, Talk and Listen Aliases and Talk and 
Listen labels.

To enable/disable Basic Options

1. Open the Fixed Groups screen by selecting the ‘Fixed Groups’ link 
on the Configuration menu.

2. Create a Fixed Group or select a Fixed Group that was been 
previously created.

3. Expand the Basic Options item in the ‘Properties’ window.
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To edit an item in the Basic Options list select the item in the left hand 
column and edit the text in the right hand column.

FIXED GROUP GLOBAL SETTINGS
To enable/disable Global Settings

1. Open the Fixed Groups screen by selecting the ‘Fixed Groups’ link 
on the Configuration menu.

2. Create a Fixed Group or select a Fixed Group that was been 
previously created.

3. Expand the ‘Global Settings’ item in the ‘Properties’ window.
4. Select the ‘Auto Signal’, ‘Latch Disable’ or ‘Page Override’ item in 

the ‘Global Settings’ list.
5. Select the drop down arrow and select the required status.

FIXED GROUP SOFT MODE OPTIONS
The ‘Soft Mode Options’ list display items which relate to the Soft 
Mode available on certain panel types.  Currently this is restricted to 
Sort Groups.

To enable/disable Soft Mode Options

1. Open the Fixed Groups screen by selecting the ‘Fixed Groups’ link 
on the Configuration menu.

2. Create a Fixed Group or select a Fixed Group that was been 
previously created.

3. Expand the ‘Soft Mode Options’ item in the ‘Properties’ window.
4. Select the required options:

• Default Assign as Talk and Forced Listen.  When true the default 
for a key assigned to this label is Talk and Forced Listen.

• Enable Assignment as Listen.  This must be enabled to allow a 
V-Series panel operator to assign a listen key to this label.  If it is 
not enabled a V-Series panel operator cannot assign a listen key 
to the label.

• Enable Assignment as Talk.  This must be enabled to allow a 
V-Series panel operator to assign a talk key to this label.  If it is 
not enabled a V-Series panel operator cannot assign a talk key to 
the label.

• Protect Port from Assignment.  When this option is enabled the 
port cannot be locally assigned as a talk/listen key by another 
panel.

5. Select the drop down arrow and set the required status (True or 
False).  The status box will be checked or unchecked to indicate 
True or False.
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FIXED GROUP TALLIES
To enable/disable Tallies

1. Open the Fixed Groups screen by selecting the ‘Fixed Groups’ link 
on the Configuration menu.

2. Create a Fixed Group or select a Fixed Group that was been 
previously created.

3. Expand Tally Options in the ‘Properties’ window.
4. Select the ‘In Use Tally’ item in the Tally Options list.
5. Select the drop down arrow and select the required status.

This allows the system to set a tally (flashing LED) on all the panel 
keys that are assigned to the Fixed Group whenever a talk is active on 
the Fixed Group.  In the case of multiple matrices in a linked set the ‘In 
Use’ tally is broadcast to all other systems in the linked set.   In this 
way the feature is seamless over the matrices in a linked set.

The default is disabled.

Sort Function on Fixed Groups members 
EHX provides a sort capability that allows the EHX user a quick and 
easy way of grouping common items such as FOR-22s together.  The 
sort function has been implemented in both the  ‘Attached’ window and 
‘Available’ window.
 

Figure 5-4: Group Members List

To operate the sort function, select the Fixed Groups link from the 
Eclipse HX Menu and select the required Fixed Group.  Use the ’All’ 
tab on the Attached window to display all the members of the groups, 
or the ‘Interfaces’ tab to display only the interfaces in the group or the 
‘Panels’ tab to list the panels in the group.

The ‘#’ tab will sort the group members by ascending or descending 
port number.
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Global group numbers
Fixed groups are globally numbered, giving them a unique, global 
identity throughout the Eclipse HX system. 

If a Fixed Group is assigned the number 001, then there can be only 
one Fixed Group with the number 001, however many matrix frames 
are intelligently linked.

Fixed Groups are numbered based on local creation order.
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SORT GROUPS
Sort Groups are groups of other items such as controls, fixed groups, 
interfaces, panels and partylines that can be treated as a single item 
and accessed in local menu mode to assign a member of the sort 
group to a key.  Selecting Sort Groups in the EHX Setup menu displays 
the sort group editor.

Figure 5-5: Sort Group Editor

To create a new sort group click on the ‘New’ button and the new sort 
group will be added to the main window (top left window).  To add 
members to the sort group select the required item in the lower left 
window (the ‘Available’ window) and click on the ‘>’ symbol in the 
center partition to transfer them to the lower right window (the 
‘Attached’ window).  To remove items from the sort group select the 
item in the ‘Attached’ window and click on the ‘<‘ symbol in the center 
partition to move the item back to the ‘Available’ window.

The ‘#’ button on the Available and Attached panes sorts the members 
by port number in ascending or descending order, preceded by 
non-port items such as controls.

The ‘Label’ button sorts the members by name alphabetically and the 
‘Description’ button sorts the members alphabetically by description.

The tabs above the Available and Attached panes filter the members 
by type.

To set the properties of the sort group open the ‘Basic Settings’ menu 
in the Properties window (top right).
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BASIC OPTIONS

Description
Enter an optional description for the sort group such as function.

Engineer Comments
A scratchpad for engineers to record any relevant information about 
the sort group.

Listen Label
The listen label that is available for panel configuration.

Talk Label
The talk label specified for use in the panel configuration table.
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KEY GROUPS
Key Groups provide a way of assigning a label to keys on multiple 
panels in a system or within a linked set.  Once the key group 
members have been set up using EHX, the target of the key group can 
be changed with a single assignment in Production Maestro Pro.

Up to 100 key groups can be set up on a system; each key group can 
only be assigned to a single target such as a partyline (Conference in 
Production Maestro) or four-wire port (Four-wire Viewer in Production 
Maestro Pro) or a panel port.

To set up Key Groups select ‘Key Groups’ in the EHX Setup menu to 
open the key groups editor.

Figure 5-6: Key Groups Editor

Click on the ‘New’ button to create a new key group and select the 
group to configure it using the ‘Properties’  pane.  Open the ‘Basic 
Settings’ menu to set up the key group properties.

BASIC OPTIONS

Activation
The activation setting determines how the assigned keys the key group 
will behave when the key group is activated.  To set the activation 
select ‘Activation’ on the ‘Basic Settings’ and open the drop-down 
menu.
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The activation options are: Talk and Listen, Talk, Listen, Talk and 
Forced Listen or Dual Talk and Listen.

• Talk and Listen sets all the key group keys to talk with listen 
when the key group is active.

• Talk sets all the key group keys to talk when the key group is 
active.

• Listen sets all the key group keys to listen when the key group 
is active.

• Talk and Forced Listen sets all the key group keys to talk key 
with permanently made listen when the key group is active.

• Dual Talk and Listen sets all the key group keys to Dual talk 
and listen when the key group is active.

Description
Contains the description for the selected key group.

Engineer Comments
A scratchpad for engineers to record any comments about the key 
group or the key group target.

Listen Label
The listen label for the key group that will be displayed on the keys 
assigned to the key group.

Talk Label
The talk label for the key group that will be displayed on the keys 
assigned to the key group.

KEY GROUP MEMBERS
The key group editor will display a list of all the members of the 
currently selected key group in the lower ‘Attached’ pane.

The key members cannot be changed in this pane but by right-clicking 
on an item a ‘Go to’ option is displayed. Click Go to to open the Panel 
Programming tab and display the panel.
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Figure 5-7: Key Group Member on Panel

Panel keys are assigned to a key group from the Panel Programming 
tab.  Select the required panel and key then right-click to display the 
properties menu.  

Figure 5-8: Adding a Key to a Key Group

Select ‘Key Groups’ to display a list of all the available key groups and 
select the destination key group.  Left click on the required key group 
to add the key to the key group.  The assignment will be indicated by 
the addition of a white box round the key and a checkbox against the 
key group.

Figure 5-9: Key Added to a Key Group

To remove a key from a key group select the key in panel programming 
and right-click on it to open the options menu.  Select the ‘Key Groups’ 
option to display a list of key groups and click on the checkbox for the 
key group the key is to be removed from.

Keys may already be assigned to destinations before being added to a 
key group.  In this case the key functions remain active until the key 
group is assigned to a conference or four-wire port by Production 
Maestro Pro, at which point the key functions are overridden by the key 
group destination.  If the key group is deassigned by Production 
Maestro Pro the keys will revert to their previous states.

A red reset will not delete the destination assignment of a key group, 
while a black reset will delete the destination assignment of a key 
group.
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A key group can only be introduced to the Eclipse HX working 
configuration using a configuration download (keygroups cannot 
currently be applied to a system in online mode). 

The EHX software will only include a configured key group in the map 
download for a particuler system if the keygroup is in use on that 
system. This means that in a linked set configuration, any system that 
utilises a newly created keygroup must be downloaded to.
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PARTYLINES
An EHX partyline is a virtual partyline.  When assigned to selector keys 
on various panels in the system, that label enables anyone in the 
system who activates a talk or listen (or both) to that partyline label to 
talk/listen to anyone else who has joined the partyline the at the same 
time. EHX permits the assignment of panels to a partyline; however 
this is normally completed in the Panel Programming screen by 
assigning the partyline label onto the panel.

Note:
Because partylines and Fixed Groups are now viewed as a global item 
across all systems (they work inter-system), Partyline and Fixed Group 
alias names are no longer displayed in remote systems. All Partylines 
and Fixed Groups should be given a unique name.

Figure 5-10: Setup Menu

To create a partyline and assign permanent members to that party the 
following steps should be followed:
1. From the Configuration menu select the ‘Partylines’ link.  This opens 

the Partylines configuration screen.
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Figure 5-11: Partyline Setup Screen

2. Select the ‘New’ button at the bottom left of the Partylines window.
3. Change the partyline label and description fields with more 

meaningful identifiers.
4. In order to add permanent fixed members select the required 

member in the ‘Available’ pane.
5. Click on the ‘>’ button to transfer the member to the ‘Attached’ pane.
6. Right-click on a member in the ‘Attached’ pane to open a 

configuration menu and select whether the attached member is Talk, 
Listen or Talk and Listen.

The partyline label is able to be programmed onto a panel key.

The ‘#’ button on the Available and Attached panes sorts the members 
by port number in ascending or descending order, preceded by 
non-port items such as controls.

The ‘Label’ button sorts the members by name alphabetically and the 
‘Description’ button sorts the members alphabetically by description.

The tabs above the Available and Attached panes filter the members 
by type.

Once a partyline is created, a system must be downloaded to in order 
to utilse that partyline i.e. it is not sufficient to only download to the 
frame that hosts the partyline (for example, use Production Maestro 
Pro to assign members from the entire linked set to the partyline.

The recommended use of this feature is that all partylines are 
configured and then a download to all frames is carried out. The 
Production Maestro Pro software can then be used to manipulate 
these partylines in an online fashion.  
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PARTYLINE ATTACHED CONTROLS
Controls can be attached to partylines that will allow a Route, Relay or 
Speed Dial to be activated via a secondary action.
1. Open the partyline screen by selecting the ‘Partylines’ link on the 

Configuration menu.
2. Create a partyline or select a partyline that was been previously 

created.
3. Expand the ‘Attached Control’ item in the ‘Properties’ window.
4. Select the ‘Secondary Action’ item in the ‘Attached Control’ list.
5. Select the drop down arrow and select the required control.

Figure 5-12: partyline Attach Control Screen

PARTYLINE BASIC OPTIONS
Basic Options displays the fixed information about a partyline and can 
be used to edit the partyline description, Talk and Listen Aliases and 
Talk and Listen labels and Shared Partyline.  

To enable/disable Basic Options

1. Open the Partyline screen by selecting the ‘Partylines’ link on the 
Configuration menu.

2. Create a partyline or select a partyline that was been previously 
created.

3. Expand Basic Options in the ‘Properties’ window.

The Basic Options are:

• Description - description of the partyline to indicate function etc.
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• Engineer Comments - engineering information about the 
partyline.

• Listen Label - the Listen label for the partyline.

• Shared Partyline - if set to True (the default) the partyline is 
available to all the matrices in a linked set.  If set to False it is only 
available locally (on the matrix it is physically connected to).

• Talk Label - the Talk label for the partyline.

PARTYLINE GLOBAL OPTIONS
To enable/disable Global Options

1. Open the partyline screen by selecting the ‘Partylines’ link on the 
Configuration menu.

2. Create a partyline or select a partyline that was been previously 
created.

3. Expand the ‘Global Options’ item in the ‘Properties’ window.
4. Select the ‘Auto Listen’, ‘Auto Signal’ or ‘Latch Disable’ item in the 

‘Global Settings’ list.
5. Select the drop down arrow and select the required status.

PARTYLINE SOFT MODE OPTIONS
To enable/disable Soft Mode Options

1. Open the partyline screen by selecting the ‘partylines’ link on the 
Configuration menu.

2. Create a partyline or select a partyline that was been previously 
created.

3. Expand the ‘Soft Mode Options’ item in the ‘Properties’ window.
4. Select the required options:

• Default Assign as Talk and Forced Listen.  When true the default 
for a key assigned to this label is Talk and Forced Listen.

• Enable Assignment as Listen.  This must be enabled to allow a 
V-Series panel operator to assign a listen key to this label.  If it is 
not enabled a V-Series panel operator cannot assign a listen key 
to the label.

• Enable Assignment as Talk.  This must be enabled to allow a 
V-Series panel operator to assign a talk key to this label.  If it is 
not enabled a V-Series panel operator cannot assign a talk key to 
the label.

• Protect Port from Assignment.  When this option is enabled the 
port cannot be locally assigned as a talk/listen key by another 
panel.

5. Select the drop down arrow and select the required status.
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PARTYLINE TALLIES
To enable/disable Tallies

1. Open the Partylines screen by selecting the ‘Partylines’ link on the 
Configuration menu.

2. Create a partyline or select a partyline that was been previously 
created.

3. Expand Tally Options in the ‘Properties’ window.
4. Select the ‘In Use Tally’ item in Tally Options.
5. Select the drop down arrow and select the required status.

This allows the system to set a tally (flashing LED) on all the panel 
keys that are assigned to the partyline whenever a talk is active on the 
partyline.

In the case of multiple matrices in a linked set the ‘In Use’ tally is 
broadcast to all other systems in the linked set. In this way the feature 
is seamless over the matrices in a linked set.

The default is disabled.

Partyline Global Numbers
Partylines are globally numbered, giving them a unique, global identity 
throughout the Eclipse HX system. 

If a partyline is assigned the number 001, then there can be only one 
partyline with the number 001 in the system, however many matrix 
frames are intelligently linked.

Partylines are numbered based on local creation order.
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ROUTES
A route is an audio path between two points in the matrix that can be 
activated by another intercom panel’s selector key. The Routes link 
provides the following functions:

• Define the source port and destination label for each route.

• Determine whether each route will be activated with a talk key, a 
listen key, or both.

• Enable a reverse listen (a reversal of the route’s direction when it is 
activated by a Talk).

A route is defined by selecting a source port, a destination label, and 
providing a description. The source can be any port in the local 
system.  A source cannot be a nonport label, including a partyline or 
fixed group.  The destination can be any audio label in the system 
including a partyline or a Group or remote ports, except a control label.  
When a route is activated, it will set a talk from the source port to the 
destination label.

It is possible to activate the route by activating a talk and/or a listen to 
the route’s label.

If the Action is set to Talk the route will act as a unidirectional audio 
path whenever a talk or listen to the route is activated.  If the route 
action is set to Reverse Listen the route will act as a bi-directional 
audio path provided ‘Activate with Listen’ is also set.

Figure 5-13: Routes Configuration Screen
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After the route has been set up using this screen, it is possible to 
assign it to a label from the Control Manager screen.  Within the Panel 
Programming screen and the Stacked Keys area, with the Control 
Label programmed onto a panel then double clicking this Label, the 
attachments to the Label are displayed.

The following is an explanation of each column:

DESCRIPTION
Enter the description of the route into this field.  This field is an 
information field only and is not used by the Eclipse HX System.

SOURCE
The route Source is the label of the calling Panel/Interface.

ACTION
The Action field specifies how the route will behave when it is 
activated.  When the mouse pointer is placed in the action field an 
arrow is displayed.  Right click the arrow to display the drop-down 
menu of possible route actions.

Figure 5-14: Route Action Menu

Talk
When this route action is selected the route will act as a talk only route 
from the source to the destination.  Signalization will appear on the 
destination.

Talk & Reverse Listen
When this route action is set audio will be routed from the source to the 
destination and signalization will appear on the destination.  Audio will 
also be routed from the destination to the source.

Reverse Listen
When this route action is set the route will allow the source to listen to 
audio from the destination.  No signalization will appear on the source.

Inhibit Talk
When the route is activated all audio from the source to the destination 
will be blocked.
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DESTINATION
The Route Destination is the label of the Panel Interface receiving the 
call.

ACTIVATE WITH TALK
When this box is checked, the route will activate whenever anyone 
sets a talk key to the route’s label.

ACTIVATE WITH LISTEN
When this box is checked, the route will activate whenever anyone 
sets a listen key to the route’s control label.

Note: Activating the route by a listen has exactly the same effect 
as activating it by a talk, unless the Reverse Listen box has 
been checked making a bi-directional  audio path between 
the source and destination.
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CREATING A ROUTE
Select the ‘Routes’ link from the Configuration menu. The Routes 
screen opens. The top area of the screen is used to configure Routes 
and the bottom area contains all Labels that are available to select and 
utilize.  Select New, complete the description field then select either 
Activate with Listen or Activate with Talk. 

 It is also possible to have both Activate with Listen and Activate with 
Talk selected. 

Assign a source and a destination to the Route.

ASSIGNING A SOURCE AND DESTINATION TO A 
ROUTE
To assign a source and destination to a route:

1. Open Routes. 

Figure 5-15: Assigning sources and destinations to a route

2. Do either of the following:

• Create a new route.

• Select an existing route and click Description to edit.

3. Click the Route Source field. A drop-down menu of available 
sources is displayed. Select a source.
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4.  Click the Route Destination field. A drop-down menu of available 
destinations is displayed. Select a destination.

Note:
Alternatively, you can assign sources and destinations from the 
labels palette at the base of the screen.

5. Click the Route Action field. A drop-down menu of available actions 
is displayed (see above). Select an action.

DELETE A ROUTE
To delete a route:

1. Open Routes. Locate the route you want to delete. 

2. Click the gray button next to Description to highlight the row. 

3. Press Delete.
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SPEED DIALS

SPEED DIAL (DTMF SEQUENCES)
The MVX-A16 matrix card can generate DTMF Tones using the DTMF 
Daughter board fitted into the slots on the MVX-A16 card.  DTMF 
Tones are the “beeps” made by a Touch Tone Telephone.

The Speed Dial screen defines the name, activation type DTMF 
Sequence and the source of the sequence which is currently a 
Telephone interface. There is a 23 digit limit on a DTMF Sequence.

The currently allowable dial sequences are as follows:  The numbers 
through 0 – 9 the pound (#) and asterisk (*) characters.  A DTMF 
Sequence is defined as a sequence of these numbers.

A Speed Dial must be attached to a control label with the Speed Dials 
label attached to this control, then the control label is programmed 
onto the panel next to the label of the telephone.  To Activate the 
Speed Dial activate the label to the telephone interface, then activate 
the Speed Dial label by latching the selector of the label.

SPEED DIAL SETUP
In order to setup a speed dial the following steps should be followed:

Select ‘Speed Dials’ from the Configuration menu.  The above screen 
shot displays the Speed Dial screen.

Figure 5-16: Speed Dial Setup

To add a new speed dial, click New at the bottom left of the speed dial 
window.  A new speed dial entry will be created with the default 
description highlighted.
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Complete the Description, Activate with Listen, Activate with Talk, 
DTMF Auto Dial number and the Speed Dial Source fields.

Note: A comma (,) may be placed in the DTMF sequence to add a 
pause of 500ms between digits or before the DTMF 
sequence if required.

Create a control using the ‘Controls’ link on the Configuration menu.  
Then attach the speed dial to the control by selecting the control so 
that it is highlighted.  Then select the required speed dial from the 
‘Available’ members pane and click on the right arrow to transfer it to 
the ‘Attached’ members pane.  The speed dial is now attached to the 
control.  

To detach a speed dial from a control simply select the control and 
then select the speed dial to be detached in the ‘Attached’ members 
pane.  Click the left arrow to move it back to the ‘Available’ pane.

Program the label of the Telephone Interface and the Control to 
activate the Speed Dial from the panel Programming screen.

Download to the Frame by an Apply Label Changes download.

To activate the Speed Dial, select the Label of the Telephone Interface, 
then select the label of the Speed Dial’s control.

DELETE A SPEED DIAL
To delete a Speed Dial:

1. Select the Speed Dials link from the Configuration menu.  This 
opens the Speed Dials configuration screen.Locate the Speed Dial 
you want to delete. 

2. Click the gray button next to the description field to highlight the row. 

3. Press Delete.
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CONTROLS
Relay options, routes and speed dials can only be accessed by being 
first placed inside a control.  A control can then be placed on a panel 
key for activation.

The ‘Controls’ link on the Configuration menu provides a screen 
location where the use of controls are used for association with 
attachments to allow a label to activate a route, relay or speed dial for 
the currently required control.

Figure 5-17: Setup Menu

To access the Control Manager select the ‘Controls’ link from the 
Configuration menu.
C
E

lear-Com®
HX User Guide

5 - 9 9



Figure 5-18: Control Manager Screen

The Control Manager screen is split into 4 windows, which allows the 
following activities:

CREATING AND DELETING CONTROLS
The Controls window provides a list of all available controls.  Also 
Controls are created and deleted from within this area.  To create a 
new control, select the ‘New’ button.This adds a control to the list. 

 Controls are automatically identified with a Talk and Listen label (the 
default labelling is ctrl1 and onwards).

To delete a Control, highlight the Control from the Control Viewer 
window then select Delete.
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PROPERTIES
The Properties window allows the user to edit the Control’s Basic 
Settings, Global Settings and Soft Mode Options.  

Controls Basic Options
Basic Options displays the fixed information about a Control and can 
be used to edit the Control description, Talk and Listen Aliases and 
Talk and Listen labels.

To enable/disable Basic Options:

1. Open the Control Manager screen by selecting the ‘Controls’ link on 
the Configuration menu.

2. Create a Control or select a Control that was been previously 
created.

3. Expand Basic Options in the ‘Properties’ window.
4. Update the settings as required.

Global Options

To enable/disable Global Options

1. Open the Control Manager screen by selecting the ‘Controls’ link on 
the Configuration menu.

2. Create a Control or select a Control that was been previously 
created.

3. Expand the Global Options in the ‘Properties’ window.
4. Select the ‘Latch Disable’ item in the ‘Global Settings’ list.
5. Select the drop down arrow and select the required status.

Soft Mode Options
The ‘Soft Mode Options’ list display items which relate to the Soft 
Mode available on certain panel types.  Currently this is restricted to 
Sort Groups.

To enable/disable Soft Mode Options

1. Open the Control Manager screen by selecting the ‘Controls’ link on 
the Configuration menu.

2. Create a Control or select a Control that was been previously 
created.

3. Expand the ‘Soft Mode Options’ item in the ‘Properties’ window.

AVAILABLE
The Available window provides a complete list of all the available 
relays, routes and speed dials that can be attached to a Control.

To attach a relay, route or speed dial to a Control, select or create a 
Control from the Control Viewer and then either double click the 
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required item in the Available window or select the item and click on 
the ‘>’ symbol between the windows. This transfers the item into the 
Attached window.  The Control label can then be placed onto a panel 
key or attached as a secondary action to a panel, Interface, Fixed 
Group or partyline depending on user requirements.

ATTACHED
The Attached window provides a list of relays, routes and speed dials 
that have been attached to a Control.  You can also remove items from 
Controls.  

To remove an attached item from a control, select the Control from the 
Control Viewer window. 

From the Attached Actions window double click the item that is no 
longer required or select the item and click on the ‘<‘ symbol between 
the Available and Attached windows.  This returns the item to the 
Available window.

Select the ‘Matrix Frame Preferences’ link to display the options for a 
number of system wide functions.

RELAY NAMING
The Available and Attached windows have tabs for the various types of 
functions, allowing them to be filtered for ease of selection.  Two of the 
tabs are “Panel AUX relays” and “Panel mute relays”. 

These functions correspond to these relay outputs in the ICS panel 
documentation.  In the case of V-Series panels the output relays  and 
labelled as 1 and 2.  The correspondence between the labels in EHX 
and the panel hardware is:

• Panel mute relay - relay output 1.

• Panel AUX relay - relay output 2.

TEL-14 CONFIGURATION OPTIONS
From the Hardware menu select the ‘Cards and Ports’ to display the 
Eclipse HX  hardware setup.  Locate the Telephone Interface and 
select it.  The Advanced Settings for the telephone are displayed.  
Open the ‘DTMF Settings’ menu in Advanced Settings to set up the 
DTMF facilities.

Set the ‘Access Prompt’ to true, and then select the ‘Enable 
Passcodes’ field from the Advanced Settings and open the drop down 
menu listing the passcodes configured under ‘Matrix Frame 
Preferences’.  Select the Passcode by placing a tick in the check box 
beside the required password.  Apply the changes to the Frame by 
completing an ‘Apply changes to System’ download.

The selected Passcode is then specific to that TEL-14 interface.
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INWARD DTMF Access
DTMF Access allows combinations of DTMF tones that are 
pre-assigned with specific meanings to have access to the Eclipse HX 
system. The Assign DTMF Access field within the Advanced Setting 
screen of a telephone screen allows setting all parameters related to 
the DTMF-tone decoding. Each MVX-A16 Crosspoint Card provides 
sixteen ports, on each MVX card there are 4 slots where DTMF 
Daughter boards are required to be fitted before DTMF-tone encoding 
and decoding is possible. DTMF decoding is the ability to interpret 
DTMF tones.  DTMF encoding is the ability to create DTMF tones.

Selector codes are the two-digit numerical codes that outside callers 
use to access the system. The codes initiate the specification of audio 
paths when system is accessed via DTMF inward access.  If the [One 
Digit Codes] field is set to true, only the ten single-digit codes [0] 
through [9] will function as selector codes.

If the ‘Multiple Codes (Accumulate)’ option has been selected in 
Advanced Settings the inward DTMF stream may contain multiple 
selector codes, for example to activate more than one panel or control.  
If this is the case it is advisable to separate the selector codes by 
placing a space in the source string to ensure that selector codes after 
the first are correctly identified.

Note: The characters used to specify a space or pause between 
codes may vary with the equipment calling into the Eclipse 
HX system; consult the  manufacturers instructions for 
details.

Control Codes are codes that perform specific functions, including:

·00 - Clear Last Entry—This code will clear the paths that were 
activated by the last selector code entry. If [00] is entered twice, the 
paths that were activated by the last two selector code entries will 
clear, and so on.

·91 - Send Call Signal—This code will send a call from the port to 
the matrix as if a call signal was sent by an external device 
connected to the port.

·92 - Disable DTMF Decoding—This code turns off DTMF decoding. 
This may be desirable because certain program sources may 
contain DTMF tones not intended to be interpreted as selector 
codes, and that can inadvertently reroute the audio path. For further 
information See “First Code Only” on page 5-105.

·99 or 099 - Clear All—Either of these codes will clear all currently 
active talk and listen paths.
C
E

lear-Com®
HX User Guide

5 - 1 0 3



Prompt tones are tone sequences that the MVX-A16 sends to the 
user. The MVX-A16 issues the following four distinct prompt tone 
sequences:

"Access Code Request"—Indicates that the system is ready for an 
access code to be entered. If the system does not recognize the 
entered access codes, it will repeat the access code request 
prompt. The number of attempts to enter the access code is 
limitless. The prompt consists of a low tone followed quickly by a 
higher tone. The sequence is quickly repeated three times.

"Access Granted"—Indicates that the system has acknowledged the 
access code and that access to the Eclipse HX matrix has been 
granted. The prompt consists of four tones, each increasing in pitch 
and immediately followed by a "ready” prompt.

"Ready"—Signals that the system is ready for a selector code entry. 
It also indicates that it has acknowledged the last selector code 
entered. The prompt consists of a single high-pitched tone.

"Error"—Indicates that an invalid code has been entered. Error 
prompts result from:

1. Selecting a code that is less than 10 or greater than 59
2. Selecting a code without talk or listen labels assigned to it
3. Assigning a control code before a port has been activated.

Multiple Codes
If the Multiple Codes is set to false only one selector code can be 
active at a time. Entering a second selector code will automatically 
deactivate any audio paths that were activated by the previous selector 
code.  If this field is set to true, any number of selector codes can be 
active at the same time.  To deactivate a selector code, either enter the 
selector code number preceded by a zero or enter a clear last or clear 
all control code.

One Digit Codes
If One Digit Codes is set to true the selector codes are limited to one 
digit—0 though 9—plus the quick keys—pound (#) and asterisk (*).  
These codes are easier to remember and dial; however, they also 
have the following limitations:

• Only ten codes are available

• Control codes are not recognized

• The pound and asterisk keys can only be assigned a single digit 
code
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• The system will no longer recognize the "0<selector code>" form, 
which will deactivate any established individual path. This means 
if multiple codes, has been enabled a previously established path 
cannot be deactivated.

First Code Only
If the First Code Only is set to true the DTMF tone detection will be 
disabled after the first valid code has been received. DTMF decoding 
can also be disabled by entering the disable DTMF decoding control 
code (92), described in the Control Codes section.

Certain circumstances may encourage the disabling of DTMF-tone 
detection. During normal operation, DTMF tones in the port’s audio 
input are decoded at all times. However, certain audio program 
sources— such as telephone company commercials—may contain 
DTMF tones that are not intended to be interpreted as selector codes, 
and can inadvertently reroute the audio path. Certain voices or musical 
instruments can also fool the DTMF tone detection circuitry into 
detecting false DTMF tones.

By disabling DTMF-tone detection after the program feed has been set 
up, the paths will not be accidentally rerouted. To re-enable tone 
decoding, hang up and call back again.

Quick Codes
These menus define the Touch-Tone keypad’s asterisk (*) and pound 
(#) keys as quick keys through the use of quick codes. If a two-digit 
pair (corresponding to one of the valid selector codes or control codes) 
is selected from the menus for the asterisk or the pound, the DTMF 
port will translate the asterisks or pound’s DTMF tone into that 
two-digit code. For example, if the asterisk key is supposed to clear all 
paths, select [00] from the [*] menu. If the [One Digit Codes] box is 
checked, the quick keys cannot be assigned control codes.

CONFIGURING DTMF ACCESS CODES

Multiple Code Setup
Multiple codes enable an operator to stack multiple routes so that 
having called one destination a sequential call can be made to a 
further destination without ending the first call.
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Assign DTMF Codes

Figure 5-19: DTMF Activations

1. From the telephones Advanced Setting screen select Assign DTMF 
Codes to open the DTMF Assignments screen.

2. Select the desired destination label from the palette of available 
destinations, at the bottom of the screen.

3. Find the desired code in the DTMF Codes column.
4. The columns to the right of the DTMF Codes column allow assigning 

as many as three talk labels and one listen label for each key. Click 
in the column for the desired type of label for the desired code: Talk 
1, Talk 2, Talk 3, or Listen. The selected label will appear in the 
desired cell. If this cell has already been assigned a label, the new 
label will displace the old one.

5. Download the new configuration to the Frame with an Apply Label 
Changes download.

Note: Although above describes a single route multiple routes 
can be attached to a control.

One Digit Code Setup
To assign the one-digit selector codes (numbered "0" through "9"), set 
the [One Digit Codes] field in the Advanced Settings screen for a 
telephone interface to true. 

1. From the telephones Advanced Setting screen select Assign DTMF 
Codes to open the DTMF Assignment screen.
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Figure 5-20: Single Digit DTMF Assignments

2. Select the desired destination label from the palette of available 
destinations, at the bottom of the screen.

3. Find the desired code in the DTMF Codes column.
4. The columns to the right of the DTMF Codes column allow assigning 

as many as three talk labels and one listen label for each key. Click 
in the column for the desired type of label for the desired code: Talk 
1, Talk 2, Talk 3, or Listen. The selected label will appear in the 
desired cell. If this cell has already been assigned a label, the new 
label will displace the old one.

5. Download the new configuration to the Frame with an Apply Label 
Changes download.

Note:
When a user manual dials, the DTMF tones go out on the last selected 
talk to an interface (in ECS v5.2.4, the DTMF tones go out on the last 
TEL-14 port). An interface is either a TEL-14, CCI-22, FOR-22 or a 
Direct.
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LOGIC MAESTRO
The ‘Logic Maestro’ link on the Configuration menu opens the Logic 
Maestro window.  Logic Maestro allows the user to create complex 
controls using an interactive graphic editor. 

Figure 5-21: Initial Logic Maestro Screen

Logic Maestro operations are described in the Logic Maestro 
manual.

PREFERENCES
The ‘Preferences’ link on the Configuration menu opens the 
Preferences dialog allowing the matrix system setups to be configured.  
This dialog is also accessible from the System Layout screen and is 
described in chapter 3 under Preferences.
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BELTPACKS
Selecting ‘Beltpacks’ from the EHX setup menu displays the beltpack 
configuration editor which will allow beltpacks to be added and 
configured.  Before a beltpack will work, it must be registered to the 
system.

To do this:

1. In Preferences set the correct DECT system ID and Frequency.

2. Configure the COM port to use for the beltpacks.

3. Open the Beltpacks screen, and enter a beltpack.

4. Connect the required beltpack on the COM port.

5. Press the "Register connected Beltpack to this system" button.

6. Click the ‘Register Beltpacks’ button to register a beltpack.  A list of  
instructions to register a beltpack will be displayed.

7. When the beltpack has been powered up and connected click on the 
‘Register’ button.  A confirmation screen will be displayed when the 
beltpack has been registered.

If the beltpack cannot be registered an error message will be 
displayed.

 Note:
The ‘Associated Role’  field can be edited by positioning the cursor in 
the box and editing the text in the normal way.  A description of the 
beltpack can be added in the ‘Description’ column.

BELTPACK PROPERTIES
To set the properties for the beltpack open the required options in the 
‘Properties’ window (top right).

Basic Options

Associated Role

Select a role from the list of available beltpack roles set up using the 
Beltpack Roles facility.

Description

Enter an optional description for the beltpack such as user or 
department.
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Engineer Comments

A scratchpad for engineers to record any relevant information about 
the beltpack.

Listen Label

The Listen label that is available for panel configuration (a combined 
Talk/Listen label is shown unless the option for 10 character labels is 
turned off).

Power Up State

This defines whether the beltpack role is set to a preferred role or a 
fixed role when it is powered up.

Serial Number

The beltpack serial number. This field is non-editable.

Talk Label

The Talk label specified for use in the panel configuration table (a 
combined Talk/Listen label is shown unless the option for 10 character 
labels is turned off). 
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BELTPACK ROLES
Beltpack roles define the beltpack in the same way as a label defines a 
key on a panel so that assigning a role to a beltpack has the effect of 
creating a label for it that can be referenced by other devices in the 
system such as a panel.  

To create and edit beltpack roles select the ‘Beltpack Roles’ entry in 
the Setup menu to display the beltpack roles editor.

Figure 5-22: Beltpack Role Editor

To create a new beltpack role select a port and click on the ‘Type’ 
drop-down menu and select the entry ‘Beltpack Role’.  This will add a 
new role entry on the selected port.  The Talk and Listen labels can be 
edited by placing the cursor in the box and clicking to select the entry 
and editing the text in the normal way.  To edit the description position 
the cursor in the description box and select the text to edit it.

Highlighting the role allows the role properties to be entered using the 
‘Properties’ window.

BASIC OPTIONS

Description
Enter an optional description for the beltpack role such as user or 
department.

Engineer Comments
A scratchpad for engineers to record any relevant information about 
the beltpack role.
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Listen Label
The Listen label that is available for panel configuration. A combined 
Talk/Listen label is displayed unless this option is set.

Talk Label
The Talk label specified for use in the panel configuration table. A 
combined Talk/Listen label is displayed unless this option is set.

GLOBAL OPTIONS

Latch Disable
The setting determines if the beltpack PTT is latching or non-latching 
in the same way as a key on a panel may be latching or non-latching.
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MENU OPTIONS

Beltpack Menu Options
The setting determines the level of access the beltpack user has to the 
beltpack menus to alter settings.  The four settings are:

• Advanced - full access to all menu options and settings.

• Normal - beltpack microphone type and headphone limiter setting 
are locked, all other options and settings are available.

• Basic - all beltpack options and settings are locked except 
contrast, master volume, key lock, tap latch, page lock and 
information screens.

• None - all menus and settings are locked and cannot be viewed.

FAST KEY ASSIGN OPTIONS

Default Assign as Talk and Forced Listen.  
When true the default for a key assigned to this label is Talk and 
Forced Listen.

Enable Assignment as a Listen
Allow the port to be assigned locally using Fast Key Assign as a listen 
key by another panel.

Enable Assignment as Talk
Allow the port to be assigned locally using Fast Key Assign as talk key 
by another panel.

Protect Port from Assignment
Prevents this port from being locally assigned by another panel in soft 
mode.

BELTPACK PROGRAMMING
Beltpack programming (assigning labels to keys, setting beltpack 
operating parameters etc is now carried out in Panel Programming 
treating the beltpack as a panel where labels can be dragged and 
dropped onto keys in the same way as panels.

To program a beltpack select ‘Panel programming’ from the 
Configuration menu and select the required beltpack from the 
drop-down list of panels at the top of the window.  The beltpack mimic 
will be displayed.
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Figure 5-23: Beltpack Programming Screen

Labels can be selected from the list and dragged and dropped onto 
beltpack keys.

Six pages of keys are available on the beltpacks; the key pages are 
selected from the drop-down ‘Page’ list.  The pages are Main (the 
default page), Shift1, Shift2, Shift3, Shift4, Shift5.  

When the pointer is placed over a key the status of the key is displayed 
showing the beltpack role, key number and the key type.

Right clicking a key will open a key configuration menu allowing the 
key type, local assignment, interlock group and latch disable to be set 
up.

Activation
The activation option allows the key type to be configured to determine 
how the key will behave when activated via the pushbutton.  To set the 
key activation type right click over the required key to display the 
options menu and then select the ‘Activation’ item to display the 
activation options.
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Figure 5-24: Beltpack Key Assignment Menu

The activation options are: Talk, Listen, Talk and Listen, Talk and 
Forced Listen or Dual Talk and Listen.

• Talk sets a talk from the beltpack to a destination with no 
automatic listen to the destination.

• Listen sets a key to listen to the source without talking to the 
destination at the same time.  Use as a monitor key (press the 
volume level up/down buttons under the display to increase 
listen level).

• Talk and Listen sets a talk key with listen  (press the volume 
level up/down buttons under the display to increase or mute 
the listen level).

• Talk and Forced Listen sets a talk key with permanently made 
listen (press the volume level up/down buttons under the 
display to increase or mute the listen level).
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• Dual talk and Listen sets a Dual talk and listen key.  This 
makes the pushbutton activate a Talk and Listen on a press 
and hold or latch a Listen with a short press and release (less 
than 200ms) on the same pushbutton.

Local Assignment
Click on the ‘Local Assignment’ entry to display the available options 
for local key assignment.  The options are to allow local key 
assignment and to disallow local key assignment.  If the local 
assignment is allowed for the key then the beltpack key can be 
assigned by updating the beltpack with key assignments uploaded 
from the matrix via the ‘Upload’ control on the toolbar.

Interlock Group
The EHX user can assign several keys on a beltpack into a selector 
group and restrict the group so that only one key of the group can be 
activate at any one time.  This function only refers to talk paths. 

Note: For example if a beltpack had three keys programmed to 
talk to a cameras 1 to 3 then by setting these into an 
interlocked group only one camera key can be selected at a 
time.

There are nine available interlocked groups to which the EHX user can 
assign any or all beltpack keys. 

To add a key to an interlocked group

1. From Panel Programming, select the beltpack. 
2. Right click on the required key to display the key options list.
3. Select the ‘Interlock Group’ entry to display the interlock group 

options list.
4. Select the required interlock group or ‘None’ if the key is not to be in 

any interlock group.
5. The key may be added to other interlock groups as required.
6. The key interlock groups will be displayed in the key information 

popup.
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Figure 5-25: Beltpack Interlock Group Assignment

Local Advanced Latch Disable
This allows latching of keys to be disabled locally on the beltpack.  May 
be set to On or Off.

Go To Key Destination
Click the ‘Go To Key Destination’ entry to display the Matrix Hardware 
editor screen with the destination the key refers to highlighted.

Delete Key
Click the ‘Delete Key’ entry in the menu to delete the assigned label 
(shown highlighted).  Note that only the highlighted label will be 
deleted; the green listen label for that key will not be deleted.
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FRAME FILTERING
If there are many matrices in a project, it is possible to select which 
frames are visible and configurable in the Palette. If there is more than 
one matrix in the project, the Configure Filters button is visible in the 
top left of the screen. 
1. Select Configure Filters, the following screen appears.

Figure 5-26: Filter Frames

2. Deselect any frames that you do not wish to be visible in the Palette.
3. Select Apply. You will return to the Palette.

Note: Deselecting a frame does not remove it from the project.

Note: Entities from filtered out frames do not show on screens for 
non-filtered frames. For example, if you filter frame 2, then 
go to, say the fixed groups screen on Frame 1, you will not 
see any entities from Frame 2. This is only true for entities 
that are available to be assigned - you will always see 
already assigned entities (i.e. existing group members) 
whether they are filtered or not. In addition, panel 
programming maintains a separate list of filters.
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IP DEVICES

INTRODUCTION TO IP DEVICES
IP Devices allows the EHX operator to centrally manage IP panels, 
IVC-32 cards and Concert users. 

To start IP Devices, go to Hardware > IP Devices.

The initial IP Devices display shows three panes for managing the 
configuration of IP panels, Concert users and IVC-32 IP interface 
cards.  

When IP Devices is opened it will automatically search for IVC-32 
cards in configured matrices and IP enabled V-series panels on the 
same network as the configured matrices.

Note: EHX operators should not open more than one instance of 
IP Devices to assign or monitor IP panels on the same frame 
at the same time.

Figure 6-1: IP Devices screen

The IP Panels and Concert Users panes have a menu button in the top 
left corner for opening menus for diagnostics and the discover button 
in the top right corner to start EHX searching for the specified items.
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Figure 6-2: IP Devices Pane Buttons

Clicking on the menu button will open the menus associated with the 
type of IP device associated with the pane.

Clicking on the discover button at the top left corner of the IP Panels 
pane will cause IP Devices to search for all the IP panels on the 
network.

The IP Cards pane has a similar layout but does not have a discover 
button.  Instead the left-hand button on the header bar opens or closes 
the list of IVC-32 cards detected in the current matrix.

Figure 6-3: IP Cards Pane

The left and right buttons on each IVC-32 card display are used to 
open displays for the individual cards.

IP PANELS
Clicking on the ‘IP Panels’ discover button will cause EHX to search all 
the systems on the network for IP enabled V-Series panels and display 
all the panels detected as a list.
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Figure 6-4: IP Panel List

The panels listed are color coded according to status.  The color codes 
are:

• Blue - panel has been discovered but does not have a login IP 
address, User ID or password configured.

• Green - panel has been discovered and is logged in to the current 
configuration.

• Amber - panel has been discovered that is configured in this 
configuration but is not logged in.

• Gray - panel has been discovered with an IP address that is not 
for the matrix in this configuration.  The panel may be configured 
for another matrix and may be logged in to that matrix.

• Red - panel has been discovered that is not in one of the other 
states.  The panel may be configured for this matrix but is not in 
the current configuration.

• Mauve - panel has been discovered but the panel status is 
undetermined.  Panels may be displayed in this color briefly 
during discovery until the panel status is established and the color 
will then change to reflect the panel status.

Clicking the left button of a panel entry will display an ‘Identify Panel’ 
button.

Figure 6-5: Identify Panel Button

Clicking on the identify button will request that the panel enters its 
‘IDENTIFYME’ mode with the panel LEDs flashing red across the 
panel.  The ‘Identify Panel’ text will be displayed in bold and a red bar 
will move across the button to show that the mode is active.
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Figure 6-6: Identify Function Active

Clicking the button again will end the identify mode.

Clicking the right button will display a list of all the available information 
about the panel.

Figure 6-7: IP Enabled Panel Info

The panel information displayed shows the following:

• Panel - panel type.

• MAC - panel MAC address.

• Connection - the protocol used in the panel connection.

• Connected - the length of time the panel has been connected 
without a reset.

• Powered - the length of time since the panel was last powered up.
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The IP settings displayed are the same as those set on the panel using 
the panel IP setup menus (see V-series manual).

• Login IP - the IP address of the IVC-32 card that the panel will try 
to log in to.

• Login Port - the port the panel will use to log in to the IVC-32 
card.

• DHCP Enabled - whether the panel should obtain an address 
from a DHCP server or use a preset address.

• Connection - the type of connection; WAN, LAN or Internet.

• IP Address - the IP address of the panel.

• Netmask - the subnet mask for the network the panel is on.

• Gateway - the IP address of the gateway to be used when 
connecting to the matrix.

• DNS - the IP address of the Domain Name Server to be used by 
the panel to obtain an IP address automatically if DHCP is 
enabled.

Clicking Edit enables the IP settings to be changed from IP Devices.  

Figure 6-8: Editing IP Panel Settings

When the edits are completed click on the tick button to accept the 
changes or the cross button to cancel the changes.

If a parameter is set to an invalid state, such as part of an IP address 
being set to a number greater than 255 the error will be flagged by a 
red border around the item when attempting to save it.  The invalid 
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entry will not be sent to the panel and the entry will be reset to the 
original value if edit mode is cancelled.

Figure 6-9: Panel Setting Error in Edit Mode

Note: Care should be taken when making some changes as they 
may prevent the panel from logging in to the IVC-32 card, for 
example by changing the login IP or login port.

Clicking on the left arrow button at the top of the IP Panels pane will 
display the panel filter facilities allowing panels to filtered by state 
and/or by name.

Figure 6-10: IP Panel Filter Options

To filter panels by status open the status menu (show as ‘All Panels’) 
and select the panel status filter.

Figure 6-11: Status Filter Menu

Select the required status filter to list all the panels in that state.
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Figure 6-12: Panel Status Filtering

To filter panels by name enter the panel IP address, MAC address or 
panel ID into the ‘Name Search’ box and click on the ‘Discover’ button 
to refresh the display.

ASSIGNING A PANEL TO AN IVC-32 PORT
Panels can be assigned to ports on an IVC-32 card by dragging the 
panel icon from the IP Panels pane to the assignment zone on the 
IVC-32 card.  Panels can also be moved from one IVC-32 port to 
another.  The results of the action will depend on the status of the 
panel.  

• Moving (assigning) a panel to a port on the IVC-32 card will only 
adjust the current user ID in the panel if no user ID in the panel 
currently exists.  In this case a unique user ID is used as the user 
ID of the connection.  The password on the connection is left 
blank.  This initial state of the panel represented by the blue color 
and indicates that the panel is known to be out of use and ready 
for assignment.

• If a current user ID setting already exists on a panel it is not 
adjusted during an assignment.  If the panel is used in another 
currently inactive Eclipse configuration this association would now 
have been broken.

• When a panel is not used by the current configuration but has a 
user ID (even though this may be a stale configuration) and the 
matrix IP address is in the current configuration the panel is 
shown as red. This indicates that care should be taken before 
using this panel i.e. check its current usage before assigning it
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• If a panel's matrix IP address is not in the current configuration 
and a user ID is set the panel is shown as grey to indicate it is 
configured for use on another system. In this state only a user 
logged in as administrator (in EHX) may assign it to an IVC-32 in 
the currently active configuration.

• To un-assign a panel that has been assigned to a port on an 
IVC-32 card, simply drag the panel off the port and drop it in the 
blank area to the right of the IVC-32 cards.

IP CARDS
The IP Cards pane will display a list of all the IVC-32 cards detected in 
the current matrix with the number of the matrix slot the card is in.

Figure 6-13: IVC-32 Cards List

Clicking the left menu button on any card will display diagnostics and 
the current card configuration and allow the card configuration to be 
edited.
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Figure 6-14: IVC-32 Cards Diagnostics and Settings

Click on the ‘Get Diagnostic Info’ button to retrieve the current buffer 
overflow statistics.  If a significant number of buffer overflows are 
reported this may indicate network problems.
6
 - 9
 Clear-Com®
EHX User Guide



IVC-32 IP SETTINGS
The ‘IP Settings’ section displays the IP setup of the IVC-card.  Click 
on the ‘Edit’ button to enable this section to allow changes.  The fields 
will change from grey text to input boxes.  The external IP address and 
IP port will only be enabled if the ‘External IP Address’ box is checked.

Figure 6-15: Editing IVC-32 Card Settings

IP Port
The port the panel will use to log in to the IVC-32 card.  This will be the 
internal IP port  if the panel is on the same LAN, or the external IP port 
if not.

This parameter should not normally be changed from the default value 
unless all the IP panels or Concert server are also updated to use the 
new port number.  If this is not done the IP panels or Concert server 
will not be able to communicate with the IVC-32 card.  Eclipse system 
administrators are advised to check with network administrators or IT 
that the default port may be used without causing a conflict with any 
other application on the network.

If the IP port number is changed ports 42001 and 1300 should not be 
used as these ports are already used by EHX. The Eclipse HX system 
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administrator should check with the network administrator or IT to 
obtain a port number to use.

IP Address
The IP address of the IVC-32 card that the panel will try to log in to. 
This will be the internal IP address if the panel is on the same LAN, or 
the external IP address if not.

Subnet Mask
Subnet mask used by the IVC-32 card to define the address range the 
card can access.  Commonly set to 255.255.0.0 or 255.255.255.0.

Default Gateway
The address of the gateway to be used to communicate with external 
devices such as IP panels and Concert clients over the IP network.

External IP Address
This checkbox enables editing of the external IP address and port 
number below the checkbox.

IP Address
The external IP address that can be used to communicate directly with 
the IVC-32 card itself rather than the matrix via the IVC-32 card.  This 
address is not used by IP panels etc.

IP Port
The external IP port used when communicating directly with the 
IVC-32 card using the external IP address.

When the edits are complete click on the tick button to save the 
changes.  Alternatively click on the cross button to discard the 
changes.  As soon as the changes are confirmed EHX will send them 
to the IVC-32 card.
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IVC-32 CARD PANEL LIST
Clicking on the right button will display a list of the panels connected to 
the IP ports on the IVC-32 card.

Figure 6-16: List of Ports on an IVC-32 Card

To display diagnostics for a panel click on the down arrow button on 
the right side of the entry for the required panel.

This will open a diagnostics display of cumulative error data for the 
panel and the IVC-32 port it is connected to.  Where data is presented 
for both panel and port this can be used to diagnose whether any 
network problems are at the matrix or panel end of the link.

Click ‘Get Diagnostic Info’ to retrieve the current panel diagnostic data 
and display it.
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Figure 6-17: Panel Diagnostics Display

Jitter is a measure of the quality of the network connection.  It 
represents the variation in the time period with which audio packets are 
received. For example, if an audio packet is expected every 10 
milliseconds, but one audio packet is received 13 milliseconds after 
another, this represents a jitter of 3 milliseconds.

If the jitter gets too high the panel will start to experience audio 
dropouts.

WAN mode panels can deal with larger jitter than LAN mode panels, 
and Internet higher than WAN mode, as they use larger jitter buffers to 
smooth out the uneven arrival of audio packets. However the downside 
of this is that the larger the jitter buffer, the longer the audio delay.

• Average Jitter - the average packet interval in microseconds.

• Max Jitter - the highest packet interval measured in milliseconds.

LAN mode panels can cope with jitter up to 80 milliseconds 
without audio dropout.
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WAN mode panels can cope with jitter up to 120 milliseconds 
without audio dropout.

Internet mode panels can cope with jitter up to 200 milliseconds 
without audio dropout.

• Forward Error Correction - this allows the IVC-32 to recover from 
corruption in audio packets caused by a poor network link, at the 
cost of slightly increased network traffic and slightly higher audio 
delay.  Forward Error Correction is set to a HIGH level in internet 
mode, LOW level in WAN mode and is disabled in LAN mode. 

• Silence Suppression - this reduces the network traffic generated 
by a panel by stopping the transmission of packets when there is 
no audio input (that is, the microphone is turned off). It can cause 
a slight increase in audio delay.  Silence suppression is enabled 
in WAN and Internet mode, but disabled in LAN mode. 

• Rx Packets - this displays a count of the IP packets that a panel 
has received, and can be used to check the network connection. 
When Silence Suppression is enabled the numbers may only 
increase when the panel microphone is enabled.

• Tx Packets - this display a count of the IP packets that a panel has 
sent, and can be used to check the network connection. When 
Silence Suppression is enabled the numbers may only increase 
when the panel microphone is enabled.

• Rx Drops - The number of audio packets that have been lost. This 
can be due to network quality.
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CONCERT USERS
The Concert Users pane obtains details of the Concert users on the 
specified Concert server.  The user list can be obtained for all partitions 
on the server or for only one partition.

Figure 6-18: Initial Concert User Display

Click on the left hand button to enter or edit the IP address for the 
Concert server to be searched for users.

Figure 6-19: Current Concert Server IP Address

Click on the ‘Edit’ button to enable the Concert server IP address for 
editing in order to input the correct address.

Figure 6-20: Editing the Concert Server Address

Enter the required address and optionally the port to be used.  
Normally the default port of 8003 should be accepted.

Click on the tick button to accept the edit or the cross button to cancel 
the edit.

Note: The port would not normally be changed unless there was a 
specific reason for this and the Concert server setup was 
also changed.  If the port number is changed to an incorrect 
value IP Manager will not be able to connect to the server 
for the user information.
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CONCERT SERVER DIALOG
Click on the discover button (top right) to obtain the server information.  
If ‘All Partitions’ is selected then all the Concert users known to the 
server will be listed.  Clicking on the down arrow next to ‘All Partition’ 
will display a list of the partitions and allow a specific partition to be 
selected.

Figure 6-21: Concert Users on a Partition

The Concert users are color coded according to the user status.  The 
possible user codes are described below.

• Blue - Concert user discovered, no configured login IP address or 
EclipseID or Password.

• Amber - Concert user discovered, configured in EHX to this 
configuration, but not logged in. This does not indicate whether or 
not it is configured in the matrix. The configuration of a port using 
the IP manager screen involves both the drag and drop in the UI 
and a map download to the matrix.

• Green - Concert user discovered, user is logged in to this 
configuration.

• Gray - Concert user is discovered, login IP address set to the IP 
address of another matrix.

• Red - Concert user discovered, user is not in any of the previous 
categories, may be used by other configuration on same frame IP 
address or not in use but setup on the current matrix.

Clicking on the arrow button on the right side of a user entry will display 
the user details and diagnostics.
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Figure 6-22: Concert User Information

The Concert user information fields provide the following details:

• ID - internal Concert identifier.

• Username - Concert user name.

• Eclipse Username - the name that is used to log in to the Eclipse / 
Eclipse HX system over IP.  This is used in conjunction with the 
Concert panel.  The Eclipse HX user name must be set up on the 
Eclipse HX system.

• Keyname - the name by which the Concert user is assigned to 
keys on Eclipse HX panels.

• Eclipse Enabled - whether the Concert user is allowed to log in to 
an Eclipse / Eclipse HX system.

• Matrix IP Address - the IP address of the matrix that the Concert 
user will be logged in to when communicating with an Eclipse / 
Eclipse HX system.
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Concert User Diagnostics
The diagnostic display for Concert users indicates user activity.

• Software Version - the version of the Concert client in use.  This field 
can only be displayed if the Concert user is logged in to the 
Concert server.

• Online seconds - length of time in seconds that the user has been 
online to the Concert server.

• Tx Pkts - number of ethernet packets transmitted to the user Concert 
client.

• Tx Octets - number of 8-bit bytes transmitted.

• Rx Pkts - number of ethernet packets received from the user Concert 
client.

• Rx Pkts Lost - number of ethernet packets from the user client lost.

• Rx Pkts Recovered - number of lost receive packets recovered.

• Rx Pkts Out Of Order - number of ethernet packets received from the 
user client in the wrong order.

The packet count diagnostics are to help diagnose network problems 
experienced by Concert clients such as excessive packet loss leading 
to lower audio quality.

ASSIGNING A CONCERT USER TO AN IVC-32 PORT
A Concert user can be associated with an IVC-32 port by dragging and 
dropping a Concert user entry onto a port on an IVC-32 card.  If the 
port is already in use the current entry is removed and replace by the 
Concert user.  Concert clients can also be moved between ports on an 
IVC-32 card by dragging and dropping.

The IVC32 port's talk label, listen label and description fields are 
updated with the information received from the EMS (Concert) server.

The connection ID is set as follows:

• If the Concert User already has a connection ID this is assigned to 
that port, otherwise a new unique connection ID is created and 
used by both concert user and port.  One special case is when the 
eclipse ID is already in use, a new unique ID will be created for 
both concert user and port.

• By default a connection password is NOT set; a password is only 
used if the port has a password explicitly set on it in Matrix 
Hardware for added security.  The password can be set in ‘IP 
Panel Settings’ under ‘Advanced Settings’.

• These changes are sent to the EMS server in real time during the 
drag and drop operation so no separate action is required to 
update the Concert server.
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PANEL 
PROGRAMMING

From the Panel Programming screen (in the Configuration menu), the 
EHX operator can assign talk and listen labels to panel keys, assign 
labels to expansion panel keys, configure assignment panels, stack 
keys and set key specific functions.

Figure 7-1: Panel Programming Screen
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THE PANEL PROGRAMMING SCREEN
The Panel Programming Screen is split into four areas.  

The top area provides scroll arrows and a drop down list of all intercom 
panels. The top area also provides access to key Label Options and 
Local Assignments.

The middle area provides a mimic of the intercom panels and is the 
area where labels are programmed onto the panel selectors.  Also this 
area provides access to configure Expansion Panels to host Panels.  

Note: Expansion panels can only be added or removed in Cards 
and Ports.

The bottom right area provides an area where stacked keys can be 
configured or specific key actions can be set. This area can be 
expanded or collapsed.

The bottom left area provides Palette consisting of a list of all the 
matrices currently in the project. Each matrix can be expanded to list 
all the entities that it contains, such as panels, interfaces and 
partylines.
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V-SERIES PANEL PROGRAMMING
The following section overs the programming of the V-Series lever key, 
pushbutton, and rotary panel types and their associated expansion 
panels.

V-SERIES LEVER KEY PANELS
Select ‘Panels’ from the Configuration menu to display the panel 
options toolbar and select the panel from the drop-down list or the ‘>’ 
icons to step through the list of panels.

Figure 7-2: V-Series Lever Key Panel

Keys are assigned in the normal way by clicking on the required item in 
the list of available labels then dragging the items to the required key 
and dropping them over the display corresponding to the key and 
clicking on the mouse to confirm the assignment.  
C
E

lear-Com®
HX User Guide

7 - 3



Figure 7-3: Assigning a Label on a Lever Key Panel

Each blue display window is divided into an upper and lower section 
with the upper section being the listen label and the lower section 
being the talk label. This corresponds to the lever key action to activate 
the talk or listen routes (up to listen, down to talk).

If the mouse pointer is positioned over a key display/label the details of 
the label are displayed. 

Figure 7-4: V-Series Lever Key Assignment

To display the action menu for a key position the pointer over the label 
and right-click the mouse.
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Figure 7-5: Key Properties Menu

Local Assignment
Click the ‘Local Assignment’ entry to display the available options for 
local key assignment.  The options are to allow local key assignment to 
overwrite the selected key or to disallow local key assignment to 
overwrite the selected key.   This permits the system administrator to 
limit the keys a panel operator can overwrite when locally assigning 
keys by Fast Key Assign (V-Series only) or by Local Key Assignment 
(on panels supporting this facility).

Interlock Group
The EHX user can assign several keys on a panel into an interlock 
group and restrict the group so that only one key of the group can be 
activate at any one time.  This function only refers to talk paths. 

For example if a panel had five keys programmed to talk to cameras 1 
to 5 then by setting these into an interlocked group only one camera 
key can be selected at a time.

There are nine available interlocked groups to which the EHX user can 
assign any or all panel keys.  

The interlock groups are specific to the panel they are programmed for 
and do not affect interlock groups that may be set up on any other 
panel in the system.

To add a key to an interlocked group:

1. From Panel Programming, select the desired panel. 
2. Right click on the desired key to display the key options list.
3. Select the ‘Interlock Group’ entry to display the interlock group 

options list.
4. Select the required interlock group or ‘None’ if the key is not to be in 

any interlock group.
5. The key may be added to other interlock groups as required.
6. The key interlock groups will be displayed in the key information 

popup.
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Figure 7-6: Interlock Group Assignment

Lever key panels (1RU and 2RU) can support up to eight lever key 
expansion panels (not pushbutton or rotary expansion panels).  To add 
an expansion panel use the Advanced Settings options under ‘Cards 
and Ports’; to display the expansion panel mimic open the right hand 
drop-down list (normally displaying ‘Main Panel’) to show the list of all 
the expansion panels configured and select the required expansion 
panel.

Figure 7-7: V-Series Lever Key Expansion Panel

Labels are assigned to keys in the same way as main panels and the 
option menu is available.

Local Advanced Latch Disable
When the mouse pointer is over this entry a second menu is displayed 
giving the options to set Local Advanced Latch Disable  to On or Off.  
Select and click on the required option.  This performs the same 
function as ‘Latch Disable’ in the Local Advanced facility.  It will allow 
or disallow a panel to latch a key to another device.

Go To Key Destination
Click the ‘Go To Key Destination’ entry to display the editor screen for 
the type of destination the key refers to.  For example if the destination 
is a panel then the panel will be displayed on the ‘Panels’ screen; for a 
partyline key the ‘Partylines’ editor will be displayed with the partyline 
highlighted.
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Delete Key
Click the ‘Delete Key’ entry in the menu to delete the assigned label 
(shown highlighted).  Note that only the highlighted label will be 
deleted; the green listen label for that key will not be deleted.

V-SERIES PUSHBUTTON PANELS
Select ‘Panels’ from the Configuration menu to display the panel 
options toolbar and select the panel from the drop-down list or the ‘>’ 
icons to step through the list of panels.

Figure 7-8: V-Series Pushbutton Panel

Keys are assigned in the normal way by dragging items from the list of 
available sources and destinations to the required key and dropping 
them over the display corresponding to the key.  

Entities in the label palette appear differently for push button panels - 
they are split into left and right sections for talk and listen respectively. 
Clicking on the talk section will result in a talk key when clicked, 
clicking on the listen section will give a listen key

Unlike the lever key panels only one label can be assigned to a key 
rather than two but key activation can be assigned unlike lever key 
panels.

If the mouse pointer is positioned over a key display/label the details of 
the label are displayed. 

Figure 7-9: V-Series Pushbutton Assignment

To display the action menu for a key position the pointer over the label 
and right-click the mouse.
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Figure 7-10: Pushbutton Properties Menu

Local Assignment
Click the ‘Local Assignment’ entry to display the available options for 
local key assignment.  The options are to allow local key assignment to 
overwrite the selected key or to disallow local key assignment to 
overwrite the selected key. This permits the system administrator to 
limit the keys a panel operator can overwrite when locally assigning 
keys by Fast Key Assign (V-Series only) or by Local Key Assignment 
(on panels supporting this facility).

Interlock Group
The EHX user can assign several keys on a panel into a selector group 
and restrict the group so that only one key of the group can be activate 
at any one time.  This function only refers to talk paths. 

For example if a panel had five keys programmed to talk to cameras 1 
to 5 then by setting these into an interlocked group only one camera 
key can be selected at a time.

There are nine available interlocked groups to which the EHX user can 
assign any or all panel keys.  

The interlock groups are specific to the panel they are programmed for 
and do not affect interlock groups that may be set up on any other 
panel in the system.

To add a key to an interlocked group:

1. From Panel Programming, select the desired panel. 
2. Right click on the desired key to display the key options list.
3. Select the ‘Interlock Group’ entry to display the interlock group 

options list.
4. Select the required interlock group or ‘None’ if the key is not to be in 

any interlock group.
5. The key may be added to other interlock groups as required.
6. The key interlock groups will be displayed in the key information 

popup.
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Figure 7-11: Interlock Group Assignment

Activation
The activation option allows the key type to be configured to determine 
how the key will behave when activated via the pushbutton.  To set the 
key activation type right click over the required key to display the 
options menu and then select the ‘Activation’ item to display the 
activation options.

Figure 7-12: Pushbutton Key Activation

Pushbutton panels (1RU and 2RU) can support up to eight pushbutton 
expansion panels (not lever key or rotary expansion panels).  To add 
an expansion panel use the panel options under ‘Advanced Settings’; 
to display the expansion panel mimic open the right hand drop-down 
list (normally displaying ‘Main Panel’) to show the list of all the 
expansion panels configured and select the required expansion panel.
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Figure 7-13: V-Series Pushbutton Expansion Panel

Labels are assigned to keys in the same way as main panels and the 
option menu is available.

Local Advanced Latch Disable
When the mouse pointer is over this entry a second menu is displayed 
giving the options to set Local Advanced Latch Disable  to On or Off.  
Select and click on the required option.  This performs the same 
function as ‘Latch Disable’ in the Local Advanced facility.  It will allow 
or disallow a panel to latch a key to another device.

Go To Key Destination
Click the ‘Go To Key Destination’ entry to display the editor screen for 
the type of destination the key refers to.  For example if the destination 
is a panel then the panel will be displayed on the ‘Panels’ screen; for a 
partyline key the ‘Partylines’ editor will be displayed with the partyline 
highlighted.

Delete Key
Click the ‘Delete Key’ entry in the menu to delete the assigned label 
(shown highlighted).  Note that only the highlighted label will be 
deleted; the green listen label for that key will not be deleted.

V-SERIES ROTARY PANELS
Select ‘Panels’ from the Configuration menu to display the panel 
options toolbar and select the panel from the drop-down list or the ‘>’ 
icons to step through the list of panels.
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Figure 7-14: V-Series Lever Key Panel

Keys are assigned in the normal way by clicking on the required item in 
the list of available talk and listen labels then dragging the items to the 
required key and dropping them over the display corresponding to the 
key and right clicking on the mouse to confirm the assignment.  

On rotary panels Listen and Talk  are actioned by separate controls 
(rotary knob for Listen, talk button for Talk) so different paths can be 
assigned for Talk and Listen on the same key.

It is also possible to assign other keys to the Reply key on rotary 
panels, unlike other V-Series panels.

Figure 7-15: Assigning a Label on a Rotary Control Panel

Each blue display window is divided into and upper and lower section 
with the upper section being the listen label and the lower section 
being the talk label.  This corresponds to the rotary push action to 
activate the listen route and the talk button below the display to 
activate the talk route.

If the mouse pointer is positioned over a key display/label the details of 
the label are displayed. 
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Figure 7-16: V-Series Rotary Key Assignment

To display the action menu for a key position the pointer over the label 
and right-click the mouse.

Figure 7-17: Rotary Key Properties Menu

Local Assignment
Click on the ‘Local Assignment’ entry to display the available options 
for local key assignment.  The options are to allow local key 
assignment to overwrite the selected key or to disallow local key 
assignment to overwrite the selected key.

This permits the system administrator to limit the keys a panel operator 
can overwrite when locally assigning keys by Fast Key Assign 
(V-Series only) or by Local Key Assignment (on panels supporting this 
facility).

Interlock Group
The EHX user can assign several keys on a panel into an interlock 
group and restrict the group so that only one key of the group can be 
activate at any one time.  This function only refers to talk paths. 
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For example if a panel had five keys programmed to talk to cameras 1 
to 5 then by setting these into an interlocked group only one camera 
key can be selected at a time.

There are nine available interlocked groups to which the EHX user can 
assign any or all panel keys.  

The interlock groups are specific to the panel they are programmed for 
and do not affect interlock groups that may be set up on any other 
panel in the system.

To add a key to an interlocked group:

1. From ‘Panel’ select the desired panel. 
2. Right click on the desired key to display the key options list.
3. Select the ‘Interlock Group’ entry to display the interlock group 

options list.
4. Select the required interlock group or ‘None’ if the key is not to be in 

any interlock group.
5. The key may be added to other interlock groups as required.
6. The key interlock groups will be displayed in the key information 

popup.

Figure 7-18: Interlock Group Assignment

Rotary key panels (1RU and 2RU) can support up to eight rotary key 
expansion panels (not pushbutton or lever key expansion panels).  To 
add an expansion panel use the Advanced Settings options under 
‘Cards and Ports’; to display the expansion panel mimic open the right 
hand drop-down list (normally displaying ‘Main Panel’) to show the list 
of all the expansion panels configured and select the required 
expansion panel.
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Figure 7-19: V-Series Rotary Key Expansion Panel

Labels are assigned to keys in the same way as main panels and the 
option menu is available.

Local Advanced Latch Disable
When the mouse pointer is over this entry a second menu is displayed 
giving the options to set Local Advanced Latch Disable  to On or Off.  
Select and click on the required option.  This performs the same 
function as ‘Latch Disable’ in the Local Advanced facility.  It will allow 
or disallow a panel to latch a key to another device.

Go To Key Destination
Click the ‘Go To Key Destination’ entry to display the editor screen for 
the type of destination the key refers to.  For example if the destination 
is a panel then the panel will be displayed on the ‘Panels’ screen; for a 
partyline key the ‘Partylines’ editor will be displayed with the partyline 
highlighted.

Delete Key
Click the ‘Delete Key’ entry in the menu to delete the assigned label 
(shown highlighted).  Note that only the highlighted label will be 
deleted; the green listen label for that key will not be deleted.
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V-SERIES PANEL OPTIONS
This functionality is limited to the current configuration and ‘label sets’ 
can not be transferred between configurations.  The options for panel 
Save, Load, Copy, Paste and Clear are provided on the panel 
configuration toolbar above the panel mimic.

Figure 7-20: Panel Load Options

Page
Displays a list of  pages for the panel as a drop-down list.  Click on the 
required page to update the mimic to the page.

Save
Clicking on the ‘Save’ button on the Panel Programming toolbar will 
display the label file save dialogue.

Figure 7-21: Label File Save Dialogue
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Enter the name of the file which will default to the .ccl extension.  The 
keys from all pages are saved (including shift pages where supported) 
but the keys from any expansion panels that may be fitted are not 
saved in the file.  Expansion panel labels must be saved separately.

Load
Clicking on the ‘Load’ button on the Panel Programming toolbar will 
display the dialogue screen to select and open a panel label (.ccl) file. 

Figure 7-22: Label File Load Dialogue

Select the required file and click on the ‘Open’ button to load the labels 
from the file.  When a label load is performed all the labels on a panel 
(including shift pages) and cleared before the new labels are applied.  

If the type of panel being loaded is not the same as the type of panel 
the label file was saved from this may result in labels being lost when 
the panel is loaded.

Copy
Clicking on the ‘Copy’ button on the Panel Programming toolbar will 
copy the labels of the current panel page only into the scratch pad.  It 
does not copy labels from expansion panels.

Paste
Clicking on the ‘Paste’ button on the Panel Programming toolbar will 
paste the labels copied to the scratch pad onto the currently selected 
panel.  All the labels currently on the page will be lost. This allows 
single pages of labels to be pasted on to the panel.
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If the type of panel being pasted to is not the same as the type of panel 
the labels were copied from this may result in labels being lost when 
the labels are pasted onto the new panel.

Clear
Clicking on the ‘Clear’ button on the Panel Programming toolbar will 
clear all the labels from the current panel including shift pages but 
excluding any attached expansion panels.

Audio Mixer
Displays the audio mixer panel that allows the levels of individual 
crosspoints to be adjusted interactively.  This facility can only be used 
with V-Series panels.  See chapter 7 for details of the Audio Mixer.

Identify Panel
Selecting the ‘Identify Panel’ button on the panel programming toolbar 
will cause the panel currently being edited to flash the panel buttons or 
LEDs red and display ‘IDENTIFYME’ in the bottom left display.  In 
order to use this facility monitoring must be enabled using the ‘Monitor’ 
button on the EHX toolbar.

This facility is only available for V-Series panels; the ‘Identify Panel’ 
button will be greyed out for other panel types.

CONCERT PANEL PROGRAMMING
A Concert panel is a virtual panel (or soft panel) that runs on a PC and 
provides the same functionality as a normal hardware panel such as a 
V-Series panel.  Concert panels can connect to an Eclipse matrix via a 
Concert server.

Concert panel keys act as pushbuttons rather than lever keys and are 
operated using a mouse or other pointing device.  Concert panels do 
not support any expansion panels.

The following section covers the programming of Concert panels.

Select ‘Panels’ from the Configuration menu to display the panel 
options toolbar and select the panel from the drop-down list or the ‘>’ 
icons to step through the list of panels.
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Figure 7-23: Concert Panel

Keys are assigned in the normal way by dragging items from the list of 
available sources and destinations to the required key and dropping 
them over the display corresponding to the required key.  

As with V-Series pushbutton panels only one label can be assigned to 
a key and key activation can be assigned.

If the mouse pointer is positioned over a key display/label the details of 
the label are displayed. 

Figure 7-24: Concert Panel  Assignment

To display the action menu for a key position the pointer over the label 
and right-click the mouse.
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Figure 7-25: Concert Panel Properties Menu

Local Assignment
Click the ‘Local Assignment’ entry to display the available options for 
local key assignment.  The options are to allow local key assignment to 
overwrite the selected key or to disallow local key assignment to 
overwrite the selected key. 

This permits the system administrator to limit the keys a panel operator 
can overwrite when locally assigning keys by Fast Key Assign 
(V-Series only) or by Local Key Assignment (on panels supporting this 
facility).

Interlock Group
The EHX user can assign several keys on a panel into a selector group 
and restrict the group so that only one key of the group can be activate 
at any one time.  This function only refers to talk paths. 

For example if a panel had five keys programmed to talk to cameras 1 
to 5 then by setting these into an interlocked group only one camera 
key can be selected at a time.

There are nine available interlocked groups to which the EHX user can 
assign any or all panel keys.  

The interlock groups are specific to the panel they are programmed for 
and do not affect interlock groups that may be set up on any other 
panel in the system.

To add a key to an interlocked group

1. From Panel Programming, select the desired panel. 
2. Right click on the desired key to display the key options list.
3. Select the ‘Interlock Group’ entry to display the interlock group 

options list.
4. Select the required interlock group or ‘None’ if the key is not to be in 

any interlock group.
5. The key may be added to other interlock groups as required.
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6. The key interlock groups will be displayed in the key information 
popup.

Figure 7-26: Concert Interlock Group Assignment

Activation
The activation option allows the key type to be configured to determine 
how the key will behave when activated via the button.  To set the key 
activation type right click over the required key to display the options 
menu and then select the ‘Activation’ item to display the activation 
options.

Figure 7-27: Concert Panel Key Activation
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Local Advanced Latch Disable
When the mouse pointer is over this entry a second menu is displayed 
giving the options to set Local Advanced Latch Disable  to On or Off.  
Select and click on the required option.  This performs the same 
function as ‘Latch Disable’ in the Local Advanced facility.  It will allow 
or disallow a panel to latch a key to another device.

Go To Key Destination
Click the ‘Go To Key Destination’ entry to display the editor screen for 
the type of destination the key refers to.  For example if the destination 
is a panel then the panel will be displayed on the ‘Panels’ screen; for a 
partyline key the ‘Partylpartylineines’ editor will be displayed with the 
partyline highlighted.

Delete Key
Click on the ‘Delete Key’ entry in the menu to delete the assigned label 
(shown highlighted).  Note that only the highlighted label will be 
deleted; the green listen label for that key will not be deleted.

CONCERT PANEL OPTIONS
This functionality is limited to the current configuration and ‘label sets’ 
can not be transferred between configurations.  The options for panel 
Save, Load, Copy, Paste and Clear are provided on the panel 
configuration toolbar above the panel mimic.

Figure 7-28: Concert Panel Load Options

Page
Displays a list of  pages for the panel as a drop-down list.  Click on the 
required page to update the mimic to the page.
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Save
Click ‘Save’ on the Panel Programming toolbar to display the label file 
save dialog.

Figure 7-29: Label File Save Dialog

Enter the name of the file which will default to the .ccl extension.  The 
keys from all pages are saved (including shift pages where supported).

Load
Click ‘Load’ on the Panel Programming toolbar to display the dialog for  
selecting and opening a panel label (.ccl) file. 

Figure 7-30: Label File Load Dialog
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Select the required file and click the ‘Open’ button to load the labels 
from the file.  When a label load is performed all the labels on a panel 
(including shift pages) and cleared before the new labels are applied.  

If the type of panel being loaded is not the same as the type of panel 
the label file was saved from this may result in labels being lost when 
the panel is loaded.

Copy
Clicking the ‘Copy’ button on the Panel Programming toolbar will copy 
the labels of the current panel page only into the scratch pad.

Paste
Clicking the ‘Paste’ button on the Panel Programming toolbar will paste 
the labels copied to the scratch pad onto the currently selected panel.  
All the labels currently on the page will be lost. This allows single 
pages of labels to be pasted on to the panel.

If the type of panel being pasted to is not the same as the type of panel 
the labels were copied from this may result in labels being lost when 
the labels are pasted onto the new panel.

Clear
Clicking the ‘Clear’ button on the Panel Programming toolbar will clear 
all the labels from the current panel including shift pages.Audio Mixer

Displays the audio mixer panel that allows the levels of individual 
crosspoints to be adjusted interactively.  This facility can only be used 
with V-Series panels.  See chapter 7 for details of the Audio Mixer.

Identify Panel
Selecting the ‘Identify Panel’ button on the panel programming toolbar 
will cause the panel currently being edited to flash the panel buttons or 
LEDs red and display ‘IDENTIFYME’ in the bottom left display.  This 
facility is only available for V-Series panels; the ‘Identify Panel’ button 
will be greyed out for other panel types.
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I-SERIES PROGRAMMING
This section deals with programming I-Series main panels and 
expansions panels which are programmed in exactly the same way.  
The V-Series panels which may also be attached to I-Series panels as 
expansion panels are non-programmable.

ASSIGNING LABELS

Figure 7-31: Label Assign Screen

To assign a label to a given selector
1. Locate the mimic of the panel to programme by either using the 

scroll arrows or the drop down list box from the middle area of the 
screen.

2. Keys are assigned in the normal way by clicking on the required 
item in the list of available labels, and then dragging the item to the 
required key and dropping them over the display corresponding to 
the key and clicking on the mouse to confirm the assignment.

3. Drag the mouse cursor up the screen into the mimic area and 
position it over the required key.

4. Repeat for all required Label programming.

To program a Talk and Listen key, press and hold the keyboard “Ctrl” 
key and then select the Talk label and place that onto the panel.
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To program a Talk and Forced Listen key press and hold the keyboard 
“Alt” key and then select the Talk label and place the label onto the 
panel.

RE-ASSIGNMENT OF LABELS

Figure 7-32: Reassign Labels Screen

To re-assign a Label
1. Select the required port and locate the Label that is required to be 

re-assigned.
2. To select the new Label, place the mouse cursor over the Label.
3. Left click and hold down the mouse button.
4. Whilst holding down the mouse button drag slightly down the mouse 

until the Label is free from the display. 
5. Position the Label over the new position and release the mouse 

button to drop the label into the new position.
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I-SERIES LABEL FUNCTIONS

Activation
The activation option allows the key type to be configured to determine 
how the key will behave when activated via the pushbutton.  To set the 
key activation type right click over the required key to display the 
options menu and then select the ‘Activation’ item to display the 
activation options.

Figure 7-33: Key Assignment Menu

The activation options are: Talk, Listen, Talk and Listen, Talk and 
Forced Listen or Dual Talk and Listen.

• Talk sets a talk from the I-Series panel to a destination with no 
automatic listen to the destination.

• Listen sets a key to listen to the source without talking to the 
destination at the same time.  Use as a monitor key.  Press 
the volume level up/down buttons under the display to 
increase listen level.

• Talk and Listen sets a talk key with listen. Press the volume 
level up/down buttons under the display to increase or mute 
the listen level.

• Talk and Forced Listen sets a talk key with permanently made 
listen. Press the volume level up/down buttons under the 
display to increase or mute the listen level.

• Dual talk and Listen sets a Dual talk and listen key.  This 
makes the pushbutton activate a Talk and Listen on a press 
and hold or latch a Listen with a short press and release (less 
than 200ms) on the same pushbutton.

Local Assignment
Click the ‘Local Assignment’ entry to display the available options for 
local key assignment.  The options are to allow local key assignment to 
overwrite the selected key or to disallow local key assignment to 
overwrite the selected key. This permits the system administrator to 
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limit the keys a panel operator can overwrite when locally assigning 
keys by Fast Key Assign (V-Series only) or by Local Key Assignment 
(on panels supporting this facility).

Interlock Group
The EHX user can assign several keys on a panel into a selector group 
and restrict the group so that only one key of the group can be activate 
at any one time.  This function only refers to talk paths. 

For example if a panel had five keys programmed to talk to cameras 1 
to 5 then by setting these into an interlocked group only one camera 
key can be selected at a time.

There are nine available interlocked groups to which the EHX user can 
assign any or all panel keys.  

The interlock groups are specific to the panel they are programmed for 
and do not affect interlock groups that may be set up on any other 
panel in the system.

To add a key to an interlocked group

1. From Panel Programming, select the desired panel. 
2. Right click on the desired key to display the key options list.
3. Select the ‘Interlock Group’ entry to display the interlock group 

options list.
4. Select the required interlock group or ‘None’ if the key is not to be in 

any interlock group.
5. The key may be added to other interlock groups as required.
6. The key interlock groups will be displayed in the key information 

popup.

Figure 7-34: I-Series Interlock Group Assignment

Local Advanced Latch Disable
When the mouse pointer is over this entry a second menu is displayed 
giving the options to set Local Advanced Latch Disable to On or Off.  
Select and click on the required option.  This performs the same 
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function as ‘Latch Disable’ in the Local Advanced facility.  It will allow 
or disallow a panel to latch a key to another device.

Go To Key Destination
Click the ‘Go To Key Destination’ entry to display the editor screen for 
the type of destination the key refers to.  For example if the destination 
is a panel then the panel will be displayed on the ‘Panels’ screen; for a 
partyline key the ‘Partylines’ editor will be displayed with the partyline 
highlighted.

Delete Key
Click the ‘Delete Key’ entry in the menu to delete the assigned label 
(shown highlighted).

I-SERIES ADVANCED FUNCTIONS
The I-Series operates in one of four modes: 

• COM mode is the default mode. In this mode the I-Series panel 
operates as a simple panel. Talk labels are assigned to 
destinations, and listen labels are assigned to sources. 

• IFB mode allows the I-Series to assign a program audio source or 
sources to an IFB Global destination. For example “on-the-air”  
audio can be assigned to the “talent” or announcer in a television 
studio application. It is called “IFB mode” because the program 
audio source that is routed to the IFB destination can be 
“interrupted” by an incoming intercom call to the IFB destination.

• PL mode allows the panel operator to add and delete members of a 
partyline directly from the panel. 

• FG mode allows the panel operator to add and remove members of a 
fixed group directly from the panel. 

For more details of how to use the I-Series advanced functions, see 
the I-Series Panels User Guide.

USING EHX TO SET UP I-SERIES FIXED GROUP 
MEMBERSHIP OPTIONS
A “fixed group” occurs when one source needs to call many 
destinations at one time. The panel operator can add and remove 
members of a fixed group in real time with the I-Series provided that 
the feature has been enabled in EHX.

To enable the feature in EHX
1. Open the required map configuration in EHX. 
2. From Cards and Ports screen, select the required panel. 
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3. Select Port Properties > AP Panel Options > Fixed Group 
Assignment. Click the drop-down box to turn the feature on or off. 
• When the check box reads “true” the feature is on. 

• When the check box reads “false” the feature is off. 

4. From Panel Programming, select the panel to which the I-Series is 
connected, and immediately below it, select the I-Series panel. 

5. Assign the fixed group source as a “talk” key on the I-Series panel 
on screen.  

6. Assign potential fixed group “members” as “listen” keys on the 
I-Series panel on the screen.  

7. From the Eclipse HX Downloads menu, click Apply and Reset. 
EHX uploads the information to the I-Series panel. 

USING EHX TO SET UP I-SERIES IFB OPTIONS 
After a program audio source has been attached to a matrix port, the 
EHX operator can assign the audio source to an IFB destination with 
the I-Series Assignment Panel in panel programming.

To assign an audio source to an IFB destination
1. In ’Cards and Ports’ select the I-Series panel. 

Note: Highlight the entire row when selecting the panel. 

2. Go to Port Properties > AP Panel Options > IFB assignment. 
Select True (the box is checked). 

3. From Panel Programming, select the I-Series panel. 
4. Assign the IFB “destination” as a “talk” label.
5. Assign the IFB “source” or “sources” as a  “listen” label. 
6. Click Apply Label Changes from the Eclipse HX Download menu to 

send information to the matrix. 

USING EHX TO SET UP I-SERIES PARTYLINE 
MEMBERSHIP OPTIONS
The panel operator can add and remove members of a partyline in real 
time with the I-Series provided this feature has been enabled in EHX.  

To enable the feature in EHX
1. Open the required map configuration in EHX. 
2. From the ’Cards and Ports’ screen, select the desired panel. 

The Advanced Settings screen opens. 

3. From Port Properties, select Partyline Assignment from I-Series AP 
Panel Options. Click the drop-down box to turn the feature on or off. 
• When the check box reads “true” the feature is on. 

• When the check box reads “false” the feature is off. 

4. From Panel Programming select the I-Series panel. 
5. Assign the partyline as a “talk” key on the on screen I-Series panel. 
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6. Assign potential partyline “members” as “listen” keys on the on 
screen I-Series panel. 

7. From the Eclipse Downloads menu, click Apply and Reset. 
EHX uploads the information to the I-Series panel. 

I-SERIES PANEL OPTIONS
This functionality is limited to the current configuration and ‘label sets’ 
can not be transferred between configurations.  The options for panel 
Save, Load, Copy, Paste, Upload and Clear are provided on the panel 
configuration toolbar above the panel mimic.

Page
Displays a list of  pages for the panel as a drop-down list.  Click the 
required page to update the mimic to the page.

Save
Clicking the ‘Save’ button on the Panel Programming toolbar will 
display the label file save dialog.

Enter the name of the file which will default to the .ccl extension.  The 
keys from all pages are saved (including shift pages where supported) 
but the keys from any expansion panels that may be fitted are not 
saved in the file.

Expansion panel labels must be saved separately.

Load
Clicking the ‘Load’ button on the Panel Programming toolbar to display 
the dialog for selecting and opening a panel label (.ccl) file. 

Select the required file and click ‘Open’ to load the labels from the file.  
When a label load is performed all the labels on a panel (including shift 
pages) and cleared before the new labels are applied.  

If the type of panel being loaded is not the same as the type of panel 
the label file was saved from this may result in labels being lost when 
the panel is loaded.

Copy
Click Copy on the Panel Programming toolbar to copy the labels of the 
current panel page only into the scratch pad.  You cannot copy labels 
from expansion panels.
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Paste
Clicking the ‘Paste’ button on the Panel Programming toolbar will paste 
the labels copied to the scratch pad onto the currently selected panel.  
All the labels currently on the page will be lost. This allows single 
pages of labels to be pasted on to the panel.

If the type of panel being pasted to is not the same as the type of panel 
the labels were copied from this may result in labels being lost when 
the labels are pasted onto the new panel.

Clear
Clicking ‘Clear’ on the Panel Programming toolbar will clear all the 
labels from the current panel including shift pages but excluding any 
attached expansion panels.

Audio Mixer
Displays the audio mixer panel that allows the levels of individual 
crosspoints to be adjusted interactively.  This facility can only be used 
with V-Series panels.

Identify Panel
Selecting the ‘Identify Panel’ button on the panel programming toolbar 
will cause the panel currently being edited to flash the panel buttons or 
LEDs red and display ‘IDENTIFYME’ in the bottom left display.  This 
facility is only available for V-Series panels; the ‘Identify Panel’ button 
will be greyed out for other panel types.

FAST KEY ASSIGN RESTRICTIONS (I-SERIES) 
The I-Series Advanced Settings area, located on the rightmost side of 
’Cards and Ports’ offers three Soft Menu Restrictions: 

• Dial Phone Mode Access 

• Information Mode Access

• Key Assign Mode Access

By default the panel operator has access to these options from an 
I-Series, but if the check box for any of these options is cleared the 
panel operator will not be able to access that menus from the I-Series 
front panel. 

USING EHX TO SET UP ASSIGNMENT PANEL 
PARTYLINE MEMBERSHIP OPTIONS
The panel operator can add and remove members of a partyline in real 
time from an assignment panel provided this feature has been enabled 
for the panel in EHX. 
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To enable the feature in EHX
1. Open the required map configuration in EHX. 
2. From the ‘Cards and Ports’ screen, select the desired panel.  
3. From Port Properties, select Partyline Assignment from AP Panel 

Options. Click the drop-down box to turn the feature on or off. 
• When the check box reads “true” the feature is on. 

• When the check box reads “false” the feature is off. 

4. From ‘Panels’ in the Configuration menu select the required panel or 
the panel to which the AP22 is connected.

5. Assign the partyline as a “talk” key on the on panel. 
6. Assign potential partyline “members” as “listen” keys on the on 

screen panel.
7. From the Eclipse HX Downloads menu, click Apply and Reset. 

EHX uploads the information to the panel. 

USING EHX TO SET UP ASSIGNMENT PANEL FIXED 
GROUP MEMBERSHIP OPTIONS
A “fixed group” occurs when one source needs to call many 
destinations at one time. Members of a fixed group may be added or 
removed by the panel operator in real time with the assignment panel 
provided this feature is enabled for the panel in EHX.To enable the 
feature in EHX
1. Open the required map configuration in EHX. 
2. From the ‘Cards and ports’ screen, select the required panel.
3. From Port Properties, select Fixed Group Assignment from AP 

Panel Options. Click the drop-down box to turn the feature on or off. 
• When the check box reads “true” the feature is on. 

• When the check box reads “false” the feature is off. 

4. From ‘Panels’ in the Configuration menu select the required panel or 
the panel to which the AP22 is connected.  If the AP22 is to be 
configured select the AP22 panel in the list of expansion panels to 
the right of the main panel list.

5. Assign the fixed group source as a “talk” key on the assignment 
panel on screen.  

6. Assign potential fixed group “members” as “listen” keys on the 
assignment panel on the screen.  

7. From the Eclipse HX Downloads menu, click Apply and Reset. 
EHX uploads the information to the assignment panel. 
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KEEP HIDDEN KEYS ACTIVE (I-SERIES PAN-
ELS) 
In Advanced Settings for I-Series panels the EHX operator can select 
the “Keep Hidden Keys Active” option.  When this option is selected, 
audio paths from an I-Series panel’s main page are maintained even 
when the panel operator switches to the shift (swap) page. 

Clear the check box to turn off this option. if this option is disabled the 
audio paths from the main page are cut when the panel operator 
switches to the swap page. 

This option is not selected by default. 
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GENERAL PANEL SETUPS

STACKED KEYS
Stacked Keys functionality is the ability to add more than one Talk label 
to a single selector of an intercom panel. 

Figure 7-35: Stacked Keys Screen

CREATING A STACKED KEY
1. To create a stacked key, open the Panel Programming screen.
2. Select the panel where the stacked key is to be created
3. Either programme a Talk label to the panel or identify a Talk label 

that has already been programmed onto the panel.
4. On the mimic of the panel, place the mouse cursor over the required 

Talk label.
5. Double click the Talk label.
6. The Talk Label appears in the Stacked Key area (the bottom right 

window).
7. Drag the mouse cursor over to the Talk Labels window
8. Click the required Label
9. In the Stacked Key window, select the ‘Add Label’ button.
10. Repeat steps 7 to 9 for the required amount of Labels.

Figure 7-36: Stacked Key Label Order
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The order of the labels on the stacked key will run from the last 
(bottom) key in the list to the first (topmost) key in the list.

REMOVING LABELS FROM A STACKED KEY

Figure 7-37: Remove Label from Stacked Key

1. Double click the Stacked Key on the mimic of the panel using the left 
mouse button. The Stacked Key window displays all labels on the 
stack.

2. Click the label to be removed.
3. Click the Remove Label context box to remove the label.
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PALETTE OPTIONS
You can customise the appearance of the Palette. 
1. Select Configure Palette. The Palette Options appear on the upper 

left side of the screen. The following options are available:

• Sort By Port Number - sorts entities by port number.

• Sort By Label - sorts entities by label

• Group By Frame - groups entities by frame first, then by entity 
type.

• Group By Type - groups entities by type first, then by frame.

• Show Descriptions - shows the entity description.

• Show Port Numbers - shows the entity port number.

2. Select or deselect each option, as required.
3. Select Apply. You will return to the Palette.

KEY ASSIGNMENT
You can specify how entities are assigned to panel keys.
1. Select Configure Palette. The Assign Keys options appear on the 

lower left of the screen. The following options are available:

• On Double Click - double click an entity to assign it to the first 
free key on the panel. To determine the assignment mode, see 
“Default Assignment Mode” on page 37.

• On Right Click Menu - right click an entity to display a menu. The 
menu displays the appropriate assignment types for the panel.

• On Keyboard Enter - When searching entities, press Enter to 
assign the first search result to the first free key on the panel. To 
determine the assignment mode, see “Default Assignment Mode” 
on page 37.

2. Select or deselect each option, as required.
3. Select Apply. You will return to the Palette.
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DEFAULT ASSIGNMENT MODE
This option determines the key type for entities that are assigned to 
panel keys using:

• Select Unique Search Result

• Assign Keys on Double Click

• Assign Keys on Keyboard Enter

1. Select Configure Palette.
2. In the lower left of the screen, select the Default Assignment Mode 

list.
3. Select from the following options:

• Talk - sets a talk from the panel to a destination with no automatic 
listen to the destination.

• Listen - sets a key to listen to the source without talking to the 
destination at the same time.

• Talk and Listen - sets a talk key with listen.

• Dual Talk and Listen - sets a dual talk and listen key (only on 
pushbutton panel types).  This make the pushbutton activate a 
TALK on a press and hold and LISTEN with a short press on the 
same pushbutton.

• Forced Listen - sets a key with permanently made listen.

• Talk and forced Listen - sets a talk key with permanently made 
listen.

4. Select Apply. You will return to the Palette.

SELECT UNIQUE SEARCH RESULT
This option automatically selects a search item, if that item is the only 
search result.
1. Select Configure Palette.

Select or deselect the Select Unique Search Result option as 
required. To determine the assignment mode, see “Default Assignment 
Mode” on page 37.

ENTITY SEARCHING
It is possible to search the list of entities using the Search box at the 
top left of the Palette. Use an asterisk (*) to denote a wild character.
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ENTITY FILTERING
It is possible to select which entities appear in Panel Programming 
Screen. To do so:
1. Select Configure Palette from the top of the Palette.

2. From the middle of the screen, deselect any entity types or frames 
that you do not wish to appear in the palette.

Note: Select the red checkmark in the top right of the screen to clear 
the entity filters.

3. Select Apply. You will return to the Palette.

Quick Filtering
It is also possible to access the entity filters by using the Quick Filters 
option. To do so:
1. Select Entity Types from the top of the palette. The filters appear as 

a row at the top of the Palette.
2. Click on any filter to select it.

Note: You can select more than one entity filter by pressing the 
Control key and then selecting the entities.

3. Select Frames from the top of the palette. The frames appear as a 
row at the top of the palette.

4. Click on any frame to select it.

Note: You can select more than one frame by pressing the Control 
key and then selecting the frames.
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LOCAL ADVANCED
The Local Advanced screen sets functions that determine how every 
panel and interface in the system will interact with each other at the 
device level.  For example IFB levels can be set for every individual 
device or Forced Listen can be enabled or disabled between any two 
specific system devices.

To open the Local Advanced screen select the ‘Local Advanced’ entry 
in the Configuration menu.

The configured devices are displayed to form a grid with each square 
displaying the attributes set for interactions between the devices as a 
colored dot or empty if the attributes are not set.  Tabs on the toolbar 
allow the specific attributes to be selected.  Positioning the mouse 
pointer over a square will display a tooltip indicating the current status.

A key to the meaning of the colored dots that indicate status is shown 
in the top left hand corner of the Local Advanced screen.  The Sources 
are listed down the left hand side and the Destinations are listed 
across the top.

Figure 7-38: Local Advanced Functions

 The type of  source/destination is denoted by the color of the entry.  
These are:
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• Pink - Panel

• Yellow - Partyline

• Purple - Interface (Direct, FOR-22, Telephone, TEL-14, CCI-22)

• Blue - Fixed Group

• Green - Control

The tabs allow the grid to be displayed for the various properties of the 
connections (such as Forced Listen, Latch Disable etc). 

Selecting one of the tabs will display a grid with sources and 
destinations which may have this property and the status of any 
connection between them.  For example, selecting the ‘Blocked Listen’ 
tab will only display panels and interfaces to which this property can 
apply.  Where the property is enabled a colored dot will be displayed in 
the square; red for local property assignment, black for global property 
assignment.

The items along the top (destinations) can be filtered by name using 
the text filter box on the right hand side of the EHX Control Bar.  

Figure 7-39: Source Filter

Enter the text to filter by and click on the filter icon to the right of the 
filter box left filter icon).  Only the destinations with names containing 
the filter text will be displayed on the top row.  The sources are not 
filtered.  To turn off filtering click on the rightmost of the two filter icons.

Text Filter Box Filter
On

Filter
Off
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Figure 7-40: Multiple Select Display

By holding down the Control key whilst selecting the tabs, it is possible 
to select multiple tabs.  In this case any  squares representing 
connections will be colored red if any of the select properties are set.

Note: Only local settings are displayed when multiple tabs are 
selected; global settings are not shown.

When the mouse pointer is positioned over one of the squares of the 
grid a tooltip will give details of the connection.

Note: By not touching the mouse the tooltip remains on the 
screen.
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Figure 7-41: Local Advanced Information Display

1. Place the pointer over the square that intersects the required source 
and destination.

The tooltip will display the current properties.

2. Click the square. The square will turn blue and the source and 
destination label backgrounds will change to white.

3. To set or clear the current property (for example, Latch Disable) 
right-click the mouse to display the On/Off options. 

Use the pointer to select the required state and right-click or left-click 
on it to select it. 

A red dot will be displayed in the square if the function has been 
enabled in local mode.

Note: By holding down the Control key when assigning 
connection properties it is possible to move from square to 
square and make multiple selections with a single mouse 
click.  If the Shift key is held down a block of connections 
can be assigned by clicking on limits of the required block 
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selecting all the points between the limits.  This allows large 
numbers of connections to be set very quickly.

Figure 7-42: Local Advanced with a Property Selected

The following is a description of each option.  Every option does not 
appear for every combination of source and destination.

The possible options are described below.

FORCED LISTEN
A forced listen is a permanently enabled audio path between a source 
and a destination that can only be interrupted by IFB/ISO calls.  It 
doesn’t have any association with a selector key.

If panel eavesdropping is disabled for a panel, the forced listen will not 
be effective until the panel has at least one talk path set.  Panel 
eavesdropping is enabled from the Advanced Settings screen of 
’Cards and Ports’ for the source port.  Forced listen audio is routed 
from the label on the left to the label on the top.
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BLOCKED LISTEN
If a listen is blocked between two ports then an audio path from that 
same source to that destination cannot be set under any 
circumstances.  This is primarily used as a safety feature.  For 
example, to prevent one studio’s program feed from being accidentally 
routed to a destination in another studio.

LATCH DISABLE
This function prevents talks to any label from latching.  If a 
latch-disabled label is assigned to a selector key, the key can only 
access the label for as long as the operator physically holds down the 
key.  A latch-disabled port’s label can be included in a fixed group or 
partyline without automatically latch disabling the entire fixed group or 
partyline.

LOCAL ISO
This function enables a panel or interface as a local ISO destination of 
the source panel or interface.  When the source activates a talk to any 
of its local ISO destinations, that talk is a private, two-way path.  All 
other talk paths from the source are interrupted.  All existing talk and 
listen paths between the source and the destination are interrupted, 
except for other ISO talk paths.  When the source terminates the talk, 
the destination’s audio paths resume; when all ISO paths to the 
destination are deactivated, the destination’s audio paths return to their 
previous states.  If more than one panel activates an ISO path to the 
destination, both sources can talk and listen to the destination.  For 
ISO talks to also interrupt listens at the source, check the ISO 
Interrupts All Other Listens box in the Matrix Frame Preferences ‘ISO 
and IFB’ tab.

Note: If the destination of an ISO is a panel then ‘Eavesdropping’ 
must be enabled in Global Settings (Advanced Settings 
section) in order to activate the panel microphone if it is not 
already activated.  If the destination is not a panel but a 
device such as a four-wire port Eavesdropping does not 
need to be enabled for the destination device.

LOCAL IFB
This function enables a panel or interface as a local IFB destination of 
the source panel or interface.  When the source activates a talk to one 
of its local IFB destinations, that talk is a private, one-way path.  All 
existing talk and listen paths to the destination are interrupted, except 
for other IFB talk paths.  When the source terminates the talk, its audio 
paths resume; when all IFB talks to the destination are deactivated, the 
destination’s audio paths return to their previous states.  If more than 
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one panel activates IFB talks to the same destination, both sources will 
be heard by the destination.  For IFB talks to also interrupt talks at the 
source, select the IFB Interrupts All Other Talks From Source Panels 
button in the ‘Matrix Frame Preferences’ screen from the System 
screen.

Note: The level of the interrupt can be set using Local Advanced.

ROUTE MONITOR
Enable monitoring of an audio route.  This creates a key that is 
available for assignment from Panel Programming.   When the key is 
pressed, audio from the required crosspoint is routed to the panel with 
the key.

This allows panel C to monitor audio between ports A and B when 
Route Monitoring between A and B is enabled.

MUTE RELAY
This function enables a specific interface label to activate the source 
panel’s mute relay when the talk key for that interface is activated.  The 
mute relay is a general purpose relay whose contacts are connected to 
the Miscellaneous DB-15M connector on the panel’s rear panel.  It is 
commonly used to mute a control room monitor speaker, but it can also 
be put to other uses, such as turning on a light or unlocking a door.

PRESET TALK
This option enables setting preset talk paths from this port to any other 
destination in either the local or a remote system.

Preset talks are similar to routes, except they can be configured to 
activate only when a call signal is received at this port from an external 
device, such as a radio or telephone or external partyline (CCI-22).

PRESET LISTEN
This options enables setting preset listen paths from this port to any 
other destination in either the local or a remote system.  Preset listens 
are similar to routes, except they can be configured to activate only 
when a call signal is received at this port from an external device, such 
as a radio or telephone.

PRESET CALL
Preset Call is used to send a call signal to a group or a port on either 
the local system or a remote system. 

A panel receives the call as an incoming call tally but without the audio. 
If Audible Alerts is set for the panel, then the panel receives three 
beeps at either its loud speaker or headset speaker.
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If the source interface is a TEL-14 telephone module, and Auto Answer 
is set to off, then the call signal is repeated every time a ring signal is 
received.

If the destination is a CCI-22 or FOR-22 module, the output is driven 
high during the call signal.

Call signal to a TEL-14
To enable an audible warning when a call is made from an external 
telephone to the TEL-14 module, set Local Advanced > Preset Call.

Call signal tones must also be enabled at the destination panel in the 
Cards and Ports screen.

While the phone is ringing, a call signal is sent to the panel. Call signal 
tones are sent to the panel every time a pulse is received from the 
TEL-14. The label for the TEL-14 port is placed in the Answerback 
stack of the panel, and an incoming call tally is displayed on both the 
Reply key and any configured key to that port. 

NEARBY PANELS
This function is used to prevent audio feedback ("howlround") between 
panels located physically nearby each other. When enabled, audio 
from the source panel is prevented from reaching the destination 
panel, and signalization is also suppressed. The advanced setting 
"Nearby Panel Partial" in ’Cards and Ports’ can be used to route audio 
from nearby panels to the headset rather than suppressing it.
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AUDIO MIXER

INTRODUCTION TO AUDIO MIXER
The Audio Mixer facility is accessed from panel programming and is 
only available for V-Series panels.  The Audio Mixer allows the audio 
input, output and crosspoint levels for the panel to be set by the use of 
the panel controls (main and auxiliary volume controls) or via the panel 
software.  The audio mixer will also allow audio input levels to be 
modified by means of threshold levels and compressors and for 
frequency based noise reduction filters to be applied.  Crosspoints 
which are attached to IFB controls can also have the IFB dim levels set 
by the audio mixer.

The layout of the audio mixer is determined by the panel interface 
selected; for some types of interface such as the D25 connector more 
options are available than with the basic RJ45 interface. 

When the pointer is moved over the panel tooltips will be displayed 
whenever it is over an active item such as a button on the toolbar, a 
filter setting or a crosspoint.  The tooltip will display the current setting 
of any audio processing element.

AUDIO MIXER PANEL
The audio mixer panel is divided into three functional areas, Input, 
Crosspoint and Output.  Each area has separate controls that function 
idependently of controls in other areas.  For example the controls in 
the input area will act on the input audio stream before it passes to the 
crosspoints.

The audio mixer areas are shown in Figure 8-1 below.

8
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Figure 8-1: Audio Mixer Panel

The audio mixer toolbar provides facilities to apply, save or configure 
the audio mixer.

SAVE TO EHX CONFIGURATION AND EXIT
Click on this button to save the audio mixer setup to the current EHX 
configuration.  When in Online mode clicking on this button will also 
save the audio mixer settings into the current EHX configuration.  After 
the setup has been saved the audio mixer will automatically exit back 
to panel programming.

ONLINE MODE
Clicking on this button allows audio mixer settings to be sent to the 
panel immediately without the need to save to the  configuration and 
download a new map. 

When the Online button is pressed it will flash amber/green and the 
mixer pane background will change to amber while EHX contacts the 
matrix and uploads the current audio settings for the selected panel.  If 
the button and audio mixer pane background remain amber (see 
Figure 8-2 below) this indicates that EHX was unable to obtain the 
current panel audio settings from the matrix (the panel may not be 
connected to the matrix).

It may take a few seconds for EHX to obtain the panel details from the 
matrix.
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Figure 8-2: Online Mode Waiting for Reply

When the settings have been loaded the button and audio mixer pane 
background will turn green to indicate that the settings may be 
adjusted (see Figure 8-3 ).

Figure 8-3: Online Mode Connected and Ready

Whenever a setting is changed in Online mode it will be sent to the 
matrix to be applied to the panel and a confirmation will be returned.  
While EHX is waiting for confirmation that the change has been 
applied the online button will change to amber and then to green when 
confirmation is received.
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RESTORE TO DEFAULT VALUES
Click on this button to reset all the mixer settings for the current layout 
to their default values.  The user will be asked to confirm the request.  
Click on ‘Yes’ to replace the current settings with the default settings or 
‘No’ to cancel the action.  This option can also be used when in online 
mode.

SAVE TO FILE
Saves the audio mixer settings to a file.  The file save dialogue will 
request a file name.  If no filename extension is given it will default to 
“amc”.  This feature is available when in online mode.

LOAD FROM FILE
Loads audio mixer settings from a file previously created by the file 
save function.  If this function is used in online mode the settings in the 
file will be sent straight to the panel.

LAYOUT SETTINGS
Clicking on this button displays a drop-down menu of layout options.  
These options configure the audio mixer for V-Series panels that have 
their audio connected in different ways such as the Matrix port, the 
25-way D-type auxiliary audio and the AES3 interface.

Note: The layout cannot be changed while in online mode.

Layout Basic Settings
This configures the audio mixer for the panel when using the RJ-45 
analogue matrix connection.

Layout Basic Settings using D25
This configures the audio mixer for use with the analogue RJ-45 and  
auxiliary audio connectors.

Layout Binaural coax/AES
This configures the audio mixer for use with the AES3 digital option 
card.  The AES3 option card has both RJ-45 and coax connectors and 
will auto-detect which is in use.  This option will apply regardless of 
which connection on the AES3 card is used.
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Layout Binaural coax/AES using D25
This configures the audio mixer for use with the AES3 digital option 
card and the auxiliary audio connector.  The AES3 option card has 
both RJ-45 and coax connectors and will auto-detect which is in use.  
This option will apply regardless of which connection on the AES3 card 
is used.

INPUT AREA
This area contains a list of all the available audio sources and five 
columns for processes that can be applied to the audio before it is sent 
to the crosspoint audio mixers.  Any processing applied at this point 
will affect the audio supplied to all the downstream mixing.

AUDIO INPUTS
The first column in the input area lists all the inputs that may be 
available in the configuration.  All of the possible inputs are listed 
below but some inputs may not be available depending on which 
input/output interface options have been selected.

HS1 Mic GN
This input takes audio from the headset1 microphone or gooseneck 
microphone.

HS2 Mic
This input takes audio from the headset2 microphone.

Matrix1
This input takes mono audio from the analogue matrix connection if the 
Basic Layout is being used or one channel of stereo audio from the 
AES3 digital option card if this is fitted.

Matrix2
This input takes a second channel of stereo audio from the AES3 
digital option card.  This input is only available if the AES3 digital option  
is fitted.

Ext1
This input uses the External Input 1 on the auxiliary audio connector.

Ext2
This input uses the External Input 2 on the auxiliary audio connector.
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Listen Again
This input uses audio from the listen again facility.

FILTER
The filter column shows a graphic representing the type of audio 
filtering that is being applied to the audio inputs.  The graphic 
represents the frequency profile of the input filters.

OUTPUT AREA
The top row of the output area lists all the outputs that may be 
available in the configuration.  All of the possible outputs are listed 
below but some outputs may not be available in specific 
configurations.

Main LS
This outputs audio to the main panel loudspeaker.

Aux o/p
This outputs audio to the auxiliary loudspeaker via the auxiliary audio  
connector.

Matrix1
This output sends either mono audio to the matrix via the analogue 
matrix connection or one channel of stereo audio to the matrix via the 
AES3 digital connection.

Matrix2
This output sends one channel of stereo audio to the matrix via the 
AES3 digital matrix connection.  This output is only available if the 
AES3 digital option card is fitted.

HS1L
This output sends audio to the main panel headset left ear.

HS1R
This output sends audio to the main panel headset right ear.

HS2L
This output sends audio to the second headset left ear via the auxiliary 
audio connector.
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HS2R
This output sends audio to the second headset right ear via the 
auxiliary audio connector.

Ext1
This sends audio output to the first external output via the auxiliary 
audio connector.

Ext2
This sends audio output to the second external output via the auxiliary 
audio connector.

Hot Mic
This sends audio output to the hot mic output via the auxiliary audio 
connector.

Voicerec
This output sends audio to the Listen Again voice recording facility.

FILTER SETTINGS
The filters are applied to input audio streams to remove extraneous 
noise from the audio before it is sent to the mixer.  There are two types 
of filter; the “Low Pass” filter and the “High Pass” filter.

The Low Pass filter will pass low frequencies and is used to remove 
high frequency noise such as wind noise while the High Pass filter will 
pass high frequencies and is used to remove low frequency  noise 
such as machinery.

Each filter has four possible settings; off, filter 1, filter 2 and filter 3.
1. Off - no noise filtering is done.
2. Filter 1 - uses the first noise filtering algorithm. 
3. Filter 2 - uses the second noise filtering algorithm. 
4. Filter 3 - uses the third noise filtering algorithm

The frequency filters have the following effects:

High Pass 1 - reduces audio volume below 120Hz.

High Pass 2 - reduces audio volume below 250Hz

High Pass 3 - reduces audio volume below 500Hz

Low Pass 1 - reduces audio volume above 8KHz

Low Pass 2 - reduces audio volume above12KHz

Low Pass 3 - reduces audio volume above 15KHz
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The filter configuration is shown using a graphic of the frequency 
against level.

Figure 8-4: Audio Mixer Filter Settings

If the mouse pointer is placed over the filter graphic a tooltip will be 
displayed giving additional information on the filter settings.

LIMITER/THRESHOLD/COMPRESSOR
These settings are all linked together and provide a facility for 
controlling the overall level of the input audio.  The settings will allow 
the audio level to be limited to a maximum and audio above a 
threshold level to be modified as it approaches the maximum 
permissable level.

Figure 8-5: Audio Level Compression
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Limiter
This sets the maximum audio level on the input that will be passed to 
further stages of the audio mixer.  The limiter settings are:

•  Off

• -6dB

• -8db

Threshold
The threshold setting determines the level at which audio compression 
starts.  When the audio input level passes the threshold it begins to be 
compressed so that the output level from the compressor approaches 
the audio limit more slowly as the audio input level rises.  The 
threshold settings are:

•   Off

• -10dB

• -20dB

Compressor
The audio compressor reduces the audio level by compressing it 
whenever the audio level exceeds the threshold.  Thishas the effect of 
allowing the audio level to rise but reducing it by a fixed ratio.  The 
compressor settings are:

• Off

• Compression 5:1

• Compression 3:1

For example, if the compressor is set to 5:1 with a threshold of -10dB 
this will have the effect that for every 5dB increase in the input level 
above the threshold of -10dB the compressor will output only 1dB of 
increase.  Thus if the input audio is 20dB above the threshold the 
output from the compressor will only show an increase of 4dB.  If the 
limiter was set to +6dB then a 20dB increase would normally exceed 
the limiter (-10dB + 20dB = 10dB) so the audio level would be cut off at 
+6dB.  With the compressor the audio level would not reach the limit so  
the audio would still rise to mimic the input (-10dB + 4dB = -6dB).
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Figure 8-6: Audio Compression

INPUT TRIM
The input trim sets the amount by which the output from the filter and 
compressor is modified before it is fed to the audio crosspoints.  It is 
displayed as a color coded dial indicating the trim action.  To set the 
trim right click over the dial to display the list of preset trim levels.

Figure 8-7: Input Trim

If the dial is colored blue then no trim (0dB) is being applied.  If the dial 
is green then a negative trim is being applied to reduce the audio level.  
If the dial is red then a positive trim is being applied to increase the 
audio level.
8
 Clear-Com®
EHX User Guide

- 1 0



CROSSPOINTS
The crosspoint area of the audio mixer displays all the crosspoints 
available for the current configuration and the status of the crosspoint.

Each crosspoint allows individual setting of the input and output audio 
between the audio source in the input section and the Asia destination 
in the output section.  Each crosspoint is displayed as a dial with color 
coding to show the status of the crosspoint.  The color codes are:

• Grey - crosspoint is muted so no audio passes through the 
crosspoint.

• Blue - audio level gain is set to 0dB or controlled by a volume 
knob.

• Green - audio level is reduced in the crosspoint (gain level is 
negative e.g. -3dB).

• Red - audio level is increased in the crosspoint (gain level is 
positive e.g. +3dB).

• Blank - no crosspoint.

The center of the dial is also color coded when appropriate to indicate 
whether the audio level is being controlled by software only or by the 
panel volume controls.  The settings are:

No colored center - audio levels are set in software only.

White center -  audio level is set by main volume control knob.

Mauve center - audio level is set by auxiliary volume control knob.

Figure 8-8: Audio Mixer Crosspoint

Right clicking on a crosspoint dial will display a list of options for setting 
the crosspoint.
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Figure 8-9: Crosspoint Settings

If an additional yellow ring is displayed on the crosspoint dial this 
indicates that the crosspoint is also used by an IFB.  If the IFB is 
activated the audio output from the crosspoint mixer is reduced 
(dimmed) by the specified amount.

Figure 8-10: Crosspoint with IFB

The colored segment in the outer dial indicates the dim setting for the 
IFB (the amount by which the source audio is dimmed when the IFB 
control is activated). This is set by right-clicking on the dial and 
selecting the required IFB level.  The IFB is activated using a control 
set up in Control Manager.
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Figure 8-11: Setting IFB Dim on Crosspoint

The level settings from +12dB to -30dB represent the levels set for 
audio through the crosspoint and Mute will stop all audio through the 
crosspoint.  Below this are the IFB dim levels from 0dB to -30dB and 
Mute (IFB completely interrupts audio feed).

Setting Up IFBs in Imported Configurations
When a EHX 4.2 map is imported the IFB control information V-Series 
panels is lost due to changes in the way the configuration data is 
organized.  In order to restore the IFBs and restore the control 
information the following steps should be carried out.
1. Open Panel Programming from the Configuration menu.
2. Select the V-Series panel that the IFB control was originally attached 

to.
3. Open the audio mixer.  
4. Use the audio mixer to set the IFB dimming for EXT1 and EXT2 

crosspoints as required.  This action will create Panel IFB relays 
IFB1 and IFB2 for that panel.

5. Close the audio mixer.
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6. Open the Control Manager.
7. Select the ‘Panel IFB relays’ tab.  The available IFBs will be 

displayed.
8. Select a control or create a new control.
9. Use the control manager to attach the IFB to the control.
10. Close the control manager.
11. In panel programming the control is now available under the 

‘Controls’ tab to be assigned to a key on the panel in the normal 
way.

OUTPUT AREA
The output area contains trim controllers for individual outputs 
displayed as dials.  When these are set whatever audio is being sent to 
the output will be changed by the specified amount.  As before right 
clicking the dial will display the audio settings available for that output.  
The dials are color coded to indicate the trim applied as described for 
the crosspoint.

Figure 8-12: Output Settings
8
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ONLINE MODE

INTRODUCTION TO ONLINE MODE
Online mode is a mode that allows changes to be made to the 
configuration of a live system without the need to download a new 
configuration. The new configuration is held in the matrix and even if 
the matrix is reset the modified configuration will be preserved rather 
than defaulting back to the original configuration map. 

The changes are not automatically added to the system configuration 
controlled by EHX until the modified configuration is saved either by 
clicking on the ‘Save’ button in the File menu on exiting Online mode, 
by downloading a map to the matrix or by exiting EHX and selecting 
‘Yes’ to save the configuration.

Online mode allows:

• The labels on a key (including beltpacks) to be added, deleted or 
moved in Panel Programming.

• Forced Listen and Blocked Listens to be updated in Local 
Advanced. 

The functions which can be used in Online mode are indicated by 
green color-coding of the menu entries and button text.  

However there is an important limitation when using Online mode on 
linked systems. If a label refers to a source or destination on a remote 
matrix (a matrix linked to the current matrix) it cannot be assigned in 
Online mode unless it is already present in the current map being 
modified.  In order for such a label to be present in a configuration it 
must have been assigned at least once and then downloaded as part 
of a map.

In this way it will be recognized by the matrix if it is assigned in Online 
mode.  Local sources and destinations (on the current matrix) can be 
assigned for the first time in Online mode provided they have already 
been set up in the current map.  For example a local Party Line cannot 
be created in Online mode but it can be assigned to a key for the first 
time in Online mode. 

If a remote source or destination is assigned to a key for the first time 
in Online mode the label will initially be displayed in the panel mimic 
and then disappear as the matrix will reject the assignment request.  
Further information on this limitation is given later in this chapter.

Online mode operates in a completely live mode so that as soon as a 
change is made in EHX the configuration in the matrix is updated. If a 
label on a key is changed for example, the panel affected is updated 
without any further user intervention. 

9
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EHX is notified of any changes that are made online, as a 
consequence of this, if EHX running on any other PC which is also 
configuring the same matrix and in Online mode it will also be updated 
with the changes. Therefore it is possible for more than one EHX to be 
editing a configuration with each change being displayed on all the 
copies of EHX connected and in Online mode. However this mode of 
operation is not recommended due to the risk of the different copies of 
the configuration diverging later if one of the instances of EHX ceases 
to be online.

Figure 9-1: Online Update Sequence

ENTERING ONLINE MODE
Select the ‘Online’ link in the ‘System’ menu to open a drop-down 
menu of online mode options.  

Figure 9-2: Online Mode Options

The online modes have the following effects:

• No Merge - go online without merging the current EHX 
configuration with the current matrix configuration.

• Merge Down - merge the current EHX configuration down to the 
matrix; the EHX configuration will take precedence.

To enter Online mode 
select the ‘Online’ 
button on the EHX 
toolbar.
9
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• Merge Up - merge the current matrix configuration up to EHX; the 
matrix configuration will take precedence.

• Visual Merge - merge the configurations and offer the operator the 
option to decide which configuration takes precedence in the 
event of a conflict.

If the name of the configuration on the matrix is different to the 
configuration currently open in EHX Online mode will display an error 
message.

The user may continue with the operation by clicking on the ‘Yes’ 
button but it is generally not advisable.  If the user does continue with 
the operation further errors may be reported.

EHX will then compare the matrix configuration with the current EHX 
configuration.  If inconsistencies are found between the current 
configuration in EHX and the information from the matrix informatory 
messages will be displayed.

EHX will display any differences between the current configuration 
open in EHX and the information from the matrix.  For example, if a key 
is present on a panel in the EHX configuration but not in the matrix 
configuration then it will be reported as a difference.  

The same approach will apply to forced and blocked listens.

Beltpacks and panels attached to the matrix that are offline or 
disconnected are not considered when EHX is checking for differences 
between the matrix configuration and the EHX configuration.

The user will be given the following options if the configurations cannot 
be merged:

• Upload ‘On Frame’ into EHX - overwrite the configuration in EHX 
with the current matrix configuration.

• Download ‘In EHX’ to frame - overwrite the configuration in the 
matrix with the current EHX configuration.

• Export - export the Online mode error report as a text file for 
analysis.

• Cancel - Cancel the Online operation and exit Online mode.

A number of conditions can cause the online merge to report errors.  
The most common conditions are:

• Panels present in the EHX configuration but not in the matrix 
configuration.

• Panels present on the matrix but not in the EHX configuration.

• Panels with locally assigned keys that are different to the keys set 
up in the EHX configuration.

In general merge errors arise when there are mismatches in the 
configuration through offline assignments in EHX or online 
assignments through a panel. The online error report that can be 
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exported from EHX should be used to resolve conflicts if it is not 
desirable to overwrite either the EHX configuration or the matrix 
configuration.

If the matrix configuration appears to merge without errors being 
reported but there are apparent changes in areas such as panel 
programming the user should check whether the map in EHX has been 
imported but not downloaded before entering Online mode.

Once the configurations have been synchronized the background on 
the menu pane will turn green and online editing of panel setups may 
be carried out.  The Online button will now display Go Offline.

USING ONLINE MODE
In the example below keys are assigned to a panel in Online mode to 
take immediate effect.

Figure 9-3: Panel Programming Display with Online Active

If the keys are changed on this panel the changes will be sent to the 
matrix and then on to the panel. The matrix will return a confirmation to 
EHX that the panel has been updated.

Forced and blocked listens on crosspoints in Local Advanced can also 
be set or cleared using Online mode.  It should be noted that the 
Forced Listens shown in Local Advanced can be IFB sources.  

As with panel labels these changes will take immediate effect.
9
 Clear-Com®
EHX User Guide

- 4



Figure 9-4: Local Advanced Display with Online Active

ONLINE LIMITATIONS
Online mode provides much of the functionality of Panel Programming 
but it cannot be used to create new entities; this must be done in EHX. 
Specifically Online mode cannot:

• Create or edit a Party Line.

• Create or edit a Fixed Group.

• Create or edit a Control.

• Create a Talk and Forced Listen key.

• Create the first remote key to a Fixed Group.

• Create the first remote key to a Party Line.

• Create the first remote key to a Control.

• Create a stacked key.

Also, as noted previously Online cannot assign a label that refers to a 
remote system unless it is already present in the current map.  In order 
for such a label to be present in a configuration it must have been 
assigned at least once and then downloaded as part of a map.  In this 
way it will be recognized by the matrix if it is assigned in Online mode.  
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EXITING ONLINE MODE
To exit Online mode, click Go Offline. 

The background color of the menu pane returns to gray.  The button 
text changes to Go Online.

At this point the configuration on EHX and on the matrix should be 
synchronized but the configuration will not be saved in the database at 
this point.  The configuration on the matrix will be preserved in 
non-volatile memory in the event of a power failure but it will be lost if a 
new configuration is downloaded.  Therefore it is highly recommended  
that after a configuration is updated in Online mode it should be saved 
in EHX either to the current project or as a new project to ensure that 
the changes are preserved.

Online mode can also be ended as a result of other actions that force 
EHX out of this online mode. 

Possible actions include:

• Changing to a different configuration while online. This action 
causes EHX to drop the connection to the matrix.

• Closing the current project without exiting online mode first.

• Selecting ‘Apply Changes’ to download a new map to the matrix. 

• A physical reset of the matrix. In this case as well as dropping 
online mode the background of the menu pane will turn red to 
indicate that the connection to the matrix has been lost.

• Loss of the ethernet connection to the matrix.  As with a reset the 
menu pane background will change to red to indicate that the 
connection has been lost.
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NETWORKING

NETWORK SYSTEM CONFIGURATION
Using the layout pane, the EHX operator can create, delete, or edit 
matrices for a particular matrix system. From this screen the EHX 
operator can also  allocate configurations to Eclipse HX matrices, clear 
configurations and upload active current configurations. 

The layout screen also allows the management of Intelligent Linking 
Trunks. This is explained in the Intelligent Linking section of this 
manual.

CONFIGURATION PASSWORDS
Individual configurations can be password protected to prevent 
unintended or unauthorized changes to be made or the configuration 
to be downloaded to a matrix. 

To set the password on the current configuration select the matrix on 
the layout pane, and open the Configuration Manager.

Figure 10-1: Opening the Configuration Manager

Once the Configuration Manager is open the properties of any of the 
available configurations (on that frame) can be viewed and edited.
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Figure 10-2: Configuration Properties Dialog

To set or change the password for a configuration type the password 
into the ‘Password’ field and then retype in the ‘Confirm password’ 
field. Then click on the ‘Update Details’ to add the password to the 
configuration. The configuration must be saved and closed before the 
password becomes operative.

EHX users with Admin rights can always open a configuration 
regardless of whether a password has been set and reset the 
password if required.  If an EHX user without Admin rights opens a 
password protected configuration they will be asked for the password.

 

Figure 10-3: Configuration Password Entry

The correct password must be entered to open the configuration.  
Once the configuration has been opened by an EHX user with User 
rights that user may then change or remove the password.

The configuration password may be removed by opening the 
configuration properties and clearing both the ‘Password’ and ‘Confirm 
password’ fields and then saving the configuration. The next time the 
configuration is opened it will no longer be password protected.
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USING THE LAYOUT PANE
The layout pane is accessed from the EHX menu pane. Below is a 
description of each option. The commands available to the user will 
depend on whether the user has Admin rights.

Figure 10-4: System Screen

Matrix Status
The matrix icons in the layout pane are colored according to the status 
of the matrices:

• Amber - the EHX configuration is not the same as the current matrix 
configuration.

• Red - wrong firmware on matrix for current version of EHX.

• Grey - matrix unavailable or already connected to EHX.

• Green - matrix is connected and available.

Protocols and Port Numbers
The Eclipse HX system components (matrix and EHX) communicate 
using UDP and TCP protocols.

Rack to rack 

The volume of traffic both exchanged rack to rack and rack to/from 
EHX is not large, there are however of course some points when this is 
at a peak.  The racks use both directed and broadcast UDP traffic to 
communicate. 
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Broadcast: UDP Port 42001

Directed: UDP Port 42001

Rack to EHX 

UDP Port 1300 

TCP Port 2048 to TCP Port 2055 inclusive (Lifetime of out of sequence 
packets 1 sec).

ALLOCATING A CONFIGURATION TO A MATRIX
To allocate a configuration to a matrix:

1. Select the matrix by clicking over the matrix icon on the layout pane.  
The matrix will be highlighted with a green border.

2. Click Tools > Configuration Bank on the EHX toolbar to open the 
menu listing the configuration slots available (normally four). Select 
the bank for the configuration.

3. Right-click the matrix to open the menu and select Configuration > 
Configuration Manager.

4. In Configuration Manager, select the configuration to be applied to 
the matrix and then click on the ‘Activate’ button to apply the 
configuration to the matrix.

5. Close the Configuration Manager. The name of the selected 
configuration will be displayed on the matrix.

DELETING A MATRIX FROM THE PROJECT
To delete a matrix from the layout pane:

1. Right-click the matrix. 

2. From the context menu, select Delete Matrix Frame from Project. 

The matrix is deleted from the current project and removed from the 
layout pane.
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UPLOADING THE LAST DOWNLOADED 
CONFIGURATION FROM THE MATRIX
To upload the last downloaded configuration from the matrix:
1. Right-click on the matrix.

2.  From the context menu, select Configuration > Upload 
Configuration from Matrix Frame. 

The last downloaded configuration will be uploaded and added to 
the currently selected slot on the matrix.

Note: The Upload Configuration functionality is not available over 
a serial connection between the Eclipse HX  matrix and the 
EHX PC.

INTELLIGENT LINKING (TRUNKING)
As many as 64 separate Eclipse HX-Omega, Eclipse HX-Median, 
Eclipse HX-Delta and Eclipse HX-PiCo system frames can be 
intelligently linked, using dedicated audio trunk lines and an Ethernet 
network. Audio travels between the matrices on the dedicated trunk 
lines, while control data travels on the Ethernet network.

You can intelligently link Eclipse HX matrices using:

• Fiber-optic connections (using E-FIB fiber cards).

• Four-wire connections (using MVX-A16 analog cards).

• E1/T1 connections (using E-QUE cards).

• MADI connections (using E-MADI64 cards).

Note:
Fiber, E1/T1 and MADI linking is available to Eclipse HX-Omega, 
Eclipse HX-Median and Eclipse HX-Delta matrices only.

You can intelligently link Eclipse HX-PiCo matrices using:

• Four-wire connections.

• The PiCo-link to PiCo-link.

Note:
PiCo-link is only available for Eclipse HX-PiCo to Eclipse HX-PiCo 
connections. The PiCo-link does not support hopping.

The sections below on Fiber trunking and Four-wire trunking provide a 
basic overview of the intelligent linking process. For detailed 
information about intelligent linking, see:

• The relevant matrix frame user guide.

• The Eclipse HX Installation Guide.
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Fiber Trunking
To enable fiber trunking, you must install and configure E-FIB fiber 
cards in the matrices you want to connect.

Fiber trunked matrix frames are normally connected in a ring 
configuration. An example connection layout (the IP addresses 
increment to match the system numbers) is shown below.

Figure 10-5: Fiber Connections

An example of matrices with trunks is shown below.

Figure 10-6: Trunk Connections

System 1

172.20.73.16

System 2

172.20.73.17

System 4

172.20.73.19

System 3

172.20.73.18
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Four-Wire Trunks
To configure four-wire trunks:

1. Open Hardware > Cards and Ports, then select the MVX card on 
the first matrix frame where the trunks are to be configured.

2. Configure the required ports as Trunks.

3. Switch to the MVX card on the second matrix frame, and configure 
the required ports as Trunks.

4. On the layout pane, ensure that the required systems layout is open.

The systems layout should be automatically updated with the trunk 
information on both frames. The trunks have been added to the 
bottom of each frame and the port number should be shown.

  

5. To apply the configuration changes, Select Apply changes To 
System in the System menu.

6. Open the File menu and select Save project or Save Project As to 
save the updated project.

Note:
User-configured trunk labels are ignored in Online mode and the 
default labels should be accepted.

When changing the trunking information between frames all of the 
frames in the linked set should be reset.  The option to reset frames is 
available from the download dialog.

PROGRAMMING REMOTE LABELS
To program remote labels onto panels, open Configuration > Panels.

From the Panel Programming area of the screen select the required 
panel to be programmed by either selecting the panel from the drop 
down list or cycling through the panels by selecting the left or right 
arrows.

Keys are assigned in the normal way by clicking on the required item in 
the list of available labels then dragging the items to the required key 
and dropping them over the display corresponding to the key and 
clicking on the mouse to confirm the assignment.

Once the labels have been programmed onto the required panel or 
panels, download the changes by selecting the ‘Apply Changes To 
System’ link in the System menu. The newly programmed labels 
should appear in the required positions.
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To program labels onto the next matrix frame, switch between the 
configurations by selecting the required frame from the layout pane.

REMOTE FIXED GROUPS
Remote Members from one system can be added to a Fixed Group of 
a local system.

To configure a remote member to a local Fixed group the following 
should be followed:

1. Select ‘Fixed Groups’ from the ‘Configuration’ menu.
2. Create a Fixed Group by clicking on the ‘New’ button.
3. Enter the Talk and Listen labels for the new Fixed Group and a 

description if required.
4. Set up the properties of the new Fixed Group using the properties 

dialogue in the ‘Properties’ pane.

Figure 10-7: Remote Fixed Groups

5. Select the members of the group from the ‘Available’ pane and click 
on the ‘>’ button to transfer them to the ‘Attached’ pane.  They are 
now members of the group. To remove members from the group 
select them in the ‘Attached’ pane and click on the ‘<‘ to transfer 
them back to the ‘Available’ pane.

6. Click on the ‘Apply Changes to Frame’ button to download the new 
map to the frame immediately or close the ‘Fixed Groups’ dialogue if 
other changes are to be made.

Note: The available members area will be filtered according to the 
active frame filters, but the attached area will always show 
all attached members, even if their frames are filtered out.
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REMOTE PARTYLINES
To add remote partyline embers from one system to the partyline of a 
local system:
1. Select ‘Partylines’ from the ‘Configuration’ menu.
2. Create a partyline by clicking on the ‘New’ button.
3. Enter the Talk and Listen labels for the new partyline and a 

description if required.
4. Set up the properties of the new partyline using the properties dialog 

in the ‘Properties’ pane.

Figure 10-8: Remote Partyline

5. Select the members of the partyline from the ‘Available’ pane and 
click on the ‘>’ button to transfer them to the ‘Attached’ pane.  They 
are now members of the partyline.  To remove members from the 
partyline select them in the ‘Attached’ pane and click on the ‘<‘ to 
transfer them back to the ‘Available’ pane.

6. Click Apply Changes to download the new map to the frame 
immediately or close the Partyline dialog if other changes are to be 
made.

Note: The available members area will be filtered according to the 
active frame filters, but the attached area will always show 
all attached members, even if their frames are filtered out.
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REMOTE 2-WAY RADIO
If a 2-way radio system if connected via a FOR-22, the 2-Way Radio 
can operate over an intelligently linked system. 

To configure a remote 2-way radio the following steps should be 
followed:

1. Create a control. Attach the relay for the FOR-22, and set the control 
as a secondary action on the FOR-22.

2. Apply and reset the first frame.

3. Switch frames, and open Panels > Remote Interfaces. Locate the 
remote 2-way radio.

4. Program the 2-way radio onto the required panel and click Apply 
Label Changes.

REMOTE TELEPHONE
Remote Telephone functionality enables a TEL-14 telephone module 
to be configured on one system and be available for use on another 
system. To make a remote telephone call, DTMF tone generation is 
required. 

An Eclipse HX user panel (V-Series or I-Series) can make remote calls 
both manually (using the dial pad) and through speed dials.

Tip: For more information about setting up and using the TEL-14 
module, see the TEL-14 manual. For more information about user 
panels, see the V-Series User Guide and the I-Series manual. 

REMOTE MANUAL DIAL
User panels can manually dial a remote telephone, using the dial pad. 
The panel registers as a dialler to the telephone as soon as the panel 
starts dialling the telephone through the dial pad.

When the panel comes out of dial mode (ends the call), registration to 
the telephone port is released.

Note:
Only one port at a time (local or remote) can dial the telephone.
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REMOTE SPEED DIAL
To set up a speed dial to a remote telephone between two linked 
frames:

1. Open the Panels screen and locate the telephone interface in the 
label palette.

2. Program the telephone interface onto any required panel(s).

3. In Controls, select the control for the speed dial and program next 
to the telephone interface.

4. Activate a talk for the telephone.

5. Activate the speed dial (make the call).

Alternatively:

1. Set-up telephone and speed dial as above.

1. Switch frames.

2. Program the telephone interface onto any required panels.

3. Double click the talk label to the telephone interface.

4. Select controls and click on the speed dial control.

5. Add to the stacked key area.

6. Download to the frame. Activating the talk to the telephone will 
operate the speed dial and the call will be made.

Tip: For more information about speed dials, see Configuring the 
Eclipse HX System > Speed Dials in this guide.

OFF HOOK AND OFF HOOK TALLY
If a talk route is made to that telephone port from either a local or a 
remote system the telephone is automatically placed off-hook.

Note:
The telephone port must be set to Auto-Signal. 

The off hook tally state of a telephone port is broadcast to all the 
systems in a linked set. 

To check if the telephone port has been configured as an off hook tally,  
see the entity table. 
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AUTO LISTEN
In Eclipse HX v7.1, you can set Auto Listen for ports on both the local 
frame and remote frames.

If a remote port on a matrix frame has Auto Listen set, any talk path 
made to it from anywhere in the system will have a return listen route 
made.

REMOTE CONTROLS
Controls from one system are made available for use in another 
system.

To configure remote controls:

1. Create the required controls on a local system.

2. Select Save Linked Configurations.

Figure 10-9: Remote Controls

3. Switch frames.

4. Open Panels. Select the Controls tab in the labels section of the 
window.
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Figure 10-10: Controls on a Panel

5. A complete list of controls is displayed. Locate the required control.

6. Program onto any required panel, using drag and drop.

7. Download to the frame.

REMOTE SECONDARY ACTIONS
Other functionality implemented is the remote secondary action where 
a control can be attached to a label as a secondary action.  
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CLIENT SERVER

CLIENT/SERVER OPERATION
Client/Server operation enables multiple clients to share and download 
configurations to one or more matrices using a central server which 
runs EHX.

The application ensures that while a user is editing a configuration, 
other users are prohibited from also making edits to the same 
configuration.

If client/server operation is being used then all the EHX PCs on the 
network should be configured to run in this mode.

Figure 11-1: EHX Client Server Wiring

CLIENT
EHX must be installed on each client that is used to make edits to 
configurations or update racks. The user chooses the server to use 
when logging in as EHX starts up. The server distinguishes between 
clients by Username.
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SERVER
The server controls all communications between the clients and the 
matrices.  The server stores all of the projects and ensures that when 
one configuration is being edited by a client, no other client can edit 
that configuration at the same time. 

The server must also be running IIS (Internet Information Services - a 
web server provided by Microsoft).

The EHX server provides the 'back-end' services, such as 
map-building, configuration sharing, and access to the matrices. 
Clients access the server with an Ethernet connection.

INITIAL SETUP
The following steps need to be completed in the specified order:
1. Install and configure IIS on the server system.
2. Install EHX server.
3. Install EHX on each client PC.
4. Configure each client PC to access the server.
5. Login to the Server from a client machine.

Note:
The default installation path is assumed to be C:\Program 
Files\ClearCom\Eclipse HX Configuration Server 7.1\

Installing and Configuring IIS on the Server

Stage 1 - Verify IIS is installed

To verify that IIS has been installed:

1. Go to the Windows Control Panel.

2. Double click Administrative Tools.

3. Verify Internet Information Services exists and is at version 5.0 or 
above.
 
Note:
For more information about the options that are not selected by 
default, but which must be enabled for EHX to run successfully, see 
IIS Options that must be enabled below.

If IIS does not exist on the server, complete Stage 1b. Otherwise, 
proceed to Stage 2.
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Stage 1b - Install IIS

To install IIS:

1. Open the Windows Control Panel.

2. Double click Add or Remove Programs.

3. Click the Add/Remove Windows Components tab. The OS 
installation CD-ROM may be required.

4. Select Internet Information Services and complete the install 
using the wizard.

Note:
For more information about the options that are not selected by 
default, but which must be enabled for EHX to run successfully, see 
IIS Options that must be enabled below.

IIS Options that must be enabled
When installing Internet Information Services, there are certain options 
which are not selected by default, and that must be enabled in order to 
allow EHX to run successfully. (You can select any other options in 
addition to these, without risk to the installation).

Windows XP

In Windows XP:
1. Go to Control Panel.

2. Select Add Or Remove Programs.

3. Click Add/Remove Windows Components on the left hand side of 
the window.

4. Under Internet Information Services, click Details and make sure 
the following options are enabled:

• Common Files.

• Internet Information Services Snap-In.

• World Wide Web Service.

• Scripts virtual directory

• World Wide Web Service.
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Windows Vista

In Windows Vista:

1. Go to Control Panel.

2. Select Programs and Features.

3. Click 'Turn Windows Features on or off' on the left hand side of 
the window.

4. Under Internet Information Services, make sure the following 
options are enabled:

• Web Management Tools

• IIS 6 Management Compatibility

• IIS 6 Management Console

• IIS6 Scripting Tools

• IIS6 WMI Compatibility

• IIS Metabase and IIS6 configuration compatibility

• IIS Management Console

• World Wide Web Services

• Application Development Features

• Net Extensibility

• ASP.NET

• ISAPI Extensions

• ISAPI Filters

• Common HTTP Features

• Default Document

• Directory Browsing

• HTTP Errors

• Static Content

• Performance Features

• Static Content Compression

• Security

• Basic Authentication

• Windows Authentication
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5. Under Microsoft .Net Framework 3.0, make sure the following 
options are enabled:

• Windows Communication Foundation HTTP Activation

• Windows Communication Foundation Non-HTTP Activation

Windows 7

In Windows 7:

1. Go to Control Panel.

2. Select Programs > Turn Windows features on or off.

3. Under Internet Information Services, make sure the following 
options are enabled:

• Web Management Tools

• IIS 6 Management Compatibility

• IIS 6 Management Console

• IIS6 Scripting Tools

• IIS6 WMI Compatibility

• IIS Metabase and IIS6 configuration compatibility

• IIS Management Console

• World Wide Web Services

• Application Development Features

• Net Extensibility

• ASP.NET

• ISAPI Extensions

• ISAPI Filters

• Common HTTP Features

• Default Document

• Directory Browsing

• HTTP Errors

• Static Content

• Performance Features

• Static Content Compression

• Security

• Basic Authentication

• Windows Authentication
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4. Under Microsoft .Net Framework 3.0, make sure the following 
options are enabled:

• Windows Communication Foundation HTTP Activation

• Windows Communication Foundation Non-HTTP Activation

Windows Server 2003

In Windows Server 2003:

1. Go to Manage Your Server.

2. Click Add or Remove a Role.

3. Select Application Server (IIS) and click Next.

4. Confirm that you wish to install the Application Server.

Windows Server 2008

In Windows Server 2008:

1. Go to Server Manager.

2. Click Add Roles.

3. Select Web server (IIS) and click Next.

4. Under Role Services, ensure the following options are enabled:

• Web Management Tools

• IIS 6 Management Compatibility

• IIS 6 Management Console

• IIS6 Scripting Tools

• IIS6 WMI Compatibility

• IIS Metabase and IIS6 configuration compatibility

• IIS Management Console

• World Wide Web Services

• Application Development Features

• Net Extensibility

• ASP.NET

• ISAPI Extensions

• ISAPI Filters
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• Common HTTP Features

• Default Document

• Directory Browsing

• HTTP Errors

• Static Content

• Performance Features

• Static Content Compression

• Security

• Basic Authentication

• Windows Authentication

5. From Server Manager, click Add Features.

6. Ensure that the following features are enabled:

• Net Framework 3.5.1 Features

• Net Framework 3.5.1

• WCF Activation

• HTTP Activation

• Non-HTTP Activation

Windows 8
1. Go to Control Panel
2. Select Programs > Turn Windows features on or off
3. Under Internet Information Services, make sure the following 

options are enabled:
- Web Management Tools

                - IIS 6 Management Compatibility

                                - IIS 6 Management Console

                                - IIS 6 Scripting Tools

                                - IIS 6 WMI Compatibility

                                - IIS Metabase and IIS 6 configuration compatibility

                - IIS Management Console

                - IIS Management Scripts and Tools
- World Wide Web Services

                - Application Development Features

                                - .NET Extensibility 3.5

                                - .NET Extensibility 4.5
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                                - ASP.NET 3.5

                                - ASP.NET 4.5

                                - ISAPI Extensions

                                - ISAPI Filters

                - Common HTTP Features

                                - Default Document

                                - Directory Browsing

                                - HTTP Errors

                                - Static Content

                - Performance Features

                                - Static Content Compression

                - Security

                                - Basic Authentication

                                - Windows Authentication

4. Under .NET Framework 3.5 (includes .Net 2.0 and 3.0)
- Windows Communication Foundation HTTP Activation
- Windows Communication Foundation Non-HTTP Activation

5. Under .NET Framework 4.5 Advanced Services
                - ASP.NET 4.5
                - WCF Services
                                - HTTP Activation
                                - Message Queuing (MSMQ) Activation
                                - Named Pipe Activation
                                - TCP Activation
                                - TCP Port Sharing

Stage 2 - Install EHX Server

Install EHX Server (Run the EHX server installation *.exe file). 

For Windows XP, Windows Vista and Windows 7 systems, .Net 
Framework should automatically be configured in IIS.
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Client Configuration
An EHX client installation is required on each client system.

Login to the Server from a Client machine
1. At the EHX login dialog box click the Options button to display the 

'Log on to' field.
2. Type the following string, replacing <Machine Name> with the name 

of the EHX server: “http://<Machine Name>/EclipseServer/”.

The client must able to connect to the server in order to login. If it 
cannot connect an appropriate error will be displayed. This problem 
may even be encountered in the case where the client is on the same 
machine as the server when the machine is not connected to the 
network.

If the access to the server is required with the machine in this state, 
setting the EHX server as “http://127.0.0.1/EclipseServer/” will allow 
this (this is using the network loopback address).

Figure 11-2: EHX Client Log in

Note: To determine the EHX Server Machine Name log in to the 
EHX Server. Click Start  and then Run.  Type 'cmd' into the 
box and click ok. At the command prompt type 'ipconfig 
/all'.  Use the listed Host Name as the EHX server name.
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Using Client/Server

Username

Each user is distinguished by Username and users on different clients 
should always use different Usernames when logging in to the EHX 
Server.

Usernames on the EHX server are set up by logging in to the EHX 
Server and using the User Management facility as described in chapter 
3 to set up and manage users.

If a user on a client attempts to log in to the EHX Server with a 
Username that is already in use a warning is shown. If the new user 
continues, the existing user session is terminated, and the user who 
has now been logged out is informed.

Host Name

When logging in to an EHX server running in client/server mode use 
the ‘Options’ button to display the server that the user is logging on to 
and enter the server name explicitly instead of using the default 
“localhost” name.
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ECLIPSE HX  
DOWNLOADS

When the EHX operator creates or edits a configuration, adds 
hardware to the system, or performs a variety of other functions the 
changes must be downloaded to the Eclipse HX system. The 
configuration can be downloaded either by:

• Selecting Tools > Apply Changes to Frame.

• Clicking Apply Changes from the context menu of the selected 
frame in the layout pane.

• Selecting Apply Changes to System in the System menu.

The first two methods of applying changes to the frame merge the new 
configuration with the existing configuration. They also enable the user 
to select the reset type.

The third method will only download a new configuration to the system.

APPLY CHANGES TO FRAME

Figure 12-1: Eclipse HX Downloads

When the download function is selected a dialog is displayed to 
confirm the action.
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Figure 12-2: Download Dialog

The “Merge” button allows the current EHX configuration to be merged 
with the rack configuration before download.  This facility should be 
used if the rack configuration has been changed as a result of making 
changes in EHX Online mode or from assignment panels.

In both cases these changes will not be reflected in the current EHX 
configuration and would be lost if a download was performed without 
first merging the configurations.  The merge button has the same effect 
as performing a merge in Online mode and will display the same 
informatory messages.

To continue with the download to the frame click the ‘OK’ button; to 
cancel the download click on ‘Cancel’

The options button displays a further dialog allowing the user to set up 
actions after the download.
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Figure 12-3: Apply Configuration to Matrix Frame Options

Select the required option (or options) and then click ‘OK’ to continue 
with the download. 

The configuration will be built and downloaded to the frame.

APPLY CHANGES WITH RESET (RED RESET)
If Apply changes with reset (to initialise new hardware or add 
trunks) is selected the download will reset the matrix and any 
crosspoints.Talk/Listen paths will be remade. 

This type of reset (also known as a Red reset) is required for: 

• Downloading completely new configurations 

• Hardware changes (not mandatory) 

• Any locally assigned keys will be cleared.

APPLY CHANGES WITH RESET AND CLEAR ALL 
MEMORY (BLACK RESET)
If Apply changes with reset and clear all memory (overwrite frame 
with EHX configuration) is selected, the download will clear down 
any active routes and reset the matrix to the EHX default configuration.  
Any local changes to groups, partylines or IFBs made through I-Series 
panels are reset to the EHX map default.
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This type of reset (also known as a Black reset) is used for:

• Correcting erroneous or spurious crosspoints.

• Any locally assigned keys will also be lost.

• Crosspoints - all active keys are reset to off.

• Crosspoint levels - all panel listen levels are rest to normal.

• Locally assigned keys - any locally assigned keys are deleted.

• Local panel microphone settings - all panel microphone settings 
are set to the EHX downloaded value.

• Local panel microphone gains- all panel microphone settings are 
set to the EHX downloaded value.

• Key status - all keys are unmade.

• Any local changes to groups, party lines and IFBs made through 
I-Series panels are reset to the EHX map default.

• Locally assigned fixed groups - all groups are reset to the EHX 
default.

• Locally assigned partylines -all partylines are reset to the EHX 
default.

• Locally assigned IFBs -all IFBs are reset to the EHX default.

• Locally assigned forced listens-all Forced listens are reset to the 
EHX default.

• Input levels - Matrix input levels are reset to the EHX download 
value.

• Output levels - Matrix output levels are reset to the EHX download 
value.

APPLY TO ALL FRAMES
Select this option if the EHX operator:

• Is making the first download of a new linked set.

• Has added or removed a Reserve Port.

• Has added a remote member to a partyline.

• Has added a remote key to a partyline.

• Has changed the Port Count for a fiber card.
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PRESERVING LOCALLY ASSIGNED KEYS
When a download is performed all the locally assigned keys (keys 
assigned from a panel rather than EHX) will be lost unless a merge 
operation is performed before the download.  If the user wishes to 
retain these keys in the new configuration the user should go into 
Online mode and merge the locally assigned keys with the new 
configuration before downloading and then save the modified project.

The configuration can then be downloaded with the locally assigned 
keys preserved in the new configuration.

APPLY CHANGES TO SYSTEM
System > Apply Changes to System downloads a configuration to all 
matrix frames in the system.

Figure 12-4: System Menu

Clicking this function opens the Apply to System dialog. The dialog 
includes reset options.
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Figure 12-5: Apply Changes to System Dialog

The reset options comprise:

• Apply with no reset. The configuration is applied without 
resetting the frames in the system.

• Apply and reset. The configuration and a red reset is applied to 
the frames after download (the matrices and any crosspoints are 
reset, and Talk/Listen paths are remade).

• Apply and reset, clearing all talk paths and listen levels. The 
configuration and a black reset is applied to the frames after 
download (the configuration is applied, the matrices are reset, 
and active routes and local assignments are cleared).

Select an option. To continue with the download, click Apply to 
System.
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USING THE 
DIAGNOSTIC TOOLS 

The Diagnostics menu displays information about the state of the 
system’s hardware and software operation that is useful for diagnosing 
and preventing problems. 

Tip: The Save Diagnostics Information utility (Help > Save 
Diagnostics Information) enables you to take a snapshot of the 
current state of your project, the EHX PC and the matrix frame(s), and 
store this information as a zip file on your computer. This information 
can then be sent to Clear-Com support to assist with the diagnosis of 
issues.

For more information, see Save Diagnostics Information Utility later 
in this chapter.

Figure 13-1: Diagnostics Menu

CROSSPOINT MAP 
The crosspoint map gives the EHX operator a visual display of all 
“crosspoints” or source-to-destination assignments in the matrix 
system. The crosspoint map is a graphical representation of all inputs 
and outputs in the system. 

This map can be used to identify talk and listen assignments, forced 
listens and  blocked listens. It can also be used to make or cancel 
crosspoints and to override input and output levels set up in the map.  

The grey triangles denote active crosspoints, pink half circles denote 
auto listen crosspoints, red crosses denote blocked listen crosspoints 
and green half circles denote forced listen crosspoints.

The crosspoint map displays both the labels and the port numbers the 
labels are associated with for ease of identification.

The diagnostic tools include 

crosspoint monitoring, event 

log monitoring, firmware 

downloading, and system 

monitoring. 
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The outputs are listed down the left hand side of the table with the 
output gain settings, while the inputs are listed along the top of the 
table with the input gain settings.

Figure 13-2: Crosspoint Monitor Display

The map gives the EHX user options to zoom in or out, producing 
clearer views of the map. Zoom can be done using Ctrl+ (zoom in) and 
Ctrl- (zoom out) using the keyboard or if a wheel mouse is available 
using Ctrl and the wheel to zoom.

Clicking on the ‘Refresh All Crosspoints’ button at the top of the 
crosspoint map requests the crosspoint information from the frame and 
uses it to update the crosspoint map.

When a input or output level is changed it will affect all the crosspoints 
that are connected to the port.  If an input level for a port is reduced the 
input level to all the crosspoints for that port will be reduced (all the 
crosspoints in the column below the level).  If an output level is 
changed all the crosspoints in that row will be affected.  Note that these 
levels only change the input and output levels for the ports; they do not 
change the crosspoint level settings.

Right clicking on an input or output setting (the cell next to the port 
information) will display a list of gain values.

Clicking a value in the list will set the input or output gain to the 
required level in the matrix.  This value will remain in force until it is 
either changed again using the Crosspoint Monitor or a new map is 
downloaded and the matrix is reset to the default values in the map.

If the matrix is only reset without a new map download the  modified 
values set up using the Crosspoint Monitor will remain in force.

The settable values are: +18, +15, 12, +9, +6, + 5, +4, +3, +2, +1, 0, -1, 
-2, -3, -4, -5, -6, -7, -8, -9, -10, -12, -14, -16, -20, -35, -45 and -72dB.

The current value can also be reset to the default value set up in EHX 
from this list.
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The crosspoint level cells are color coded to show whether the level is 
higher (red) or lower (green) than 0dB.

Figure 13-3: Input and Output Gain Settings

The default port gain may be set in EHX using the individual port 
settings on the Cards & Ports screen.  The setting will be downloaded 
to the matrix as part of the map and will displayed by the crosspoint 
monitor.  Right-clicking the port gain setting to display the gain levels 
will show this value as the default setting so the port may be reset to 
the EHX value at any time without a new map download and reset.

If the port gain is set to a non-zero level in EHX and then set to zero 
using the crosspoint monitor the gain will be shown highlighted in light 
blue to indicate that the zero value is not the default value in the map.
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By right clicking a cell representing a crosspoint a list of options is 
displayed.  To toggle a crosspoint from the ‘On’ state to the ‘Off’ state 
click on the ‘State’ option and then click on ‘Toggle’ in the next menu. 
Select the ‘Kill” option from the ‘State’ menu to clear a crosspoint 
completely.

Figure 13-4: Crosspoint State Options

To set the crosspoint level select the level option on the menu to 
display the crosspoint level slider and set the required level.

Figure 13-5: Crosspoint Level Slider

Select the ‘Refresh All’ option to update the display with the crosspoint 
settings current on the matrix.

CROSSPOINT SETTINGS AND AVERAGING
In some cases the same port may be placed on a panel as different  
key more than once, for example on different shift pages (multiple 
instances of the port).  If these instances of the port or keys have been 
set up with different audio levels then the level used on any of keys 
connected to the port will be the average of the levels of all the 
instances on the panel.  This is to prevent a situation where the audio 
level from the same port may vary greatly between different keys 
assigned to that port depending on how the different keys have been 
set up.
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To improve the performance of the level averaging on I-Series panels 
the crosspoint range for these panels is larger than previously.  The 
preset levels in the matrix for I-Series panels are:

•    -30.2 dB 

•    -24.1 dB

•    -18.1 dB

•    -12.1 dB

•    -9.2 dB

•    -6.0 dB

•    -3.9 dB

•    -2.1 dB

•    0 dB

•    1.1 dB

•    2.1 dB

•    3.2 dB

•    3.9 dB

•    6.0 dB

•    8.9 dB

•    12.1 dB

The range for V-Series panels is -42 dB to +12 dB.

MATRIX EVENT LOG
In Live mode, messages are displayed in the Matrix Event Log as soon 
as they are generated by the matrix.  In offline mode, EHX makes a 
connection to the database.  The user sets search criteria and the 
resulting messages are displayed on screen.

The Matrix Event Log gives the EHX user information about the state 
of the matrix that is helpful in diagnosing and repairing problems. 

The event types to be logged are selected in the ‘Properties’ pane by 
clicking on the required checkboxes.  The message types that can be 
selected for logging are Critical, Warning and Information.

The logging mode can be set to ‘Live’ to report current messages or 
‘Historic’ to display previous logged messages.  In ‘Historic’ mode the 
specific hour, minute, and second beginning and end dates to search 
can be set.  Click ‘Display’ when these parameters have been set to 
display the required log messages.
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Figure 13-6: Event Log

The log messages can also be exported to a file for further processing 
using the ‘Export’ option in the ‘Properties’ pane.

Note: The logging export file is an XML file and can be imported 
into Excel using the speech quotes (“) as the delimiter.

REQUEST INFO
Selecting “Request Info” in the Properties pane will display a “Request 
Matrix Information” screen which will allows a number of matrix 
parameters to be set or displayed.

Figure 13-7: Request Matrix Information
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Select the required function in the left pane and the click on the ‘Send’ 
button to send the request or update.

The default functions are described below.

Matrix Overview
Causes information about the current matrix status to be output to the 
matrix event log.

IP Address Dump
Outputs information on the current matrix IP address information to the 
event log.

Network Status Info
The current network status of the matrix is output to the matrix event 
log.

Comms Test
Initiates a network communications test.

Comms Test Results
Outputs the results of the last communications test performed to the 
matrix event log.

Ethernet Stats
Output the statistics of ethernet transactions logged such as packet 
losses etc to the matrix event log.

Change IP Address
This function allows the primary and secondary IP address of the 
target matrix to be set.  These addresses correspond to the LAN1 and 
LAN2 connectors on the rear of the CPU card (see the Eclipse 
HX-Omega, Eclipse HX-Median and Eclipse HX-Delta User Guides) or 
the Eclipse HX-PiCo unit (LAN 1 only).
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Figure 13-8: IP Address Setup Display

Select interface 1 or 2 (LAN1 or LAN2 port) and enter the required IP 
address, subnet mask and default gateway and click on ‘Send’ to 
update the matrix.  

Note: Changing the IP address parameters may result in the EHX 
PC losing contact with the matrix  and may require the 
ethernet configuration of the PC to be changed.

Custom
Allows request parameters to be entered manually for downloading to 
the matrix.

AUDIO ALERTS 
This option in the ‘Properties’ pane allows audio alert sounds to be set 
up for the three message types of Critical, Warning and Informatory.  
The audio alerts are .wav files and the default is the standard Windows 
media files.  The EHX operator may configure other sound files if 
required.

Click to select one or all of the following categories of messages to 
cause an audio alert from the EHX computer. 

• Critical 

• Warning

• Info

If no option is selected no event in this category of messages will 
cause an audio alert. 
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CHANGING MATRIX IP ADDRESS
It may be necessary to change the IP address of a matrix. The 
sequence of steps to change the IP address of a matrix via the event 
log is:
1. After starting EHX open the configuration.
2. Ensure that the PC is connected to the matrix via ethernet or a serial 

link.
3. Open Matrix Event Log from the Diagnostics menu (see the chapter  

“Using the Diagnostic Tools” for details on the Matrix Event Log).

Note: To display the Diagnostics menu at least one matrix must be 
configured on the layout pane.

4. To connect to the matrix, press Play.

Figure 13-9: Press Play to Connect to Matrix

5. When connection is established click on the 'Request Info' button 
which will be displayed beside the ‘Play’ icon.

Figure 13-10: Request Info Button
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6. Choose 'Change IP Address' from the list in the left hand pane and 
enter the desired values listed below.

Figure 13-11: IP Address Entry

• Select parameter 1 and enter the pin code.

• Select parameter 2 and enter interface 1 and then enter the LAN1 
port address.

• Select  parameter 2 and enter interface 2 and then enter the LAN2 
port address (Omega, Median and Delta matrix only).

• Select parameter 3 and enter the subnet mask.

• Select parameter 4 and enter the default gateway address

7. Click on ‘Send’ to update the matrix.
8. A message from the Matrix indicating that the change was 

successful will be seen in the log, and the matrix will reset.
9. Close Matrix Event Log, and open “My Systems”.
10. Change the IP address in My Systems to be the same as the new 

value in the matrix.
11. Press Save and Activate.
12. Note that it may be necessary to change the IP address and 

subnet mask of the PC if the new matrix IP address is from a 
different network range.
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SYSTEM MONITORING
System monitoring is started by selecting System > Monitoring.

Figure 13-12: System Menu

Monitoring displays all the frames in the current configuration and their 
status.

Figure 13-13: System Monitoring Screen

Color coding is used to indicate system status:

• Amber = Unable to communicate with the matrix frame.

• Red  = Errors reported from the matrix frame.

• Gray = The matrix frame is operating normally.
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When ‘Live Status’ on the system monitor toolbar is selected tabs for 
Panels, Beltpacks and Antennae are displayed.  Selecting these 
displays the status of all the devices of this type in the current 
configuration.

RESOURCE CHART
The Resource Chart allows you to view the system resources that 
would be used by your current configuration if it were to be 
downloaded to the matrix frame(s). 

When you build the current configuration for the Resource Chart, the 
system resources are displayed as a percentage of the maximum 
permitted value.

Color coding indicates the different usage levels:

• Green = Low usage.

• Amber = Medium usage.

• Red = High usage. 

Figure 13-14: Example resource chart
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SAVE DIAGNOSTICS INFORMATION UTILITY
The Save Diagnostics Information utility (Help > Save Diagnostics 
Information) enables you to take a snapshot of the current state of 
your configuration, the EHX PC and the matrix frame(s), and store this 
information as a compressed file on your computer. 

This information can then be sent to Clear-Com support  to assist with 
the diagnosis of issues. 

The following information is captured:

Information captured Description / comments

EHX version information

The version of EHX that is being run, 
the address of the server that EHX is 
connected to, and the operational 
mode of EHX  (Client-Only or 
Client-Server).

EHX Project (configuration) Exported as an *.hxn file.

EHX Database
A copy of the EHX database is 
provided, if available.

Frame information 

The name, ID, description and IP 
address of the matrix frames in the 
current project, along with details of 
their active configurations.

Firmware report(s)
A firmware report from each of the 
frames in the current project.

Configurations currently 
running on the frames 

Copies of the configurations that are 
currently running on the frames 
(achieved by performing an upload 
from each of the frames in the current 
project).

EHX PC system 
Information.

Basic system information concerning 
the EHX PC, including OS and 
hardware information.

EHX PC process 

information

Information about the processes that 
are currently running on the EHX PC.

TABLE 14-1: SAVE DIAGNOSTICS INFO UTILITY
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CLEAR UNUSED MEMORY
The .Net Framework used by EHX manages its own memory usage on 
the system, allocating and releasing memory when appropriate. In 
some circumstances, rather than release unused memory back to the 
operating system, it may choose to hold on to the memory allocation if 
it believes it will be used again in the near future. The "Clear Unused 
Memory" option under File->Help causes EHX to ask the .Net 
Framework to release any unused memory, even if it may be used in 
the future. In general, EHX and .Net will manage the memory 
allocation without any issues - this option should only be used if the 
user believes that EHX is "leaking" memory (i.e. progressively using 
more and more memory) and wishes to get a more accurate view of 
the memory usage.

EHX PC service information
Information about the services that are 
configured on the EHX PC.

EHX exception logs The exception logs from EHX

EHX event logs The ADM event logs from EHX

Frame diagnostics 

information

A dump of diagnostics information from 
the matrix frames (including system 
information, fiber allocation, IP and 
Ethernet usage, and task performance 
history)

Information captured Description / comments

TABLE 14-1: SAVE DIAGNOSTICS INFO UTILITY
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GLOSSARY

Analog Port Any of the Eclipse HX matrix’s analog input/output RJ-45 
connectors that are used to connect cable from the matrix to panels 
and interfaces. Each “port” connects to a separate audio channel in the 
matrix intercom system.

Alias label A label that is temporarily assigned and replaces a 
previously labeled port or conference.

Bus A bus is the channel or path between the components in the 
matrix along which electrical signals flow to carry information from one 
component to the next. In the Eclipse HX matrix the bus is located in 
the etched surface of the midplane.

Call Signal A call signal is an electronic signal sent from one panel or 
interface to another. A call signal can be audible and/or visual. 
Typically a call signal is sent to get the attention of a panel operator 
who may have turned down their intercom speaker’s volume or 
removed their headset. It can also be sent to activate an electronic 
relay.

Canvas The assignment area of Production Maestro which can have 
any user labeled background.

Category-5 cable EIA/TIA 568 category specification relating to 
network cabling. Shielded category-5 cabling is required for Eclipse 
HX matrix wiring.

CellCom Digital wireless communications product.  Sold under the 
CellCom name in USA and as FreeSpeak in Europe and Asia.

Central Matrix The term “central matrix” is used to differentiate the 
central hardware and software of the intercom system from the 
connected audio devices. The central matrix consists of:
1. The metal housing for the circuit cards and power supplies.
2. The circuit cards.
3. The power supplies.
4. The rear panel connectors which connect the matrix’s hardware to 

panels and interfaces.

Conference An internal matrix virtual party line or busbar where many 
panels and interfaces can talk onto or listen from the party line without 
talking to themselves.

Configuration. Determines the operating parameters of the Eclipse 
HX matrix system, including port functions, talk-and-listen audio 
routes, controls and other functions. Configurations are created and 
managed in EHX, for download to the matrix frame(s).  
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Destination A device such as an intercom panel, beltpack, or interface 
to which audio signals are sent. The device from which audio signals 
are sent is called a “source”.

Duplex All real-time communication between individuals talking face to 
face is full duplex, meaning that they can both talk and listen 
simultaneously. The Eclipse HX matrices provide full-duplex audio.

EHX Eclipse HX Configuration Software.  Software program that 
guides the operation of the central matrix circuit cards and connected 
panels.

Ethernet International standard which describes how information is 
transmitted across a network. Provides for the efficient organization of 
network components.

Fiber-optic Cable A fiber-optic cable consists of a glass core covered 
with a reflective material called “cladding” and several layers of buffer 
coating to protect the cable from the environment.  A laser sends light 
pulses through the glass core to the other end of the cable. 

FreeSpeak Digital wireless communications product.  Sold under the 
FreeSpeak name in Europe and Asia and CellCom name in USA.

Full Duplex Refers to transmission of signals in two directions 
simultaneously. 

IFB “Interruptible Foldback”. The term “foldback” refers to sending 
“program” audio, or some other audio mix, back to announcers while 
they are on the air.  Doing so allows announcers to monitor 
themselves, other announcers, videotapes of commercials, or some 
mix of sources, while they on the air. This is typically found in television 
news and live broadcast events.

Announcers typically wear a small ear piece so they can hear the 
selected foldback audio mix. When a director wants to give directions 
to an announcer on air, or to announce changes in the program, the 
director must “interrupt” the foldback. To do this, the director uses a 
channel specifically set up to interrupt the foldback audio.

Interface Module A piece of electronic hardware designed to convert 
the 4-wire signals of a central matrix port to some other form of 
communication, such as 2-wire party line, telephone, etc. The interface 
module is connected to a central matrix port. The external non-4-wire 
device is then connected to the interface module.

ISO The ISO function, short for “panel ISOlation”, allows a panel 
operator to call a destination and interrupt all of that destination’s other 
audio paths and establish a private conversation. When the call is  
completed the destination’s audio pathways are restored to their 
original state before the interruption.
1
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KeyGroup KeyGroups provide a way of assigning a label to multiple 
panels simultaneously even within a networked matrix system. Once 
the KeyGroups have been defined using EHX, all the keys within a 
KeyGroup can be changed with a single assignment in Production 
Maestro (Pro mode only).

Label A label is an alphanumeric name of up to five characters that 
identifies a source, destination, or control function accessed by an 
intercom panel. Labels appear in the displays of the intercom panel. 
Labels can identify panels, ports interfaced to other external 
equipment, fixed groups, party lines, and special control functions.

Multiplexing The process by which two or more signals are 
transmitted over a single communications channel. Examples include 
time division and wavelength division multiplexing. 

Non-volatile Memory Data stored in the CPU’s firmware (ROM) that 
is not lost when the power is turned off.

Palette The port, keyGroup and Monitor selection screen in Production 
Maestro.

Panel Also referred to as “station” in some cases (usually older 
manuals).  Any intelligent intercom device connected to the rear-panel 
analog ports of the central matrix. This term does not refer to devices 
connected through interface modules.

Partyline A wired shared communication system based on a single 
screened pair of wires.

Port Any of the input/output connections (RJ-45 connectors) on the 
back panel of the central matrix. These connectors and the attached 
cables connect the central matrix to remote intercom devices. The 
term “port” emphasizes that the connection is a “portal” between the 
central matrix and the remote intercom devices. 

Program Any separate audio source that is fed into the intercom 
channels. In television applications, for example, “program” audio is 
the audio that is broadcast on air.

Project. A project (stored and exported as an *.hxn file) provides a 
container for your configurations, and may comprise one or many 
configurations for one or many matrix frames. 

A project can be used to define every aspect of a complex intercom 
system, including the connectivity between multiple, intelligently linked 
matrices and/or the configurations for individual matrix frames.

Rack Unit or RU Standardized unit of mounting space on a rack panel. 
Each rack unit is 1.75 inches (44.45 mm) of vertical mounting space. 
Therefore 1 RU is 1.75 inches (44.45 mm) of vertical mounting space, 
2 RU is 3.5 inches (88.9 mm), 3 RU is 5.25 inches (133.35 mm), and 
so on.
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Remote Panel Any intelligent intercom device connected to the 
back-panel ports of the central matrix. This term does not refer to 
devices connected through interfaces.

Sidetone The sound of the panel operator’s own voice heard in their 
own earphone as they speak.

Source In this manual, the term “source” refers to a device—such as 
an intercom panel, interface, or beltpack —that sends audio into the 
matrix. The device to which audio is sent is called a “destination”.

VOX In the Eclipse HX system, when audio at a panel exceeds a 
threshold, a light switches on at the panel’s port card to visually cue the 
operator. The threshold level is set in the Eclipse HX Configuration 
Software.

V-Series Communications panels used with Eclipse HX systems 
providing advanced facilities.  Available in rack mount and desktop 
formats.
1
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LIMITED WARRANTY

This document details the Clear-Com Standard Limited Warranty for all new products for sale within all 
regions with the exception of Military, Aerospace, and Government (MAG).  

EXCEPT AS SET FORTH HEREIN ("LIMITED WARRANTY"), CLEAR-COM MAKES NO OTHER 
WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, INCLUDING WITHOUT LIMITATION ANY 
WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT OF THIRD PARTY RIGHTS, OR 
FITNESS FOR A PARTICULAR PURPOSE, ALL OF WHICH ARE EXPRESSLY DISCLAIMED.

1. Standard Limited Warranty.  Clear-Com warrants its products, including supplied accessories, 
against defects in material or workmanship for the time periods as set forth below provided it was 
purchased from an authorized Clear-Com dealer or distributor.  

a) Pursuant to this Limited Warranty, Clear-Com will, at its option:

i) repair the product using new or refurbished parts, or;

ii) replace the product with a new or refurbished product.

b) Remedies: In the event of a defect, the rights detailed in 1 (a) are your exclusive remedies.  For 
purposes of this Limited Warranty, "refurbished" means a product or part that has been returned 
to its original specifications.

c) Standard Warranty Period (by Product):

i) All Clear-Com brand systems and products, including belt packs, have a Limited Warranty 
of two years, with the exception of;

(1) Cables, accessories, components & consumable items have a Limited Warranty of 90 
days.

(2) Any Clear-Com product that has been classified as obsolete at the time of sale has a 
Limited Warranty of 90 days from sales and will be replaced with the same product or a 
sales credit will be issued, at the sole discretion of Clear-Com.

(3) Headsets, handsets, microphones, and associated spare parts, as well as UHF wireless 
IFB products, have a Limited Warranty of one year.

(4) UHF WBS Analog wireless intercom systems have a Limited Warranty of three years.
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(5) All software products, including Concert (Client and Server), ECS, Production Maestro 
and Logic Maestro are warranted for one year and shall substantially conform to 
published specifications.  The media on which the Software is furnished is warranted to 
be free of defects in material and workmanship (under normal use) for a period of one 
year.

(6) Any Clear-Com products that are listed within the last time buy period have the same 
Limited Warranty for their type 1.i 1 - 1.i.5 as above.

d) Any Clear-Com product that is repaired or supplied as a replacement under the terms of this 
Limited Warranty shall inherit the remaining warranty period from the original product.

e) Standard Warranty Period Start Date

i) Dealer / Distributor Sales:  In view of Dealer or Distributor stocking practices, the Standard 
Warranty Period for products sold through Dealers or Distributors will commence from the 
Clear-Com invoice date and will include an automatic extension of three months.  Any valid 
warranty claim within the Standard Warranty Period as determined by the Clear-Com 
invoice date will be covered without further supporting evidence.  All warranty claims after 
this date must be supported by the Customer's proof of purchase that demonstrates the 
product is still within the Standard Warranty Period (as detailed in Section 1.c.i above, plus 
the automatic three month extension) from their purchase date.

ii) Direct Sales:  The Standard Warranty Period will commence from the date the product was 
shipped from Clear-Com to the Customer.  The Standard Warranty Period start date for 
contracts that include commissioning will be the date of the Site Acceptance Test (SAT) or 
one month from conclusion of the commissioning project, whichever is earlier.

f) Invalidation of Warranty

i) This Limited Warranty shall be invalidated if the product's outer case has been opened and 
internal modifications have been made or damage has occurred, or upon the occurrence of 
other damage or failure not attributable to normal wear and tear.  Authorized modifications 
with Clear-Com's express written permission will not invalidate the warranty.

g) Software Updates 

i) Software Updates are released periodically to correct discovered program bugs.  During the 
Warranty Period, software updates are available to Customers free of charge.
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h) Software Upgrades 

i) Software Upgrades include new Features and/or Functional Enhancements and are not 
included as part of the Standard Warranty but may be purchased at the published rates.

ii) Note:  In the absence of a Software Update containing a program correction and no 
available workaround to mitigate the problem, at the discretion of Service, Sales, 
Engineering, or Product Management, the Customer may be provided a Software Upgrade 
under warranty.

2. Exclusions.  Services do not cover damage or failure caused by any occurrence beyond Clear-Com's 
reasonable control, including without limitation acts of God, fire, flooding, earthquake, lightning, failure 
of electric power or air conditioning, neglect, misuse, improper operation, war, government 
regulations, supply shortages, riots, sabotage, terrorism, unauthorized modifications or repair, strikes, 
labor disputes or any product failure that Clear-Com determines is not a result of failure in the 
Services provided by Clear-Com. Further Services excluded from this Agreement include: services 
required due to errors or omissions in Customer purchase orders; installation or maintenance of 
wiring, circuits, electrical conduits or devices external to the products; replacement or reconditioning 
of products which, in Clear-Com's opinion cannot be reliably maintained or properly serviced due to 
excessive wear or deterioration; Customer's failure to maintain the installation site in accordance with 
the environmental specifications of the products; or service on products removed from the location 
originally specified by Customer and/or reinstalled without the prior written approval of Clear-Com. 
Customer will pay Clear-Com's then current published charges to restore such Covered Products to a 
condition eligible for further service under this Agreement. Clear-Com shall be excused from and shall 
not be liable for any failure or delay in performance under this Agreement due to the foregoing or any 
causes beyond its reasonable control.

3. Limitation of Liability.  IN NO EVENT WILL CLEAR-COM BE LIABLE UNDER THIS AGREEMENT 
FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES (INCLUDING 
WITHOUT LIMITATION LOST PROFITS), REGARDLESS OF THE FORM OF ACTION, EVEN IF 
ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH DAMAGES.

4. Assignment.  Neither party may assign this Agreement or any portion thereof without the prior written 
consent of the other, except in the event of a merger, sale of all or substantially all of the assets or 
other corporate reorganization.

5. Ownership of replaced parts or product. All replaced parts or products become the property of 
Clear-Com.  

6. Entire Agreement.  This Agreement constitutes the entire agreement between the parties with 
respect to the subject matter hereof, and supersedes all prior or contemporaneous proposals, oral or 
written, and all other communications between them relating to the subject matter of this Agreement.
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TECHNICAL SUPPORT & REPAIR POLICY

APRIL 29, 2010

In order to ensure that your experience with Clear-Com and our World Class products is as beneficial, 
effective and efficient as possible, we would like to define the policies and share some "best practices" 
that can accelerate any problem solving processes which we may find necessary and to enhance your 
customer service experience.  Our Technical Support, Return Material Authorization, and Repair Policies 
are set forth below.  These Policies are subject to revision and constantly evolve in order to address our 
Customers' and the Market's needs.  Accordingly these are provided by way of guidance and for 
information only and may be changed at anytime with or without Notice.

TECHNICAL SUPPORT POLICY

a) Telephone, online, and e-mail technical support will be provided by the Customer Service Center 
free of charge during the Warranty Period.

b) Technical support will be provided free of charge for all software products under the following 
conditions:

i) The application, operating, and embedded software is installed on a product covered by 
Clear-Com's Limited Warranty, and:

(1) The software is at the current release level; or, 

(2) The software is one (1) version removed from current.

ii) Older versions of software will receive "best-effort" support, but will not be updated to 
correct reported bugs or add requested functionality. 

c) For Technical Support: 

i) North and South America, (incl. Canada, Mexico, and the Caribbean) & US Military:
Hours: 0800 - 1700 Pacific Time
Days: Monday - Friday
Tel: +1 510 337 6600
Email: Support@Clearcom.com
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ii) Europe, the Middle East and Africa:
Hours: 0800 - 2000 Central European Time
Days: Monday - Friday
Tel: +49 40 853 999 700
Email: TechnicalSupportEMEA@clearcom.com

iii) Asia-Pacific:
Hours: 0800 - 1700 Pacific Time
Days: Monday - Friday
Tel: +1 510 337 6600
Email: Support@Clearcom.com 

d) Email Technical Support is available for all Clear-Com branded products free of charge for the life 
of the product, or two years after a product has been classified as obsolete, whichever comes 
first. To log or update a request, send an email to: Support@Clearcom.com.

e) Support for Distributor and Dealer Sales 

i) Distributors and Dealers may utilize the Customer Service Centers once a system has been 
installed and commissioned.  Clear-Com Systems and Applications Engineers will provide 
support to the Distributor from the pre-sales stage through to satisfactory installation for new 
system purchases.  Customers will be encouraged to contact their Dealer or Distributor with 
their installation and technical support enquires rather than using the Customer Service 
Centers directly.

f) Support for Direct Sales  

i) Customers may utilize the Customer Service Centers once a system has been installed and 
commissioned by Clear-Com Systems and Applications Engineers, or in the case of project 
installations, once the Project Team has completed the hand-over to the Support Centers.

RETURN MATERIAL AUTHORIZATION POLICY

a) Authorizations: All products returned to Clear-Com or a Clear-Com Authorized Service Partner 
must be identified by a Return Material Authorization (RMA) number.

b) The Customer will be provided with an RMA number upon contacting Clear-Com Sales Support 
as instructed below.

  

c) The RMA number must be obtained from Clear-Com via phone or email prior to returning product 
to the Service Center.  Product received by the Service Center without a proper RMA number is 
subject to return to the Customer at the Customer's expense.
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d) Damaged equipment will be repaired at the Customer's expense.

e) Returns are subject to a 15% restocking fee.

f) Advance Warranty Replacements (AWRs);

i) During the first 30 days of the Standard Warranty Period: Once the equipment fault has 
been verified by Clear-Com or its authorized representative, Clear-Com will ship a new 
replacement product.  The Customer will be provided with an RMA number and be required 
to return the faulty equipment within 14 days of receipt of the replacement or will be invoiced 
for the list price of a new product. 

ii) During days 31-90 of the Standard Warranty Period:  Once the equipment fault has been 
verified by Clear-Com or its authorized representative, Clear-Com will ship a like-new, fully 
refurbished replacement product.  The Customer will be provided with an RMA number and 
be required to return the faulty equipment within 14 days of receipt of the replacement or will 
be invoiced for the list price of a new product.

iii) To obtain an RMA number or request an AWR:

(1) North and South America, Asia-Pacific, and US Military:
Hours: 0800 - 1700 Pacific Time
Days: Monday - Friday
Tel: +1 510 337 6600
Email: SalesSupportUS@Clearcom.com

(2) Europe, the Middle East and Africa:
Hours: 0800 - 1700 GMT + 1
Days: Monday - Friday
Tel: + 44 1223 815000
Email: SalesSupportEMEA@Clearcom.com

iv) Note: AWRs are not available for UHF WBS Analog wireless intercom systems.  UHF WBS 
Analog wireless intercom systems out-of-box failures must be returned to Clear-Com for 
repair. 

v) Note: Out-of-box failures returned after 90 days will be repaired and not replaced unless 
approved by Clear-Com Management.
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vi) Note: AWRs are not available after 90 days of receipt of product unless an AWR Warranty 
Extension is purchased at the time of product purchase.

vii) Note: Shipping charges, including duties, taxes, and insurance (optional), to Clear-Com's 
factory are the responsibility of the Customer.

viii) Note: Shipping AWRs from Clear-Com is at Clear-Com's expense (normal ground or 
international economy delivery).  Requests for expedited shipping (E.g. "Next-Day Air"), 
customs duties, and insurance are the responsibility of the Customer.

REPAIR POLICY

a) Repair Authorizations: All products sent to Clear-Com or a Clear-Com Authorized Service Partner 
for repair must be identified by a Repair Authorization (RA) number.

b) The Customer will be provided with an RA number upon contacting Clear-Com Customer 
Services as instructed below.

c) The RA number must be obtained from Clear-Com via phone or email prior to returning product to 
the Service Center.  Product received by the Service Center without a proper RA number is 
subject to return to the Customer at the Customer's expense.

d) Return for Repair 

i) Customers are required to ship equipment at their own cost (including transportation, 
packing, transit, insurance, taxes and duties) to Clear-Com's designated location for repair.  

(1) Clear-Com will pay for the equipment to be returned to the Customer when it is repaired 
under warranty.

(2) Shipping from Clear-Com is normal ground delivery or international economy.  

(3) Requests for expedited shipping (E.g. "Next-Day Air"), customs duties, and insurance 
are the responsibility of the Customer.

ii) Clear-Com does not provide temporary replacement equipment ("loaner") during the 
period the product is at the factory for repair.  Customers should consider a potential 
prolonged outage during the repair cycle, and if required for continuous operations 
purchase minimum spare equipment required or purchase an AWR Warranty Extension.

iii) No individual parts or subassemblies will be provided under warranty, and warranty repairs 
will be completed only by Clear-Com or its Authorized Service Partners.
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